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HOW IT WORKS

AliveColors is  the  all-in-one  solution  for  detailed  image  editing  and  retouching,  high-quality  photo
enhancement, creating stylization effects as well as professional painting and drawing. 

With a wide range of tools, effects, and parameters, you can edit existing photos or create an image from
scratch. 

For more details please read the Tutorials. 

Installation on Windows
Installation on Mac
Installation on Linux
Trial Period
Program Activation
Workspace
Using the Program
Creating a New Image
AKVIS Format
Color Modes
Image Resizing
Graphics Tablets
Batch Processing
Batch Conversion
Print Images
Preferences
HotKeys
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INSTALLATION ON WINDOWS

The  AliveColors image  editor  runs  on  Windows,  Mac,  Linux  (64-bit).  See  the  supported  operating
systems.

Below you will find instructions on how to install AliveColors on Windows. 

You must have administrator rights to install the software. 

Follow the instructions: 

Run the alivecolors-setup.exe file.
Select your language and press the Install button to launch the installation process.
Click Next.

To continue the installation process, read and accept the License Agreement. 

Select "I accept the terms in the License Agreement" and press Next.

1. 
2. 
3. 

4. 
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You can choose a drive to install the program.

Press Install.

5. 

6. 

AliveColors How It Works: Installation on Windows

8



The installation is completed. 

You can  subscribe  to  the  AliveColors  Newsletter to  be  informed about  updates,  events,  and
special offers. Enter your e-mail address and confirm that you accept the Privacy Policy. 

Press Finish to exit the AliveColors Setup.

7. 

8. 
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After the installation of AliveColors, you will see a new line in the  Start menu and a shortcut on the
desktop. 

For optimal operation of AI filters, you need an NVIDIA graphics card with CUDA Compute Capability 3.5+
and the latest version of a driver for the graphics card. When you start the image editor, you will be
prompted to install the CUDA-powered module if your computer meets the requirements. 

If you agree, the msi file with Cuda and TensorFlow will be downloaded. You can also download it from
here. 

If the computer does not meet the requirements, the processing will be performed by the CPU. 

AliveColors How It Works: Installation on Windows
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INSTALLATION ON MAC

The  AliveColors image  editor  runs  on  Windows,  Mac,  Linux  (64-bit).  See  the  supported  operating
systems.

Below you will find instructions on how to install AliveColors on Mac. 

You must have administrator rights to install the software. 

Follow the instructions: 

Open the virtual disk dmg: alivecolors.dmg
Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AliveColors application inside.

1. 
2. 

3. 
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To install AliveColors just drag the application into the Applications folder (or any other place you
like).

Run the program by double-clicking on its icon in Finder. 

4. 

AliveColors How It Works: Installation on Mac

12



INSTALLATION ON LINUX

The  AliveColors image  editor  runs  on  Windows,  Mac,  Linux  (64-bit).  See  the  supported  operating
systems.

Below you will find instructions on how to install AliveColors on Linux. 

Note: The AliveColors image editor is compatible with Linux kernel 5.0+ 64-bit. You can find out
the kernel version using the uname -srm command. 

AliveColors installers are available for several Linux distributions: 

► DEB package: Debian/Ubuntu

► RPM package: Red Hat/CentOS/Fedora

► openSUSE

Also, you can install AliveColors using Flatpak. 

Installation on Debian-based systems: 

Note: You need apt-install or apt-get permissions required to install software. 

Run the terminal. 
Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings 

Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

or 

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

Add the repository to the list where the system looks for packages to install: 

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

Update the list of known packages: 

sudo apt-get update 

Install the AliveColors image editor: 

sudo apt-get install alivecolors 

Agree to download and install required packages (qt-akvis, akvis-alivecolors-bin, akvis-alivecolors-
presets,  akvis-alivecolors-framepack,  akvis-hdrfactory-akf,  akvis-makeup-akf,  akvis-natureart-akf,
akvis-smartmask-akf). 

The installation is completed. 

Launch the image editor via the terminal or using the program shortcut. 

For automatic updates, use the command: 

1. 
2. 

3. 

4. 

5. 

6. 

7. 

8. 

AliveColors How It Works: Installation on Linux

13

http://alivecolors.com/en/download.php
http://alivecolors.com/en/download.php


sudo apt-get upgrade 

To remove the image editor: 

sudo apt-get remove alivecolors --autoremove 

Installation on RPM-based systems (CentOS, RHEL, Fedora): 

Run the terminal. 
Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc 

Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

Update the package list: 

when using the dnf package manager: 

sudo dnf update 

when using the yum package manager: 

sudo yum update 

Install AliveColors: 

when using the dnf package manager: 

sudo dnf install alivecolors 

when using the yum package manager: 

sudo yum install alivecolors 

The installation is completed. 

Launch the image editor via the terminal or using the program shortcut.

For automatic updates: 

when using the dnf package manager: 

sudo dnf upgrade 

when using the yum package manager: 

sudo yum upgrade 

To remove the image editor: 

when using the dnf package manager: 

sudo dnf remove alivecolors 

1. 
2. 

3. 

4. 

5. 

6. 

7. 

8. 
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when using the yum package manager: 

sudo yum remove alivecolors 

Installation on openSUSE: 

Run the terminal.
Login as a root user.
Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc 

Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis 

Update the package list: 

zypper ref 

Install AliveColors: 

zypper install alivecolors 

The installation is completed. 

Launch the image editor via the terminal or using the program shortcut. 

For automatic updates: 

zypper update 

To remove the image editor: 

zypper remove alivecolors 

Installation using Flatpak: 

Run the terminal.
Add the Flathub repository 

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 

Add the AKVIS repository 

sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

Install AliveColors: 

sudo flatpak install -y akvis com.akvis.alivecolors 

The installation is completed. 

Launch the image editor using the program shortcut or the terminal: 

1. 
2. 
3. 

4. 

5. 

6. 

7. 

8. 

1. 
2. 

3. 

4. 

5. 
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flatpak run com.akvis.alivecolors 

To update all installed flatpaks, use the command: 

sudo flatpak update -y 

to remove the program: 

sudo flatpak remove -y com.akvis.alivecolors 

In order to display the program interface correctly, it is recommended to install the Compton or Picom
composite manager. 

6. 
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USING TRIAL VERSION OF ALIVECOLORS

Download and install AliveColors. 

When you run the unregistered version of the program, the About AliveColors window appears. 

Click the TRY IT button to start a trial period for AliveColors. 

During the 10-day evaluation period, you can use all the features for free and without activation. 

The trial period starts from the first launch of the program. 

The About AliveColors window displays the number of days until the end of the trial period. 

After the trial period has expired, the TRY IT button will become inactive. To continue using the product,
you should activate the program. 

To get a licensed version, you do not need to download another copy of the program. Just activate the
installed one. 

AliveColors How It Works: Using Trial Version of AliveColors
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HOW TO ACTIVATE ALIVECOLORS

After you have downloaded AliveColors, run the setup file and follow the installation instructions. 

During the 10-day trial period, you can try all the features of the program without registration. 

To use the product after the trial period has expired, you have to activate the software. There are these
license types: Free, Home, Business. 

Attention: The process described below requires that your computer must be connected to the
internet during the activation process. If it is not possible, we offer you an alternative solution.

► Free Version

Proceed as follows to activate a free version of AliveColors: 

When starting an unregistered version of the program, the About AliveColors window appears. 
Click the FREE button.

Enter your valid email address in the Email Address input field, activate both options I accept the
Privacy Policy and Subscribe to AliveColors Newsletter, and click OK.

1. 

2. 
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Alternatively, you can request a serial number directly from the Customer Room by clicking on the
button Get license key for AliveColors Free. 

The  license  key  will  be  sent  to  your  email  address.  You  will  be  automatically  subscribed  to
AliveColors Newsletter. 

Attention: If you unsubscribe, your free license key will be immediately disabled! 

Open the program again and click ACTIVATE.
Enter your name and the license key (serial number) provided in the email.

3. 

4. 
5. 
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Choose the option Direct connection to the activation server and click ACTIVATE. 
Your registration is completed!

► Home/Business Lifetime License

When starting an unregistered version of the program, the About AliveColors window appears. 
Click ACTIVATE.
Enter your name and the license key (serial number) which you received after your purchase. 

Choose the option Direct connection to the activation server and click ACTIVATE. 
Your registration is completed!

Activation Without Internet Connection

If you have no Internet connection, please follow these steps to activate the software: 

Click ACTIVATE.
Enter your name and the license key (serial number).
Choose the option Send a request by e-mail and click ACTIVATE.
A message with all necessary information will be created by the program.
Transfer the activation message to a computer connected to Internet, for example, with a USB stick.
Send us the activation request without any changes to: activate@akvis.com.
Based on this information, we will generate a license file (AliveColors.lic) and send it to your e-
mail address. 

6. 

1. 
2. 
3. 

4. 

1. 
2. 
3. 
4. 
5. 

6. 
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Save the  AliveColors.lic file  (do not  open it,  just  copy) to your computer  where you want to
register the software, in the AKVIS folder in Users’ Public Documents: 

Windows: C:\Users\Public\Documents\AKVIS; 
Mac: /Users/Shared/AKVIS; 
Linux: /var/lib/AKVIS. 

Your registration is completed!

7. 
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WORKSPACE

AliveColors is all-in-one graphics software for detailed image editing and retouching, high-quality photo
enhancement, creating stylization effects as well as professional painting and drawing. 

Watch our video tutorial to learn more about the workspace of AliveColors image editor. 

Run AliveColors. Right after the launch of the image editor, its workspace looks like this: 

Start Screen of AliveColors Image Editor

In the central area of the software window, the Start Screen is shown. 

At the top of the screen there are the following controls: 

 - the button opens the dialog box for creating a new image; 

 - the button creates a new document from the clipboard; 

 - the button opens the file dialog, where you can select an image from the disk. 

The central area of the start screen is the list of recently opened documents. You can view documents as
thumbnails  or a text list . 

The size of the thumbnails of the recently opened images can be adjusted using the slider at the top of the
start screen. 

AliveColors How It Works: Workspace
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When you click the  button next to an image, it will turn into , and the image will be pinned in the

list and will not be lost when opening other images. Press the button again to unpin the image. 

When you click the  button next to an image, it will be deleted from the list. 

At the bottom of the start screen there is the Learn Panel where you can find links to video tutorials for
working with the editor. 

Hint: You can enable or disable the Start Screen and the Learn Panel in the editor's Preferences. 

After opening an image, the editor's workspace will look as follows:

Workspace of AliveColors

Elements of the Program Window:

The main part of the program's window is taken by the Image Window. 

It's possible to open multiple images at the same time. Each image appears in a separate tab at the top of
the Image Window. You can switch between the images by clicking on the tab name. 

Image Tabs

AliveColors How It Works: Workspace
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To the right of the image tabs, the following buttons are found: 

 - the button creates a new file; 

 - the button shows thumbnail previews of opened files; 

 - the button displays the list of opened images; 

 - the button closes an active file. 

Right-click the tab bar to open the context menu with available commands. 

In the upper part of the program's window, you can see the  Control Panel with the following menu
options: 

The File menu contains basic commands to manage files: Open, Save, Print, Close, Exit, etc. 

Using the Automate command, you can process multiple files at once. 

The Preferences... command opens the program settings dialog box. 

The Edit menu is used to edit the content of a document and the history of changes. 

The Image menu allows you to adjust the scale,  size, and color mode of an image. It also offers
commands for tone and color adjustments. 

Assign Profile. The command replaces the profile with the selected one without affecting the
data. Visually, the image will change, but the data at each point will remain the same. 
Convert to Profile.  The command replaces the profile with the selected one, the data is
recalculated, but the visual image does not change. 

The Layers menu contains commands for working with layers. 

The Select menu contains commands for working with selections. 

The Effects menu contains a number of enhancement and stylization filters and effects. Here you
can find a list of built-in and installed plugins. 

The AI (Artificial Intelligence) menu contains neural filters designed to improve images. 

The Workspace menu controls the appearance of the program. It offers the following commands
and menu items: 

The Customize Workspace command allows to edit the workspace properties. 

The Panels menu item defines which panels are displayed in the program window. 

The  alignment commands (Rulers,  Grid,  Guidelines, and others) are used to arrange and
align layers and objects. 

The Help menu provides information about the program. The menu provides the following items: 

Tutorial. The command opens the User Manual (F1  key). 

About AliveColors. The command displays information about the current version and license
of the program. 

Activation. Using the command, you can register the program and change the license type. 

What's New? The command opens a web browser window providing information about new
versions of AliveColors. 

AliveColors How It Works: Workspace
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Technical Support. Use this command to contact AKVIS Support Team. 

AliveColors on the Web. The command opens the home page of the graphics editor. 

Subscribe to AliveColors News. Use this command to subscribe to AliveColors Newsletter
and stay tuned with the latest news! 

About Plugins. Select the name of any plugin to get information about its version and the
status of your license. 

Under the Control Panel there is the Tool Options panel with the parameters of an active tool. 

Options Panel of the Move Tool

The Tool Options panel shows the basic parameters of the tool. To display all parameters, click on the tool
icon on the left side of the Tool Options or right-click within the Image Window. 

In the right part of the Tool Options panel you can see the following icons: 

The button  opens a window showing the latest news about AliveColors. 

The button  opens the help files of the program. 

The button  calls the Preferences dialog box that allows to change the program's options.

The program contains some panels with specific  functions:  Navigator,  Toolbar,  Color,  Swatches,  Color
Wheel, History, Actions, Layers, Channels, Selections, and File Info. 

The parameters of the selected effect or adjustment layer are shown in the Settings Panel. 

The Hints panel displays a short description of the panels, tools, and options when the mouse cursor is
hovering over them. 

The panels can be easily moved, combined, scaled, aligned, and hidden. 

AliveColors How It Works: Workspace
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USING THE PROGRAM

AliveColors is the all-in-one graphics software for detailed image editing and retouching, high-quality
photo enhancement, creating stylization effects as well as professional painting and drawing. 

The functionality of the program depends on the license type. Some features are not available in the Free
version. During the test period you can try all options and choose the license you like. 

Follow the basic processing steps:

Step 1. Run the AliveColors image editor. 

Step 2. Open a file (supported formats: TIFF, BMP, JPEG, PNG, RAW, SVG, PSD, WEBP, and AKVIS)
or create a new image. 

To open an image, click the Open File button  in the start screen window, select the File ->

Open command in the menu, or press Ctrl+O  on Windows, ⌘+O  on Mac. 

Alternatively, you can drag an image shortcut directly to the program workspace. When dragging
into an opened file, the image will be added as a new layer. 

You can load multiple selected files from disk into a single document as separate layers, using the
Load Files into Layers command in the File -> Automate menu. 

You can view the recently opened files on the start screen. You can also select in the menu: File ->
Recent Files. 

AliveColors Window

AliveColors How It Works: Using the Program
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It is possible to open multiple images at once. 

Step 3. You can adjust the color and hue of an image by selecting Image -> Adjustment. 

Step 4. To edit the image, use appropriate tools from the Toolbar. 

Step 5. Apply effects and filters to the image by using the Effects menu in the Control Panel. 

Image Editing in AliveColors

Step  6. To  save  the  result,  use  the  command  File  ->  Save  As or  the  key  combination
Ctrl+Shift+S  on Windows, ⌘+⇧+S  on Mac. 

In the Save As dialog box, enter a name for the file, select a format (TIFF, BMP, JPEG, PNG, SVG,
WEBP, PDF, PSD, or AKVIS) and indicate a target folder. 

Note: If  your  image  has  multiple  layers,  you  can  use  the  AKVIS format to  save  all
checkpoints, all types of layers, selections, and masks. The end result can be saved in any
supported format. 

Use the command  File -> Save or the key combination  Ctrl+S  on Windows,  ⌘+S  on Mac to
replace the original image with the edited one. 

You can save each layer of the image to a separate file using the  File -> Save Layers to Files
command. When saving, select the folder, file name, and desired format. 

Using the File -> Save for Web command, you can prepare and save an image for posting on the
Internet. The dialog box allows you to select the optimal format, quality, and file size. 

AliveColors How It Works: Using the Program
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Save for Web

Step 7. To print the image, select File -> Print or use the keyboard shortcut Ctrl+P  on Windows,
⌘+P  on Mac. 

Step 8. Use one of the options to close the active image: 

- press the button  in the image tab; 

- press the button  on the right of the image tabs; 

- select the command File -> Close in the Control Panel; 

- use the keyboard shortcut Ctrl+W  on Windows, ⌘+W  on Mac. 

Step 9. Use one of the options to exit the program: 

- press the X symbol in the top right corner of the program window; 

- select File -> Exit from the Control Panel; 

- use the keyboard shortcut Ctrl+Q  on Windows, ⌘+Q  on Mac. 

AliveColors How It Works: Using the Program
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CREATING A NEW IMAGE

The AliveColors graphics editor lets you create new images from scratch. 

To create a new image, select File -> New... in the menu, click  on the start screen, or use hotkeys:

Ctrl+N  on Windows, ⌘+N  on Mac. 

Creating a New Image

Select any presets group: 

Custom, 
U.S. Paper, 
International Paper, 
Photo, 
Web, 
Mobile Device, 
Film & Video. 

After selecting a presets group, presets thumbnails appear in the central window. Choose any preset and,
if necessary, adjust the following parameters: 

Set the size of the document in the Width and Height fields. 

The Units drop-down list shows the units of measurement (pixels, inches, centimeters, etc.). 

The  Resolution parameter determines the number of pixels in an image (level of detail) and is
measured in pixels per inch (ppi). 

AliveColors How It Works: Creating a New Image
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Choose the Orientation of the document - Portrait  or Landscape . Portrait orients the

image vertically (height is  greater than width),  while  Landscape orients the image horizontally
(width is greater than height). 

In Color Mode drop-down-list, choose one of the following color schemes: Grayscale, RGB, CMYK,
or Lab. The modes differ in how they handle color. After you have chosen a color model, select a
color depth from the list below: 8 Bits/Channel, 16 Bits/Channel, or 32 Bits/Channel. 

In the Color Profile drop-down list, select a profile for the document being created. 

Use  the  Background option  to  set  the  color  of  the  background  layer.  To  use  the  custom
background, select Custom... and choose color in the color selection dialog. 

To save the settings as a new preset, click the Save Preset button . Its name appears in the field

next to it. By default, the name consists of the selected document size, color mode and depth and
can be changed by entering any combination of letters and numbers in the field. After pressing the
Enter  key, a new preset appears in the center window of the Custom presets group. 

To delete a user preset, select it in the list and click the Delete Preset button . 

Click OK to create a new document with the specified parameters. 

Click Cancel to close the dialog box without creating a new document. 

AliveColors How It Works: Creating a New Image
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AKVIS FORMAT

The software offers the special  AKVIS format which lets you losslessly save a working draft  of  your
project into a file. 

To save a file in the .akvis format, go to the main menu and select File -> Save As. In the dialog box,
choose a destination folder, type a filename, and select  AKVIS Document (*.akvis) from the Format
list. 

To load a file, use the command File -> Open. 

The  AKVIS file  contains the state of  an image at  the moment it  was saved,  all  layers (raster,  text,
adjustment, shape) and groups, with their properties, masks and selections as well as manually created
checkpoints added during your work (in History). 

The AKVIS format provides helpful opportunities to work with files: 

saving a document structure (layers, their groups and properties); 
saving text, adjustment, and shape layers without rastering them; 
saving masks and layer effects in the document structure; 
saving checkpoints (the possibility to revert to a previous state); 
saving all the selections of the same panel; 

We recommend you to use the AKVIS format to save a draft or a backup copy. 
You can save the final result using JPG, TIFF, BMP, PNG, WEBP formats to be able to share it. 

1. 
2. 
3. 
4. 
5. 
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COLOR MODES

AliveColors allows to modify the color depth and the color space of an image. To view the list of available
color modes, go to the Control Panel and select Image -> Mode. 

The program offers 4 color modes: 

RGB Mode is a standard color model. Every RGB image contains three color channels: Red, Green,
and Blue. The color of a pixel is a combination of these three primary colors. When the value of
every channel is zero, the result is pure black. 

CMYK Mode is  a  standard color  model  used in offset  printing.  A CMYK image consists  of  four
channels:  Cyan,  Magenta,  Yellow, and blacK. The color of a pixel is defined by the value of each
color component (from 0 to 100%). The lower the value, the lighter the color. 

Lab Mode. This color model is based on perception of color by the human eye. The luminance
component (L) can take values from 0 to 100; the color components a (from green to purple) and b
(from blue to yellow) have values between -128 and 127. 

Grayscale Mode. This mode uses different shades of gray for different colors. When applying this
mode, only one channel is available - Gray. In 8-bit images, there can be up to 256 shades of gray. 

In this menu, you can also adjust the color depth: 8 bits per channel, 16-bit per channel, or 32 bits
per channel. 
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To display the colors on the screen in the RGB mode, three colors/channels are used. In images with 8

bits/channel, each color channel can have 256 variations (28 = 256). Therefore the three channels can

reproduce up to 16.8 million colors per pixel (2563). 

With images with 16 bits/channel and 32 bits/channel, even more colors can be reproduced per pixel. 
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IMAGE RESIZING

Read how to resize an image using  AliveColors image editor. Alternatively, you can watch the  video
tutorial. 

You can save the image resizing settings as Presets. Find all available presets in the drop-down list. If
you modify the parameters, the preset name automatically changes to Custom, and the Save Custom
Preset button  appears next to the list. To save the current settings, press this button. 

A new preset is automatically assigned a name (for example,  Custom_1,  Custom_2, etc.) that can be
changed as needed by entering any combination of letters and numbers in the highlighted field. After
pressing Enter , a new preset will appear in the drop-down list. 
To remove a user preset, select it and press the Delete Custom Preset button . 

Click  to export user presets to a .presets file. To load the presets into the program, press on . 

Image Size: 

To change the size of an image, you can use the command Image -> Image Size. 

Resize Image Dialog Box

The size of the current document is defined by Width and Height values. To resize an image, enter
desired values in the relevant fields. Possible units (pixels, inches, centimeters, millimeters, points,
picas, and percentages) are listed in the drop-down menu. 
Resolution.  The  parameter  determines  the  density  of  pixels  in  an  image (level  of  detail)  and
calculates the number of pixels per inch (ppi). 
Scale Layer Effects. If the check-box is enabled, the layer effect will be scaled proportionally with
the image size. If the check-box is disabled, the original size of the effect remains unchanged. 
Constrain Proportions. Enable the check-box to maintain the proportions of an image (width and
height). 
Image Resampling. If the check-box is enabled, you can change the size and resolution of an
image independently of each other (and change the total number of pixels in an image). 

If  the  check-box  is  disabled,  you  can  either  resize  an  image  or  its  resolution.  The  program
automatically adjusts the remaining value to maintain the total number of pixels. 

• 

• 

• 

• 

• 

AliveColors How It Works: Image Resizing

35

http://alivecolors.com/en/tutorial/video/resizing.php
http://alivecolors.com/en/tutorial/video/resizing.php


If  the  Image Resampling check-box is enabled, you can choose a  Resampling Method.  This
option determines how the pixels are added or deleted. 

Resampling Methods: 

Nearest Neighbor - a fast but less precise method; 

Bilinear Interpolation - an optimal method delivering an average quality; 

Bicubic Interpolation - the most accurate, but also the slowest method. 

Reducing Image (Using Resampling Technique)

Nearest Neighbor Bilinear Interpolation Bicubic Interpolation

To resize the image, click OK. To exit the dialog without saving any changes, click the Cancel button. 

Canvas Size: 

Canvas is a workspace containing all the image layers and has a specific size. To change the size of a
document, you have to change the size of its canvas. 

• 
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Open the Resize Canvas dialog box using the command Image -> Canvas Size. 

Resize Canvas Dialog Box

The Actual Size section displays the current size in megabytes. The width and height are shown in
the chosen measurement unit. 
In the New Size section you can change the size of a document by entering values in the Width
and Height fields. If you increase the working area, an image will be enlarged by the border size. If
you reduce the workspace, the edges of the picture will be cut off. Available units (pixels, inches,
centimeters, millimeters, points, picas, and percentages) are listed in the drop-down list. 
Relative. If the check-box is checked, enter the desired values in the Width and Height fields. If
the check-box is  unchecked, enter the values by which the canvas size should be increased or
decreased from its current size. To increase the canvas, set a positive value. To reduce the canvas,
set a negative value. 
To adjust the Position of the resized image on the canvas, use eight arrow signs. The central point
indicates the position of an image on the canvas. 
If the Background check-box is turned on, you can specify the color of the added edges. Call the
Select Color dialog by clicking the color plate. If you disable the check-box, the added areas will be
transparent. 

Note. The color edges can be added only to the lower layer. The borders in other layers are
transparent.

• 

• 

• 

• 

• 
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Increasing Canvas Size

To change the size of the canvas, press  OK. To exit the dialog without applying any changes, click the
Cancel button. 
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WORKING WITH GRAPHICS TABLET

The AliveColors editor allows you to use a graphics tablet for creating or editing images. When working
with a graphic tablet, you can dynamically change the appearance of strokes based on how much pressure
you apply to your stylus when drawing as well as how you tilt and rotate it. 

You can also use the stylus to perform mouse functions (tool selection, color selection, parameter change,
etc.). 

As an example, we consider working with a graphics tablet using the Color Brush tool . 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. 

For the tool options that can be controlled with the stylus, a button with a drop-down menu is available.
Use the left mouse button to enable/disable the assignment of the chosen stylus option. Right-click or hold
down the left mouse button to open the drop-down list where you can select which stylus option will
correspond to this brush parameter: 

Pressure - the parameter depends on the pressure of the stylus; 

Rotation - the parameter depends on the rotating of the stylus around its axis; 

Tilt - the parameter depends on the tilting of the stylus. 

Let's assign the size of the brush to the pressure of the stylus. The weak pressure of the stylus results a
thin stroke, the strong pressure results a wide stroke up to (but not exceeding) the size of the brush
specified in the Tool Options panel. 

Thin Stroke Wide Stroke

You can assign several tool parameters to a single stylus option. Let's consider the case of assigning the
pressure of the stylus to the Size and Opacity parameters. The weak pressure results a thin transparent
stroke, the strong one results a wide opaque line. The thickness and opacity of the drawn line will not
exceed the specified values of the tool parameters. 
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Thin Transparent Stroke Wide Opaque Line

Clicking the Default button in the brush options will restore the original values. All assignment settings
will be disabled. 
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BATCH PROCESSING

AliveColors supports the Batch Processing feature that lets you automatically apply the same settings
to a series of images and save you time and effort. Batch processing does not block the program interface,
so you can simultaneously edit other images. Watch the  video tutorial on how to automatically process
multiple images. 

Even if you have never used this feature before, you will find no difficulties in using it. Just create an
Action and apply it to a folder full of images. 

Note: Not all commands can be recorded in an action. 

Follow the instructions: 

Step 1. Create two new folders, for example:  "Source Files" and  "Result Files". Place original
images into the "Source Files" folder. The results will be saved in the "Result Files" folder. 

Step 2. Open one of  the original  images in  AliveColors.  We will  use this  photo to adjust  the
parameters and create an action. 

Original Image

Step 3. In the  Actions panel, click  Create New Set button  . Enter a name for a new set of

actions, for example, "Sample". You can edit the name by double-clicking on it. 

If you already have a set for the actions, you can select it. 

Actions Panel
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Step 4. Press Create New Action  and enter a name, for example, "Resize". 

New Action

Press the Record button  to run the recording of the action. 

Step 5. Perform the operations and commands you want to record. For example, call the  Resize
Image dialog box (Image -> Image Size) and adjust the settings. 

Image Resizing Dialog Box

Click the OK button. The resized image appears in the editor's window. 

Step 6. Stop the recording by pressing Stop  at the bottom of the Actions panel. 
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Action recording is stopped

Step 7. The action is created and you can start the batch processing. In the  File menu, choose
Automate -> Batch Processing and set the parameters. 

In the Source Folder field, choose the folder which contains the photos to be processed. 

In the Target Folder, choose the folder where the processed files will be saved. 

You can check  Include Subfolders to process all  images in all  subfolders of the selected
folder (keeping the structure). 

In the Save As list, select a file format. 

In the Save RAW As list, select a format for saving RAW files. 

Click  to call up a dialog box where you can configure the saving options for the selected

file format. 

In the File Name field, specify the names of the output files: 

Source Name - the processed files will be saved with their original names. 
Add Suffix - the specified character set will be added to the original names. 
New Name - the names of all files will be replaced with the specified name with the
addition of a sequence number. 

In the actions list, select the "Sample" group and then the "Resize" action. 
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Batch Processing Tab

Step 8. Press  Start to run the processing.  AliveColors processes all the photos in the  "Source
Files" folder and then saves them to the "Result Files" folder. 

To interrupt the process, close the Batch Processing tab. 
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BATCH CONVERSION

AliveColors allows you to convert a series of images from one format to another. Batch conversion does
not block the program interface, so you can simultaneously edit other images. 

Select in the menu: File -> Automate -> Convert...

Batch Conversion

Conversion Options: 

In the Source Folder field, choose the folder with original images. 

In the Target Folder field, choose the folder to save the files. 

Enable Include Subfolders to process all images in all subfolders of the selected folder (keeping
the structure). 

In the Save As list, select a file format. 

Click   to call up a dialog box where you can configure the saving options for the selected file

format. 

In  the  RAW  Preset list,  you  can  select  one  of  the  presets  for  processing  RAW  files  during
conversion. You can create new presets in the RAW Processing mode. 

In the File Name field, specify the names of the output files: 

Source Name - the processed files will be saved with their original names. 
Add Suffix - the specified character set will be added to the original names. 
New Name - the names of all files will be replaced with the specified name with the addition
of a sequence number. 

Click Start to run image processing. AliveColors will process all the images in the Source Folder, one
by one, and will save them to the Target Folder with the selected format. 

To interrupt processing, close the Batch Conversion tab. 
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PRINT IMAGES

To open the Print options, select in the menu File -> Print or use the hotkeys: Ctrl+P  on Windows,
⌘+P  on Mac. 

Print Options in AliveColors

Adjust the parameters appearing in the Settings Panel: 

Choose a printer from the list of available devices, set the desired resolution, as well as the number
of copies to print. 

In  the  Orientation group,  set  the  position  of  paper:  Portrait (vertically)  or  Landscape
(horizontally). 

Click  the  Page  Setup button  to  open  a  dialog  box  to  choose  the  size  of  the  paper  and  its
orientation, as well as the print margins. 

Press the Reset Margins button to return the page margins to the default size. 

Change the size of the printed image adjusting the parameters  Scale,  Width,  Height and Fit to
Page.  These parameters have no effect  on the image itself,  just  on the print  version. You can
change the size of the printed image by entering any value in %, or by entering new values in
Width and Height. 

To adjust the size of the image to the paper size, select Fit to Page. 

Move the image on the page with the mouse or align it using the arrow buttons. 

You can activate Frame for the image and adjust its width and color. 
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Choose the Background Color by clicking on the color plate. 

In the Profile drop-down list, select the profile to convert the image before being sent to the output
device. 

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet. 

Print Page

Copies per Page. It lets you specify the number of copies of the image on one page. 
Horizontally and Vertically. These parameters indicate the number of rows and columns for
the copies of the image on the page. 
Spacing. The parameter sets the margins between the copies of the image. 

In  the  Poster tab,  it's  possible  to  customize  printing  of  the  image  on  multiple  pages  for  the
subsequent junction into a large picture. 

◦ 
◦ 

◦ 
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Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in
which the image will be divided. The image scale will be adjusted to fit this number of the
sheets. If the check-box is disabled, the program will automatically select the optimal number
of the pages in accordance with the actual size of the image (scale = 100%). 
Glue Margins.  If  the check-box is  enabled,  you can adjust  the width of  the padding for
bonding sheets. Margins will be added to the right and to the bottom of each part. 
Lines of Cut. Activate the check-box to display the cut marks in the margins. 
Show Numbers. With the enabled check-box, a sequence number of each part, by a column
and a row, will be printed in the margins. 

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel. 

Click the Properties... button to open a system dialog box that enables you to adjust the settings and
send the document to print. 

◦ 

◦ 

◦ 
◦ 
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PREFERENCES

You can open the Preferences dialog box using the  button in the upper right corner of the program

window or using the File -> Preferences... command. It contains several tabs with different parameters:

General

Interface Theme. Select a style of the program interface: Light or Dark. 
Interface Scale. Choose the size of the interface elements. When it is set to  Auto, the program
workspace will automatically scale to fit the screen resolution. 
Language. Select an interface language from the drop-down list. 
History Size (0-100). This parameter defines the number of document states displaying in the
History panel. If the value is set to 0, the panel contains an unlimited number of states. 
Recent Files (5-30). The number of recent documents. The option allows recently closed files to be
quickly re-opened. 
Autosave. If the check-box is enabled, a recovery file is automatically generated at the specified
time interval. It helps you retrieve unsaved files after an accidental closure or crash. 
Default  Format to Save New Single-Layer Images.  Set a  default extension for  saving new
single-layer files (JPG, PNG, TIFF, or AKVIS). You can change the file type in the Save As dialog box. 
Launch Start Screen. If the check-box is enabled, the Image Window provides quick access to
creating a new file and opening previously used files. To pin a document in the list  of  recently
opened files, click the button  next to it. To unpin the document, press the button . 

• 
• 

• 
• 

• 

• 

• 

• 
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Enable Learn Panel. If the check-box is enabled, the panel with links to tutorials appears at the
bottom of the Start Screen. 
Use GPU. The check-box lets you turn on GPU acceleration. 
Prohibit  Internet Access.  Enable the check-box to block the program from connecting to the
Internet. In this case, some features will become unavailable: the latest news, a feed with video
lessons, and the program activation through a direct connection to the server. 
Show Customer Name in Application Title.  If  the check-box is  enabled, the license owner's
name is shown in the program title. It's the name that was used when activating AliveColors. 
Show Hints in Status Bar.  When the check-box is  enabled,  a  hint  for  the selected option is
displayed at the bottom of the program window. It's a text line with a brief description of the panels,
filters, tools, parameters when the mouse cursor is hovering over them. 
Large Toolbar Icons. When the check-box is active, the tool icons become larger. 

Profile. Color profiles are necessary to accurately and reliably transfer color to different output devices
(screens, printers, etc.). They help to standardize the appearance of images. Learn more about color
profile settings here. 

• 

• 
• 

• 

• 

• 
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Filters & Plugins

Preview Area Size (in pixels). The parameter sets the size of the preview window used in effects
and adjustments.  The size of  the area can vary from 200x200 px to 2,000x2,000 px.  You can
manage the displaying of the preview window by enabling/disabling the Fixed Preview Area check-
box in the parameter panel. 
Processing Size Limit (Neon & Points) (in megapixels). The parameter works only for the built-
in  Neon and Points plugins. It allows you to speed up the calculation by temporarily reducing the
size of the file being processed. When the file size (in megapixels) does not exceed the specified
number, the image is processed in the usual way. If the size of the uploaded file is larger, then
during the process the image will be reduced, processed and increased to its original size. 
Display Settings Panel Only check-box. Enable the check-box to display only the Settings Panel
when launching the effects and filters. All  other panels attached to it will  be hidden (except for
Toolbar, Navigator, and Hints). 
Plugins Directory.  Specify  the path to external  plugins compatible  with the AliveColors  image
editor. To add a new path, click the button  and select a directory. Press on  to remove a path. 

• 

• 

• 

• 
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Guides & Grid

You can show/hide the guideline elements using the Workspace menu. The parameters are divided into
three groups: 

In the Rulers section, you can adjust the color of the ruler lines: 

You  can  change  the  Color of  each  element  by  clicking  the  corresponding  color  plate:
Background, Divisions, Cursor Marker. 

Select a Unit of measurement in the drop-down list or by clicking a ruler with the right mouse
button. 

In the Guidelines section, you can change the appearance of guidelines: 

Select a Color of guidelines by clicking on the color plate. 

In the Style drop-down list, specify the type of lines: Solid Lines, Dashed Lines, or Dots. 

Using the Grid section, you can change the appearance of the grid, which consists of base lines and
auxiliary lines. 

Color of the grid lines can be changed by clicking on the color plate. 

Step adjusts the grid spacing between the major lines. You can change units for this option. 

• 

• 

• 
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Subdivisions - this option defines the spacing between auxiliary lines. 

You can adjust a view mode for the grid lines (Lines, Dashed Lines, Dots). 
There are two drop-down lists for each type of lines: Base Lines and Auxiliary Lines. 

HotKeys. Using this tab, you can customize the keyboard shortcuts. 

To save changes made in the Preferences, press OK. If necessary, click Restore Defaults to reset to the
default settings. 
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HOTKEYS

Using the keyboard shortcuts (so-called hotkeys) can simplify and speed up the processing. To activate a
tool, you can either click its icon or use a shortcut. 

Below is a list of shortcuts which can be used in AliveColors. To change a shortcut, use the HotKeys tab

in the program's Preferences (click  in the upper right corner of the program window). 

Windows Mac

Basic Commands:

Ctrl+N ⌘+N Create a New Image

Ctrl+Shift+N ⌘+⇧+N Create a New Image from the Clipboard

Ctrl+O ⌘+O Open an Image

Ctrl+W ⌘+W Close an Image

Ctrl+Alt+W ⌘+Option+W Close All Images

Ctrl+S ⌘+S Save an Image

Ctrl+Shift+S ⌘+⇧+S Save an Image as...

Ctrl+Alt+Shift+S ⌘+Option+⇧+S Save for Web

Ctrl+P ⌘+P Print an Image

Ctrl+Z ⌘+Z Undo the Last Action

Ctrl+Y ⌘+Y Redo the Last Action

Shift+Z ⇧+Z
Back to the Last Action (switching between two
states in History)

F1 F1 Open Tutorial

Ctrl+Q ⌘+Q Exit the Program

Scaling:

+  or Ctrl++ +  or ⌘++ Zoom In

-  or Ctrl+- -  or ⌘+- Zoom Out

Ctrl+1 ⌘+1 Original Size (100%)

Ctrl+0 ⌘+0 Scale an Image to the Window

Alt+→ Option+→ Scale an Image to Fit the Window Width

Alt+↓ Option+↓ Scale an Image to Fit the Window Height

Adjustments:

Ctrl+L ⌘+L Levels

Ctrl+Shift+L ⌘+⇧+L Auto Levels

Ctrl+Alt+Shift+L ⌘+Option+⇧+L Auto Contrast

Ctrl+M ⌘+M Curves

Ctrl+U ⌘+U Hue/Saturation

Ctrl+B ⌘+B Color Balance

Ctrl+I ⌘+I Invert

Ctrl+Alt+Shift+B ⌘+Option+⇧+B Black & White

Ctrl+H ⌘+H Equalize

Ctrl+Shift+U ⌘+⇧+U Desaturate

AliveColors How It Works: HotKeys

54



Resizing:

Ctrl+Alt+I ⌘+Option+I Resize an Image

Ctrl+Alt+C ⌘+Option+C Resize Canvas

Layers:

Ctrl+Alt+G ⌘+Option+G Create/Remove Clipping Mask

Ctrl+G ⌘+G Group Layers

Ctrl+Shift+G ⌘+⇧+G Ungroup Layers

Ctrl+, ⌘+, Show/Hide Layers

Ctrl+Shift+] ⌘+⇧+] Bring to Front

Ctrl+] ⌘+] Bring Forward

Ctrl+[ ⌘+[ Send Backward

Ctrl+Shift+[ ⌘+⇧+[ Send to Back

Ctrl+E ⌘+E Merge Selected Layers

Ctrl+Shift+E ⌘+⇧+E Merge Visible Layers

Selections:

Ctrl+A ⌘+A Select All

Ctrl+D ⌘+D Deselect

Ctrl+Shift+D ⌘+⇧+D Reselect

Ctrl+Shift+I ⌘+⇧+I Invert Selection

Ctrl+X ⌘+X Cut Selection

Ctrl+C ⌘+С Copy to Clipboard

Ctrl+Shift+C ⌘+⇧+C Copy Contents of All Layers

Ctrl+V ⌘+V Paste from Clipboard

Ctrl+J ⌘+J Layer via Copy

Ctrl+Shift+J ⌘+⇧+J Layer via Cut

Ctrl+Alt+R ⌘+Option+R Refine Edges

Delete Delete Remove Selected Areas

Tools:

V V Move Tool

Ctrl+T ⌘+T Transform Tool

M M
Basic Selection Tools: Rectangular Selection, 
Elliptical Selection, Lasso, Polygonal Lasso

W W
Quick Selection Tools: Magic Wand, Quick
Selection, Object Selection

C C Crop Tool

O O View Mode for Grid while Cropping

Shift+O ⇧+O Flip Grid while Cropping

T T Text Tools: Text and Fit Text to Path

I I Eyedropper Tool

H H Hand Tool

Z Z Zoom Tool
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B B
Standard Drawing Brushes: Color Brush, Color
Pencil, Spray, Recolor Brush, Texture Brush

E E Erasing Tools: Eraser and History Brush

G G Filling Tools: Paint Bucket and Gradient Fill

S S
Cloning/Healing Tools: Clone Stamp and 
Chameleon Brush

K K
Sharpening Tools: Blur, Sharpen, and Smudge
Tools

O O
Lighting Tools: Lighten, Darken, and Saturation
Tools

J J
Retouching Tools: Tuning Brush, Spot Remover, 
Red Eye Remover, Teeth Whitening

D D Deformation Tools

X X FX Brushes

A A Artistic Brushes

U U Shape Tools

[  and ] [  and ] Decrease/Increase Brush Size

N+mouse wheel N+mouse wheel Change the size of the brush

Shift+[  and Shift+] ⇧+[  and ⇧+] Decrease/Increase Brush Hardness

Scroll an Image in a Window (the Hand tool is
temporarily active while you hold down the
spacebar)

Panels (enable/disable):

F5 F5 Expanded Tool Options Panel

F6 F6 Color Panel

F7 F7 Layers Panel

F8 F8 File Info Panel

F9 F9 Actions Panel

Auxiliary Lines:

Ctrl+R ⌘+R Show Rulers

Ctrl+' ⌘+' Show Grid

Ctrl+; ⌘+; Show Guidelines

Ctrl+Shift+; ⌘+⇧+; Snap to Edges

Ctrl+Alt+; ⌘+Option+; Fix Guidelines

In addition:

Ctrl+F ⌘+F Apply the Last Effect

Shift+mouse click ⇧+mouse click Draw a Straight Line
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PANELS

AliveColors is the full-featured graphics editor for image creation and processing. 

The program offers a wide range of tools located on the Toolbar. 

The Navigator, Color, Swatches, Color Wheel, History, Layers, Channels, and Selection panels are
irreplaceable in the professional image editing process. 

The Hints panel displays a short description of the panels, tools, and options when the mouse cursor is
hovering over them. 

You can move the panels by clicking and dragging their titles, combine the panels and attach them to the
window edges. 

To show or hide any of the panels, use the menu Workspace -> Panels. 

Navigator
Toolbar
Layers
   — Layer Effects
   — Layer Mask
   — Clipping Mask
   — Blend Modes
   — Blend by Brightness
Channels
Selection
History
Color
Swatches
Color Wheel
Actions
File Info
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NAVIGATOR

The Navigator allows fast scaling and moving of image areas as well as going back to the entire image
view. Here you can see the reduced copy of an image. The frame shows the part of the image that is now
visible in the Image Window; оther areas outside the frame are shaded. Drag the frame to make other
parts of the image visible. To move the frame, bring the cursor inside the frame, press the left mouse
button and, keeping it pressed, move the frame in Navigator. 

To scroll the image in the  Image Window you can press the spacebar on the keyboard and drag the
image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down: by
keeping the Ctrl  key on Windows, ⌘  on Mac pressed – to the left/to the right, by keeping the Alt  key
on Windows, Option  on Mac pressed − scale the image. Right-click on the scroll bar to activate the quick
navigation menu.

Use the slider to scale the image in the Image Window. When moving the slider to the right, the image
scale increases; when moving it to the left, the image scale reduces.

You can also change the image scale by entering a value into the scale field and pressing the button
Enter  on Windows, Return  on Mac. The drop-down menu shows some frequently used values.

Standard scale presets are listed in the Image -> Scaling menu: 

Actual Size (Ctrl+1  on Win, ⌘+1  on Mac) - the image is displayed at its original size (100%); 

Fit to View (Ctrl+0  on Win, ⌘+0  on Mac) - the image is fully visible in the Image Window; 

Fit Width (Alt+→  on Win, Option+→  on Mac) - the image is scaled to fit the window width; 

Fit Height (Alt+↓  on Win, Option+↓  on Mac) - the image is scaled to fit the window height; 

Fill Window - the image is scaled to fill the Image Window completely. 

To zoom in an image, use the menu command  Image -> Zoom In or the keyboard shortcuts  +  or
Ctrl++  on Windows, ⌘++  on Mac. To zoom out an image, use the command Image -> Zoom Out or
the keyboard shortcuts -  or Ctrl+-  on Windows, ⌘+-  on Mac.

You can move the  Navigator panel to any area of the screen, combine it with other panels, scale, or
collapse. 
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TOOLBAR

The  Toolbar contains  the  groups  of  image  editing  tools.  Click  the  relevant  buttons  to  activate  the
Selection Tools, Standard Brushes, Retouching Tools, Deformation Tools, FX Brushes, Artistic Brushes, Text
Tools, Shape Tools, or Common Tools. 

The basic parameters of the selected tool are shown in the Tool Options panel or by right-clicking on the
image. To view the full list of parameters, press the tool icon in the Tool Options panel or use the F5
key. 

Buttons marked with a small triangle at the bottom, contain a submenu of additional tools, which can be
selected by either right-clicking or by pressing and holding the left mouse button. All the tools of this
group will be displayed in the drop-down menu. Click on the desired tool with the left mouse button to
select it. 

Toolbar

At the bottom of the Toolbar, there is a color control box. The upper square displays the foreground color,
the lower one - the background color. Double-click one of them to open the Select Color dialog. To swap
colors, press . Reset to the default colors (main is black, background is white) by pressing . 
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You can dock the Toolbar to the left or right edge of the program window or position it anywhere on the
screen. Drag the Toolbar by clicking and holding the upper part of the bar. 
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LAYERS PANEL

The Layers panel lets you work with layers (sets of pixels which can be edited separately) and groups of
layers. 

Layers Panel

The panel contains a list of layers. It remains empty until you open an image or create a new document. 

The active (editable) layer is highlighted in gray. To select another layer, click its name or thumbnail. To
select multiple layers, click them while holding down Ctrl . To select multiple contiguous layers, click the
first layer and then Shift -click the last layer. 

To rename a layer, double-click the layer's name next to it's thumbnail, then type a new name and press
Enter . 

You can change the thumbnail size by pressing the button  at the top of the Layers panel. 

To the left of a layer’s thumbnail is a visibility icon / , which allows you to turn the visibility of a layer
on or off. Editing tools cannot be used on a layer when its visibility is turned off. To toggle a layer’s
visibility, left-click the icon. 

Note: The  layers  contained  in  a  group  are  visible  only  if  the  group’s  visibility  is  turned  on
(regardless of the visibility of separate layers). 

There are several layer types: 

Raster Layer is a basic layer type which allows applying brushes and filters. Other layers can be
rasterized by using the Rasterize Layer command. 

Adjustment Layer is marked with an  icon to the right of the layer name. This layer contains

the result of an  adjustment being applied. Click the mark to open the Adjustment Layer settings
panel. 

Shape Layer is marked with a  icon to the right of the layer name. This layer type is used to

create and edit vector shapes. Click the mark to open the Shape Layer settings panel. The layer is
created automatically when using the shape tools. 

Text Layers are used to add inscriptions to images. They are created automatically when using the
text tools. 

You can change the order of the layers by dragging them up and down in the panel. 
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Right-clicking on a layer opens a menu of commands. The available menu items depend on the layer type
and the number of selected layers. 

Blending Options opens the blending options dialog box. 

Layer Properties opens the separate parameter menu of an adjustment or a shape layer. 

Duplicate creates a copy of the selected layer or group of layers. You can copy the layer to a new
document as well as to an open document. The copy direction can be set in the dialog box. You can
copy the selected layer or group of layers by dragging it with the mouse while holding down the
Shift+Alt  keys on Win (⇧+Options  on Mac). 

Also, you can copy the layer to another image by moving the layer icon to the open document tab. 

Delete deletes the selected layer or group. 

Reveal All adds a transparent mask to the layer. The corresponding Control Panel command is
Layers -> Layer Mask -> Reveal All. 

Hide  All adds  an  opaque  mask  that  hides  the  entire  layer.  The  corresponding  Control  Panel
command is Layers -> Layer Mask -> Hide All. 

Reveal Selection creates a mask that hides everything except the selected part of the layer. The
corresponding Control Panel command is Layers -> Layer Mask -> Reveal Selection. 

Hide Selection creates a mask that only hides the selected area of the layer. The corresponding
Control Panel command is Layers -> Layer Mask -> Hide Selection. 

Create/Release Clipping Mask adds the selected layer to a  clipping mask or removes the layer
from it. 

Add Alpha Channel to Selection creates a selection which combines the alpha channel with the
selection channel. 
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Subtract  Alpha  Channel  from Selection creates  a  selection  which  includes  all  the  selection
channel contents excluding the alpha channel. 

Intersect Alpha Channel with Selection creates a selection which includes the common parts of
the alpha channel and the selection channel. 

Group Layers combines selected layers into a group. 

Ungroup Layers quickly separates layers from the selected group. 

Show/Hide Layers enables/disables the displaying of contents of layers/groups. 

Copy Layer Effects command allows you to copy the selected or all layer effects to the clipboard. 

Paste Layer Effects command allows you to add the copied effects to the selected layer. 

Clear Layer Effects command allows you to remove the selected or all layer effects. 

Rasterize Layer converts any layer to a regular (raster) layer. 

Vectorize Text Layer converts the selected text layer to the shape layer. 

Merge Layers merges the selected layers into a single layer. 

Merge Group merges visible layers of the group into a single layer. The new layer is placed in the
main list instead of the group. Invisible layers disappear. 

Merge Clipping Mask merges all layers of the clipping mask into one raster layer. 

Merge Visible combines all visible layers into one layer. 

Merge All combines all visible layers, discarding the invisible ones, into one layer. 

Bring to Front moves the selected layer to the top of the list. 

Bring Forward swaps places between the selected layer and the layer above it. 

Send Backward swaps places between the selected layer and the layer below it. 

Send to Back moves the selected layer to the bottom of the list. 

The Lock icon next to each layer prevents the layer from further editing. Click on the icon to select a lock
mode. 

Lock Modes
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Unlock  - this icon means the layer is in an unlocked state (editable).

Lock Image Pixels  protects the opaque pixels of a layer from any changes made by drawing/

editing tools. 

Lock Transparent Pixels  (only for raster layers) prevents changes to the transparent pixels. 

Lock Position  prevents a layer from being moved.

Lock All  prevents any changes to a layer. 

Double-clicking on a layer’s thumbnail opens the Blending Options menu. Close the menu by pressing
Esc  (changes will be ignored) or by clicking outside of the menu window (changes will be saved). 

The Blending Options menu looks like this: 

Blend Mode determines how the pixels on one layer are blended with those on the layer below it. 

Opacity (0-100) affects the visibility of other layers below the selected layer. If a layer has an
opacity of 0%, it will be completely transparent (invisible). The intermediate opacity value results in
partial permeability of the pixels on that layer. At 100% opacity, only the pixels on that layer are
visible. Transparent and translucent areas are filled with a checkerboard pattern. 

For blend modes other than normal, Opacity affects their influence on forming a blended image. 

Note: Blend Mode options and Opacity parameters are also displayed at the top of the 
Layers panel and can be adjusted without opening the menu.

Channels mode  controls  independent  color  channels.  Enable  the  check-boxes  to  select  color
channels involved when blending layers. 

Blend by Brightness controls the visibility of pixels on the active layer and layers below it based on
their brightness. 

The buttons at the bottom of the panel are used as follows: 

The  Add  Effect button   opens  the  Layer  Effects menu.  Use  its  commands  to  change  the

appearance of a layer. 

The  New Mask button   creates a  Layer Mask. After pressing the button, an extra thumbnail

appears to the right of the layer thumbnail. 
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The New Group button  allows you to combine multiple layers into one set. When you click on

this button in the Layers panel, elements will be created named Group 1, Group 2, etc. By moving a
folder you can move all of the layers within it together. 

To add a layer to a group, drag it to the folder while holding down the left mouse button and release
it when it is above the folder. You can remove a layer from a group in a similar way. If you drag the
folder to the  button at the bottom of the panel, a copy of the folder along with its sub-layers will

be created. 

To group multiple layers, select them and press the   button or use the command  Layers ->

Group Layers. 

To ungroup the layers, select a group and use the menu command Layers -> Ungroup. 

To rename a group, double-click on its name, enter a new value and press Enter . 

Click on the folder to open/close the group. When a group is opened , its constituent layers can

be moved, deleted, or edited individually.  If  the active group is  closed  ,  new layers will  be

created above. 

You can change a  Blend Mode for  a  group of  layers.  By default,  the  Pass Through mode is
selected for a group in the blend modes list, that is the layers inside the group interact with each
other (and the layers below) in the usual way - as if they are not grouped. 

When other blend modes are used, the group behaves as if all layers inside it are combined into one
layer, which interacts with the layers outside the group based on the chosen blend mode. In this
case, blend modes of individual layers in the group are valid only within that group, and have no
affect on layers outside of the group. 

Closed Group Opened Group

The New Layer button  creates a new layer above the active layer or in the active group. If you

drag a layer (or group) to this button while holding the left mouse button and then release the left
mouse button, a copy of that layer (or group) will be created. When creating a new layer a pop-up
menu appears, letting users specify a layer type - raster, adjustment, or shape. 

When choosing an  adjustment layer from the list, you can specify what kind of adjustment is
required. Adjustment layers contain settings which affect the underlying layers without changing
their pixel values. 
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The settings of the adjustment layers overlap with the settings in the Adjustment menu: Image ->
Adjustment. 

The Delete button  removes the selected layer/group. Drag a group to this button to delete the

group along with all  of its contents. If  a group is selected, and then the button is pressed, it’s
possible to delete the group with or without its contents (your choice). 

Note: It is impossible to delete all layers. 
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LAYER EFFECTS

You can add Layer Effects to the selected layers to change the appearance of their contents. To add an
effect, click  in the Layers panel or call the command Layers -> Layer Effects. 

Layer Effects

Layer effects are applied to a particular layer or group of layers. When you change the contents of a layer,
the effects are applied to the new content. 

Layer effects can be moved between layers by dragging them with the mouse cursor. 

You can use the commands: 

Copy Layer Effects - to copy the selected effects to the clipboard. 

Paste Layer Effects - to add the copied effects to the selected layer. 

Clear Layer Effects - to remove the selected or all layer effects. 

You can also copy effects from one layer to another by dragging them with the mouse cursor while holding
down the Shift+Alt  keys on Windows, ⇧+Options  on Mac. 

Layer Effects: 

Bevel & Emboss (Emboss, Bevel, Deboss). The effects in this group add volume to the layer. 

Emboss. The effect imitates the relief surface; both the current and the underlying layer are
affected. 
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Emboss

Bevel. The effect imitates the relief surface; only the current layer is affected. 

Bevel

Deboss. The option imitates the stamping effect. 
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Deboss

Parameters of the effects group: 

Blend Mode. The parameter determines how the effect blends with the pixels of the current
layer.

Shadow Opacity (0-100). The parameter controls the opacity of the shadow.

Shadow Color. To change the color of the shadow, call the Select Color dialog box by clicking
on the color plate.

Highlight Opacity (0-100). The parameter determines the opacity of the highlight. 

Highlight Color.  To change the color of the highlight, call  the  Select Color dialog box by
clicking on the color plate.

Smoothing (0-50). The parameter determines the sharpness of the effect. The higher the
value, the more blurred the effect.

Size (1-200). The parameter specifies the width of the effect. The higher the value, the larger
the size of the relief. 

Angle (-180..-180). The parameter adjusts the position of the light source. Depending on the
value, the arrangement of light and dark areas changes. When holding down the Shift  key,

the angle will change in increments of 5o, when holding down the Ctrl  key, in increments of

10o.

Altitude (0-90). The parameter sets the height of  the light source. At higher values, the
shadow becomes darker.

Depth (1-150). Specifies the depth of the effect. The higher the value, the stronger the relief.

Shift (1-99).  The parameter  moves the semi-transparent  effect  border  within  the blurred
area. At higher values, the effect shifts inwards; at lower values - outwards.
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Stroke. The effect outlines the contents of the layer with the chosen color. 

Stroke

Effect Parameters: 

Blend Mode. The parameter determines how the effect blends with the pixels of the current
layer.

Color. To change the color of the contour, call the Select Color dialog box by clicking on the
color plate.

Opacity (0-100). The parameter defines the transparency of the effect.

Size (1-250). The parameter determines the thickness of the contour.

Blur (0-50). The parameter specifies the sharpness of the contour. The higher the value, the
more blurred the contour.

Shift (1-99). The parameter moves the contour within the blurred area. At higher values, the
effect shifts inwards; at lower values - outwards.

Position.  From the drop-down menu, select the position of the effect: Outside, Inside, or
Center.

Inner Shadow and Outer Shadow. The effects add the shadow to the layer. 

Inner Shadow. The shadow appears inside the boundaries of the layer. 
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Inner Shadow

Outer Shadow. The shadow appears outside the boundaries of the layer. 

Outer Shadow

Parameters of the effects group: 

Blend Mode. The parameter determines how the effect blends with the pixels of the current
layer.

Color. To change the color of the shadow, call the Select Color dialog box by clicking on the
color plate.
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Opacity (0-100). The parameter defines the transparency of the effect.

Distance (0-3000).  The  distance  between  the  shadow  and  the  object/layer  casting  the
shadow.

Angle (-180..-180). The parameter adjusts the position of the light source. Depending on the
value, the position of the shadow changes. When holding down the Shift  key, the angle will

change in increments of 5o, when holding down the Ctrl  key, in increments of 10o.

Choke (0-100)  (for  the  Inner  Shadow).  The  parameter  pulls  the  inner  shadow's  edges
toward the center before blurring.

Spread (0-100) (for the Outer Shadow). The parameter expands the outer shadow's edges
before blurring.

Size (0-250). Specifies the size of the shadow relative to the size of the object.

Layer  Knocks Out.  When the  check-box is  enabled,  the  layer  content  is  cut  out  of  the
shadow.

Inner Glow and Outer Glow. The effects add color glow to the layer. 

Inner Glow. The effect adds glow that emanate from the inside edges of the layer’s content. 

Inner Glow

Outer Glow. The effect adds glow that emanate from the outside edges of the layer’s content.
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Outer Glow

Parameters of the effects group: 

Blend Mode. The parameter determines how the effect blends with the pixels of the current
layer.

Color. To change the color of the glow, call the Select Color dialog box by clicking on the color
plate. 

Opacity (0-100). The parameter defines the transparency of the effect.

Choke (0-100) (for the Inner Glow). The parameter pulls the inner glow's edges toward the
center before blurring.

Spread (0-100) (for the Outer Glow). The parameter expands the outer glow's edges before
blurring.

Size (0-300). The parameter specifies the width of the glow.

Range (0-300). The parameter adjusts the glow range.
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Satin. Creates the effect of light reflection in the current layer. To obtain the effect, two copies of
the layer are created, filled with color, shifted and blurred. 

Satin

Effect Parameters: 

Blend Mode. The parameter determines how the effect blends with the pixels of the current
layer.

Color. To change the color of the effect, call the  Select Color dialog box by clicking on the
color plate.

Opacity (0-100). The parameter defines the transparency of the effect.

Distance (0-300). The parameter adjust the size and position of the light reflection.

Angle (-180..-180). The parameter adjusts the direction along which the layer copies will be

offset. When holding down the  Shift  key, the angle will change in increments of 5o, when

holding down the Ctrl  key, in increments of 10o.

Size (0-300). This parameter determines the amount of blur.

Invert. Enable the check-box to reverse the colors of the object and the effect.
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Color Overlay. Fills the layer with the selected color. 

Color Overlay

Effect Parameters: 

Blend Mode. The parameter determines how the effect blends with the pixels of the current
layer.

Color. To change the color of the effect, call the  Select Color dialog box by clicking on the
color plate.

Opacity (0-100). The parameter defines the transparency of the effect.
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LAYER MASK

Using a mask, you can can hide portions of the layer and mask out the effect where desired. 

The quickest way to create a layer mask is to press the button  in the Layers panel. 

To create a mask, select one of the items in the menu Layers -> Layer Mask: 

Reveal All - the command creates a transparent mask that reveals the entire layer. 

Hide All - the command creates an opaque mask that hides the entire layer. 

Reveal Selection - the command creates a mask that reveals the selection. 
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Hide Selection - the command creates a mask that hides the selection. 

All the menu commands that are available as menu entries by right-clicking on the Layers panel. 

You can edit the mask using the painting tools. Select a mask in the  Layers panel by clicking on its
thumbnail. Paint with black to create an opaque mask, paint with white to create a transparent mask;
other colors will create a semi-transparent mask. 

By default, the mask is linked to the active layer. To cancel/reestablish the link between the layer and
mask, click  /  between the thumbnails or select  Layers -> Layer Mask -> Unlink/Link. Unlinking

them lets you shift the mask separately from the layer. 

You can move the mask to another layer by dragging it with the mouse cursor. If you hold down the
Shift+Alt  keys on Windows (⇧+Options  on Mac), the active mask will be copied to the selected layer.

To invert a mask, select the Invert Mask command. 

To remove a mask, select its thumbnail and click the button  or use the command: Layers -> Layer

Mask -> Delete. 
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To disable/enable a mask, select the layer containing the mask and choose Layers -> Layer Mask ->
Disable/Enable. When the mask is disabled, a "X" appears across its thumbnail, and the layer’s content
is shown without masking effects. 

To add a mask to the selection, right-click its thumbnail in the Layers or Channels panel and select one
of the following commands: 

Add Mask to Selection - The command adds a transparent area of a mask to the selection. 

Subtract  Mask  from  Selection -  The  command  subtracts  transparent  mask  areas  from  the
selection. 

Intersect Mask with Selection - The command creates a selection containing the overlapping
area of the selection and the transparent mask area. 

To apply a mask to the layer, choose Layers -> Layer Mask -> Apply (only for raster layers). After the
command is selected, the hidden layer parts become transparent. 

You can adjust the mask view mode in the  Channels panel. Click the icon to the right of the  Mask
channel and select a view mode in the drop-down menu. 

 - grayscale mask; 

 - trimap mask; 

 - red semi-transparent mask in the source image; 

 - inverted red mask; 

 - black mask in the source image; 

 - white mask in the source image. 

You can improve the mask's edges by using the Refine Edges feature in the Select menu. 
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CLIPPING MASK

Clipping Mask allows you to use the contents of one layer or group of layers as a mask for the layers
above. 

A clipping mask consists of a base layer and clipped layers above it. The opaque areas of the base layer
show where the content of the layers above will be displayed. The contents of clipped layers outside the
mask (transparent areas) are hidden. 

Clipping Mask

To create a clipping mask, you can use one of the methods: 

- select the Create Clipping Mask command in the Layers main menu; 

- select the Create Clipping Mask command in the Layers context menu; 

- press Ctrl+Alt+G  hotkey; 

- left-click + Alt  on the border between layers (the cursor will turn into ).

The selected layer will be converted to a clipped layer, and the underlying layer will be converted to a base
layer. 

The name of the mask base layer will  be underlined, and the clipped layers will  be indented with an
arrow . 

When you create or move a layer into layers of the clipping mask, it will be automatically added to it.
When moving a layer outside the clipping mask, it will be excluded from it. 

AliveColors Panels: Clipping Mask

79



When you turn off  the visibility of the base layer, the other layers of the clipping mask also become
invisible. 

To remove a layer from a clipping mask, you can use one of these methods: 

- in the Layers panel, select the layer and use the Release Clipping Mask command; 

- press Ctrl+Alt+G  hotkey; 

- left-click + Alt  key on the border between layers. 

This will exclude the selected layer and all layers above it from the clipping mask. 
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BLEND MODES

Blend modes let you mix the color and brightness of image layers. Below is an example of what can be
achieved when combining two layers: 

Upper Layer Lower Layer

The program has 27 blend modes. Each layer is set to Normal by default. 

A blend mode can be chosen for a set (group) of layers. If Pass Through is chosen from the blend mode
drop-down list, then layers in a group will interact with each other and layers below in the usual way, as if
they are not grouped. If another blending mode is chosen the set behaves as if the layers have been
merged into one layer, which interacts with layers outside of the group based on the chosen blend mode.
In this case the blend modes applied to individual layers within a set are only valid within the group and
do not affect layers outside of the group. 

Basic Modes

Normal. No interaction occurs between the active and the lower layer, ie all pixels on the upper
layer are displayed as usual. Blending in this mode can only be achieved by adjusting Opacity. 
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Dissolve. This works when Opacity is less than 100%. Lowering opacity randomly conceals pixels
on the top layer, and pixels from the lower level are shown in their place. 

Darken Modes

Darken. In this mode the top layer appears to be darker in color than the lower layer. Dark pixels
on the upper layer will remain unchanged, while the white color will be transparent. The resulting
image is derived from the least bright pixel values for each channel. 
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Multiply. The upper layer darkens the lower layer. Colors are combined in such a way that they
become denser. The image darkens. The white color will be transparent. This mode can be used to
restore faded or overexposed photos, impose shadows, or imitate a felt-tip marker. 

Color Burn. In this mode, contrast is increased by blending the darker pixels on the lower layer
with the color of the upper layer. White pixels on the layer become transparent. Shadows in this
mode are more intense than in Multiply. It is often used to increase saturation in light areas, tinted
glass, precious stones, in underlining details of collages, and to imitate the effect of Burn on an
image. 

Linear Burn. It works like Color Burn with a softer effect. 
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Darker Color. It compares the pixels of the top and bottom layers and displays those that are
darker. 

Lighten Modes

Lighten. In this mode the brighter areas of the top layer replace darker areas on the lower layer.
Brighter pixels on the upper layer will remain unchanged, while black pixels will become transparent.
The result is based on the brightest pixel values of both layers. 
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Screen. The upper layer brightens the lower, depending on its brightness. The black color on the
upper layer becomes transparent. This mode can be used to brighten dark images, simulate glow, to
blend an image with the lower layer, and with different types of glare. 

Color Dodge. In this mode the image on the lower layer is brightened by decreasing contrast based
on the color of the upper layer. The black color on the upper layer becomes transparent. The effect
on light areas is even stronger than Screen mode. This mode can be used to create bright flashes
and to match the contrast of an image with the background. 
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Linear Dodge. It works like Color Dodge with less effect. 

Lighter Color. It compares pixels of the top and bottom layers and displays those that are lighter. 
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Contrast Modes

Overlay. This mode combines the effects of Multiply and Screen modes, blending the upper layer
with the lower. The result depends on the brightness of pixels in the blended layers: if the pixels of
the lower layer are darker than those on the upper layer, the image becomes darker (Multiply), if
they are lighter than those on the upper layer, the image is lighter (Screen). It is well suited for
enhancing low contrast detail and superimposing texture on an image. If the color of the top layer is
gray (50%) there will be no effect. 
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Soft Light. The image is brightened based on the brightness of the upper layer. If the pixels on the
upper layer are brighter than neutral (50%) gray the image is brightened; if they are darker than
neutral gray, then the lower layer is darkened. If the top layer is neutral gray (exactly 50%), there is
no effect. This mode is useful for adjusting the tones of a background when making a collage, so
that an object inserted above the background will gently blend with it. 

Hard Light. Similar to the previous mode, the image is darkened (Multiply) if the pixels on the
upper layer are darker (darker than neutral gray), and lightened (Screen), if those pixels are lighter
(lighter than neutral gray). The contrast of colors is higher than in Soft Light mode. If the upper
layer  is  neutral  gray  (exactly  50%),  there  is  no  effect.  This  mode  is  useful  for  making  the
background texture of the lower layer visible on the upper layer. 

AliveColors Panels: Blend Modes

88



Vivid Light. If the color of the top layer's pixel is darker than 50% gray, the image darkens due to
the increased contrast. If the color of the pixel of the upper layer is lighter than 50% gray, the
image lightens due to the contrast decrease. If the top layer is 50% gray, there is no effect. 

Linear Light. If the color of the top layer's pixel is lighter than 50% gray, the image lightens due to
the increase in brightness. If the color of the pixel of the upper layer is darker than 50% gray, then
the image darkens due to the brightness decrease. If the top layer is 50% gray, there is no effect. 
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Pin Light. If the color of the pixel of the upper layer is lighter than 50% gray, then the pixels of the
lower layer with a darker color are replaced, and those with a lighter color remain unchanged. If the
color of the top layer's pixel is darker than 50% gray, then the lighter pixels in the lower layer are
replaced, and the darker ones remain unchanged. The mode can be used for adding special effects. 

Hard Mix. In this mode, the color of the resulting pixel is obtained by adding the color values of the
pixels of the lower layer and the upper layer. If the resulting sum for any channel is 255 or more,
then the value 255 is assigned to it, otherwise - 0. Therefore, for all blend pixels, the total values of
the red, green, and blue channels will equal 0 or 255. As a result, the pixel colors are replaced with
solid red, green, blue, cyan, magenta, yellow, white, or black, creating the posterization effect. 
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Comparative Modes

Difference. This mode displays the tonal difference between the contents of two layers. Colors are
inverted based on the brightness of pixels on the upper and lower layers. If the color of the upper
layer  is  white  the colors  of  the lower  layer  are  inverted,  if  it  is  black there no change.  If  the
combined layers are not too dark or bright and are sufficiently saturated, some interesting effects
can result. This mode can also be used to compare two images - if they differ by even one pixel, it
will be displayed in black. 
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Exclusion. Similar to the previous mode, the inversion of color is determined by the brightness of
pixels on the upper and lower layers. Pixels of intermediate colors will be shown in gray, reducing
contrast. Blending with white inverts the colors of the lower layer; blending with black has no effect.
This mode is useful for achieving various effects. 

Subtract.  In this mode, the final  pixel  color is determined by the difference between the color
values of pixels in the layers. If the result of the subtraction is negative, the pixel becomes black. 

Divide. The result color is obtained by dividing the color values of the lower pixels by the color
values of the upper pixels. If we apply to the image its copy, it will turn completely white. 
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Component Modes

Hue. In this mode, the resulting pixels have the brightness and saturation from the lower layer and
the color tone (hue) from the upper layer. 

Saturation. In this mode, the resulting pixels use the brightness and hue from the lower layer and
the saturation from the upper layer. 
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Color. In this mode, the resulting pixels have the brightness as in the lower layer and the hue and
saturation as pixels in the upper layer. This mode can be used for image toning. 

Luminosity. In this mode, the resulting pixels take the hue and saturation from the lower layer and
the brightness from the upper layer. 
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BLEND BY BRIGHTNESS

Blend by Brightness is used to control the visibility of pixels on the active layer (This Layer) and the
lower layer (Underlying Layer) based on their brightness. Each scale has two sliders. At the leftmost slider
a pixel has a brightness of 0 (black); at the extreme right a brightness of 255. 

Those pixels whose brightness falls within the values between the two sliders will be displayed (for the
upper layer) and hidden (for the lower layer). Sliders hide pixels without removing them. 

If a slider is moved while holding down Ctrl , the slider will be divided into two parts, which can then be
moved independently of one another. Divided sliders set the tonal range between visible and invisible
pixels, so you can achieve a more subtle effect with a soft color change. 

Upper Layer Lower Layer

Actions on the active layer (current layer): 

Active Layer:

Hidden 0-150,

Visible 150-255

Moving the left slider hides dark pixels with lower brightness
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Active Layer:

Visible 0-145,

Transition 145-200,

Hidden 200-255

Moving the right slider hides light pixels with higher brightness

Active Layer:

Hidden 0-40,

Transition 40-105,

Visible 105-170,

Transition 170-190,

Hidden 190-255

Moving the sliders to the middle reveals only pixels 

with brightness values within the range between the sliders

Actions on the lower layer (underlying layer): 

Lower Layer:

Visible 0-70,

Hidden 70-255

Moving the left slider makes the darker pixels of the lower layer visible on the upper layer 

if their brightness is less than the specified value

AliveColors Panels: Blend by Brightness

97



Lower Layer:

Hidden 0-155,

Transition 155-200,

Visible 200-255

Moving the right slider makes the lighter pixels of the lower layer visible on the upper layer,

if their brightness is more than the specified value

Lower layer:

Visible 0-50, Transition 50-100,

Hidden 100-170,

Transition 170-200, Visible 200-255

Moving the sliders to the center makes pixels from the lower layer visible on the upper layer 

whose brightness values fall outside the range marked by the sliders
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CHANNELS PANEL

The Channels panel lets you view and edit the image in separate channels. Channels are halftone images
providing information about the brightness of color components. The channel list contains a composite
image, color mode channels (RGB, CMYK, Lab, Grayscale), the transparency channel of the current raster
layer (alpha channel), current selection channel, and the active layer mask channel. Each channel in the
palette corresponds to a thumbnail image that displays all changes made to this channel. 

You can adjust the size of thumbnails by clicking the button  at the top of the Channels panel. 

Channels Panel for CMYK

The active (editable) channel is highlighted with a dark gray background in the list. To select another
channel, click its name. When selecting a single channel, the image is shown as grayscale. 

Displaying Green Channel Green Channel is Selected

The visibility icon next to the inactive channel means that this channel is shown in the Image Window but
is not editable. If several channels are visible, the image is displayed in color. 
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Displaying Green & Red Channels Green & Red Channels are Selected

If you select the composite channel, all component channels become visible and active. The composite
image is always located at the top of the list and is selected by default. 

Displaying All Color Components RGB Channel is Selected

To edit a channel, use the usual drawing tools. Painting on a channel with white results in 100% intensity
of  the corresponding color.  Different  shades of  color  result  in  varying color  intensity.  The black color
completely removes a color channel. 

In the  Alpha channel,  by default,  opaque areas are shown in white, transparent areas in black, and
semitransparent areas in gray. 

You  can  adjust  the  view  mode for  the  alpha  channel  in  the  pop-up  menu:  Grayscale,  Trimap,  or
Highlighted in Red. 
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Grayscale Trimap

Right-click the alpha channel to open the context menu with the following commands: 

Clear Alpha Channel fills the alpha channel with white, and the layer has no transparent areas; 

Add Alpha Channel to Selection combines the alpha channel  with the selection or  creates a
selection from the alpha channel; 

Subtract Alpha Channel from Selection removes the alpha channel from the selection channel; 

Intersect Alpha Channel with Selection creates an intersection of the alpha channel and the
selection channel. 

The Mask channel displays the current layer mask, if available: black marks protected areas, white marks
unprotected areas, gray marks the transition zone. The mask channel has 6 view modes. 

Highlighted in Red Inverted Red

Right-click the mask channel to open the context menu with the following commands: 

Remove Mask deletes the current layer mask; 

Invert Mask inverts the selected mask; 

Apply Mask merges the mask with the layer; 

Add Mask to Selection adds the unprotected area of the chosen mask to the selection; 
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Subtract  Mask  from Selection removes  the  unprotected  area  of  the  chosen  mask  from the
selection; 

Intersect Mask with Selection creates a selection that includes common parts of the selection
and the unprotected mask area. 

The  Selection channel indicates the area of the current selection: white marks selected areas, black
marks unselected areas, gray marks the transition zone. For this channel, 6 view modes are available. 

Black Background White Background

Right-click the selection channel to open the context menu with the following commands: 

Deselect cancels the selection; 

Invert reverses the selection; 

Reveal Selection adds a mask which hides everything but selected parts of the layer; 

Hide Selection adds a mask hiding the selected area. 

View Modes: 

You can change the displaying of  contents of  the alpha, mask, and selection channels in the  Image
Window by clicking the icon to the right of the channel's name and choosing from the options: 

 - Grayscale, 

 - Trimap, 

 - Highlighted in Red, 

 - Inverted Red, 

 - Black Background, 

 - White Background. 

AliveColors Panels: Channels Panel

102



SELECTIONS PANEL

The Selections panel allows users to handle multiple selections simultaneously. 

Selections Panel

The panel contains a list of selections. If there are no selections for this image, the list is empty. 

When creating selections, new items appear in the list with the names: Selection 1,  Selection 2, etc. To
rename a selection, double-click it in the list, enter a new value and press Enter . 

The current (editable) selection is highlighted in gray in the list, and its contour is marked with a dotted
line. To choose another selection, click on its name or thumbnail. To hide the contours of the selection, use
the  standard  keyboard  shortcut  Ctrl+D  on  Windows,  ⌘+D  on  Mac,  or  the  command  Select  ->
Deselect (in this case, there are no active elements in the panel list). 

To change the size of thumbnails, press the button  at the top of the Selections panel. 

To the right of the selection name you can find a lock icon / . If the element is unlocked, the selection

tools remove the current selection and create a new one. If all elements are locked, a new item will be
added to the list when creating a new selection. 

The current selection can be viewed and edited in the Channels panel. 

To delete the current selection, press  at the bottom of the panel or drag and drop the item onto this

button. 
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HISTORY PANEL

The History panel shows the list of every change made to a file. By clicking on an item in the list, you can
revert the file to a previous state. 

At the top of the panel, next to the thumbnail of an image, there is information about the file: its name,
size (in pixels), color mode, profile, date and time of creation. 

History of Changes

The history of changes is arranged in a linear fashion. This means that if you return to any intermediate
state and apply an action, all  actions on the list after it will  be permanently removed, except for the
control points (which will be placed at the top of the list). Selecting Open from the list returns the file to
its initial state (before changes were applied). 

All changes made are shown with their corresponding icon. Any successive changes made by the same
tool (two or more) are arranged in a group; the number of elements in a group is shown by a number to
the right of the icon. The list of elements in a group can be collapsed and reopened by pressing the "+"
icon to the left of the tool’s icon. 

After applying the filter or effect in the program, you can back to it and edit the result. To do this, click the
"+" icon in the History panel next to the effect's name and choose Result. The opened Effect dialog box
displays the last used settings. After the editing is done, all the subsequent history states are deleted. 

The possible number of states in the History panel can be adjusted in the Preferences. 

The following buttons are at the bottom of the History panel: 

Undo/Redo - History State / . The button allows you to switch between two last states in the

list. 

Exit Artistic Cloning/Deformation Mode . The button allows you to exit the  Artistic Cloning

mode of the Chameleon Brush tool or the Deformation mode, applying all changes made in these
modes. 

New Document from Current State . The button allows you to create a new document using

the settings at the current processing point. 

Create Checkpoint . The button allows you to save individual states of the history. A checkpoint

is any document state saved with a default name (Checkpoint 1, Checkpoint 2, etc.) with no history
of obtaining that state. To rename a checkpoint, double-click its name, enter a new value, and press
Enter . 
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Delete States . The button allows you to remove all states below the selected one, keeping all

checkpoints  at  the top of  the list.  If  this  button is  pressed while  a  checkpoint  is  selected,  the
checkpoint will be deleted. 

Collapse Group .  The button collapses  the  list  in  a  group and combines  it  into  one state,

removing the individual history of each element. 

You can also edit the history using the Edit menu commands: 

Undo cancels the last action. If you use this command several times, a series of the last actions will
be canceled. The hotkey is Ctrl+Z  on Windows, ⌘+Z  on Mac. 

Redo allows you to restore the canceled action.The hotkey is Ctrl+Y  on Windows, ⌘+Y  on Mac. 

Undo/Redo - History State - this command allows you to switch between the current and the
previous state of the document. The command is the analogue of the buttons   and   in the

History panel. The hotkey is Shift+Z  on Windows, ⇧+Z  on Mac. 

The Purge menu is used for permanent data deletion: 

History clears the whole history, except the initial and current states, as well as checkpoints. 

Clipboard deletes the contents of the clipboard. 

Clear All clears both the history and the clipboard. 

Attention: The commands in the Purge menu cannot be canceled! 
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COLOR PANEL

The Color panel displays the color component values for the selected color. The set of color components
will vary for different color modes. 

The foreground (upper) and background (lower) colors are displayed in two large squares. Double-clicking
on any of them opens the Select Color dialog. To swap colors press . Reset to the default colors (main

is black, background is white) by pressing . 

Right-clicking opens a menu of available color modes: Grayscale, RGB, Lab, and CMYK. 

Color Panel

By moving sliders or entering numerical values into the fields, one can change the individual color values
of the selected color. At the bottom of the panel is a small spectral bar; bringing the cursor over this will
cause it to take the form of an eyedropper. To choose a color, click with the eyedropper within the bar. 

The empty squares at the top are used to store frequently used (custom) colors. To add a color to the box,
drag it from the large color square. To change the main color to that in a box, left-click the box. Right-click
the color to remove it from the box. 

Select Color Dialog: 

Select Color Dialog Box
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Most of the window is occupied by a square box, where you can choose a color and adjust its saturation.
Using the vertical gradient stripe and the slider on the right side you can change the color brightness. 

Three squares at the top display the last used colors. 

Below, you can choose a color space (RGB, Lab, or HSL) and set the color if you know the exact values of
its components. 

Also, you can choose a color by entering its hexadecimal code in the Web Colors field. The six-digit code
consists of three pairs: the first pair describes the amount of red, the second pair - the amount of green,
and the third pair - the amount of blue. For example, "000000" is black and "ff0000" is red. 

In the boxes located below, you can save the frequently used colors. Just drag the color from an upper
large square. Press the Add to Custom Colors button to add the current color to a box. 
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SWATCHES PANEL

The Swatches panel contains a collection of frequently used colors. Select a color from the set by clicking
the left mouse button, and it will be set as the main color. Press   to access the control menu, which
duplicates the functions of the buttons below. 

Swatches Panel

The squares at the bottom of the panel keep the last used colors. Left-click the cell to replace the main
color with the specified one. 

The commands from the context menu and the buttons at the bottom of the panel have the following
uses: 

Add Swatch  - adds the current color to the collection of swatches. 

Delete Swatch  - removes a color (drag it to the basket).

Reset  - resets the collection of swatches to their original settings.

Import Swatches  - loads a saved swatch collection (a .swatches file).

Export Swatches  - opens a dialog box to save the swatches.
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COLOR WHEEL

You can change the current color using the Color Wheel panel. Most of the panel is occupied by a spectral
color ring that allows you to easily fine-tune color settings and select perfect color combinations. 

Color Wheel Panel

Adjust the color using one of the color markers. The number and position of markers can be adjusted
using 5 large round buttons at the top of the panel. 

The central part of the color wheel is a triangular or square field. Select the shape of the field by clicking

 / . 

Move the small round marker vertically to adjust the brightness of the selected color or horizontally to
adjust its saturation. 

The foreground (upper) and background (lower) colors are displayed in two large squares. Double-click
any of them to open the Select Color dialog. To swap colors, press . Reset to the default colors (main is

black, background is white) by pressing . 

In the field below, there is the six-digit html color code of the current foreground color. 

Alternatively, you can pick colors using the Eyedropper tool . 
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ACTIONS

In the Actions panel, you can save a sequence of actions to be automatically applied to other images. The
actions can be applied to individual documents or used for batch processing of files. 

The actions are displayed in a list view and grouped into sets for convenience. 

Actions List

At the bottom of the panel, there are the following buttons: 

The Create New Set button  creates a new action group. The grouping of actions allows you to

organize them for easier use. 

The Create New Action button  creates a new action in the chosen set. Double-click the action's

name (or the group's name) to edit it. 

The  Record button   adds commands to the selected action. After clicking the button, all  the

commands will be recorded until you stop recording. 

Note: Not all commands are recordable.

The Play button  applies the selected action to the active image. 

The Stop button  allows to stop recording or playing of an action. 

The Save button  allows to save the selected action. 

The Load button  allows you to load an action from disk. 

The Delete button  removes the selected action or set of actions from the list. 

When playing an action, it is added to the History list as a separate item. The recorded commands and
their settings are displayed in the Actions panel. 
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FILE INFO

The File Info panel captures basic file metadata. 

The information is divided into the following sections: 

The Basic section displays the basic information about the image. 

The  EXIF section  contains  details  about  the  capture  recorded  by  the  camera  (automatically
generated at the moment the picture is taken) including camera model, aperture, exposure settings,
etc. 

The  IPTC section contains information that is added by the photographer or others. It includes a
brief description of the photo, authorship, keywords, etc. 

The GPS section displays the geographical coordinates of the shooting location. 

The XMP section stores additional information about the photo added by graphics programs. 
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ADJUSTMENTS & ADJUSTMENT LAYERS

AliveColors is a powerful tool for editing and correcting photos. 

The program offers a wide range of Adjustments and Adjustment Layers for tone and color correction
of images: 

Levels
Curves
Brightness/Contrast
Exposure
Vibrance
Hue/Saturation
Photo Filter
Color Balance
Selective Color
Color Lookup (3D LUT) (See also LUT Editor.) 
Invert
Threshold
Posterize
Black & White
Gradient Map: Solid/Noise
Desaturate (only as an adjustment) 
Match Color (only as an adjustment) 
Replace Color (only as an adjustment) 
Equalize (only as an adjustment) 

All adjustments can be applied directly to the active layer with the Image -> Adjustments commands.
You can also create an adjustment layer, that will  affect the underlying layers without changing their
contents, by selecting  Layers -> New -> Adjustment Layer or using the button   in the  Layers

panel. 

When you select an adjustment from the list, the Settings Panel appears to the right by default. You can
drag the panel to the place where you want it and the next time the panel will appear in the selected
position. 

It's possible to save the adjustment settings as Presets. Find all available presets in the drop-down list. If
you modify the parameters, the preset name automatically changes to Custom, and the Save Custom
Preset button  appears next to the list. To save the current settings, press this button. 

A new preset is automatically assigned a name (for example,  Custom_1,  Custom_2, etc.) that can be
changed as needed by entering any combination of letters and numbers in the highlighted field. After
pressing Enter , a new preset will appear in the drop-down list. 
To remove a user preset, select it and press the Delete Custom Preset button . 

Click  to export user presets to a .presets file. To load the presets into the program, press on . 
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LEVELS

The Levels adjustment is used for correcting the tonal range and color balance of an image by adjusting
the brightness of its shadows, midtones, and highlights. Watch our video tutorial to learn more about the
Levels adjustment. 

Display the parameters of the Levels adjustment by selecting Image -> Adjustments -> Levels...

You can also use the  Levels adjustment layer (Layers -> New -> Adjustment Layer -> Levels...)
which will affect the underlying layers without changing their content. 

Levels

Settings and Controls: 

The Input Levels section displays a histogram showing the initial distribution of brightness in the
image. 
Above  the  histogram  there  is  a  channels  drop-down  list.  You  can  either  adjust  each  channel
separately, or use the composite color channel. 
The right edge of the histogram represents pixels having the maximum brightness (white points).
This point corresponds to the white slider. If the histogram does not reach the right side, there are
no white pixels in the image. When you move the white slider to the left, the point against which the
slider is located will assume the maximum brightness (255) and the pixels having this value will
become white. The brightness of other pixels will be re-calculated accordingly. The image will get
lighter. 
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Adjusting White Point

The  left  side  of  the  histogram  indicates  the  point  of  minimum  brightness  (black).  This  point
corresponds to the black slider. If the histogram does not start at the left end, the image does not
have any black pixels (brightness = 0). When you move the black slider to the right, the point
against which the slider is located will assume the minimum brightness value. As a result this tone
will become black, while other pixels will be re-calculated accordingly. The image will get darker. 

Adjusting Black Point
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The middle slider defines the tone of the image that will have the brightness of 128 (middle-gray
tones). If you move the slider to the left, the mid-gray tones become lighter; if you move the slider
to the right, the mid-gray tones become darker. 

Adjusting Middle-Gray Point 

Using ,  , and  you can select the white, black, and middle-gray points directly from the

image, respectively. The values will vary for each color channel, so choose a neutral gray image area
as a sample. Otherwise, the image will be tinted. 

In the Output Levels section, you can specify the range of brightness which affects the stretching
of the range of input levels. 

If  the range of  output  levels  is  less than the range of  input  levels,  the image becomes softer.
Otherwise, the contrast will be increased. 

By pressing the  Auto button,  the software adjusts the range of  input levels  automatically.  The
automatic correction affects only the levels of the separate color channels. 

Click the Options button to open the Auto Color Correction Options dialog box. 
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Auto Color Correction Options

Choose an Algorithm: 

Enhance Monochromatic Contrast clips all color channels using the same settings for each
channel. As a result, the shadows become darker and highlights become lighter. This algorithm
is applied when using the Auto Contrast command.

Enhance Per Channel Contrast adjusts the color channels individually. The values of black
and white pixels for each color channel are changed by different amounts. The resulting image
can be tinted. This algorithm is applied when using the Auto Levels command. 

The Target Colors & Clipping section displays the percentages of white and black pixels which will
be removed from each end of the range. 

Save as Default check-box. If the check-box is enabled, the specified parameter values will be used
as default when using the Auto command. 

Fixed Preview Area check-box. When the check-box is enabled, all changes are displayed in a small area
indicated by the dotted line. When the check-box is disabled, the changes are applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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CURVES

The Curves adjustment allows you to change the brightness and contrast of the entire image or in the
local area. Watch our video tutorial to learn more about the Curves adjustment. 

Select Image -> Adjustment -> Curves... to display the adjustment settings. 

You can also use a  Curves adjustment layer (Layers -> New -> Adjustment Layer -> Curves...)
which will affect all underlying layers without changing their content. 

Curves

Settings and Controls: 

Most of the dialog box is covered by the curves graph. You can adjust the curves either in each color
channel or using in the composite channel. Select the desired channel in the Channel drop-down
menu above the graph. 

By default, the curve is a straight line having a slope of 45o and it does not reflect any changes.
When you move any section of the curve above the diagonal line, the corresponding area of the
image becomes lighter. When you move it below the diagonal line, the corresponding area becomes
darker. 
When you drag the entire curve above the diagonal line, the entire image becomes lighter. When
you drag the entire curve below the diagonal line, the entire image becomes darker. 
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Curve Above the Diagonal Line Curve Below the Diagonal Line

You can edit the curve in two ways: 

In the mode  you can modify the curve by setting and dragging the control points.

In the mode   you can draw a curve.  Click  Smooth to  make the drawn curve appear

smoother. 

Edit Points to Modify the Curve Draw a Line

If you modify the graph using the control points, you can add extra points to the curve by clicking
on it with the left mouse button. 

Moving the points at the top of the curve adjusts the highlights. Moving the points in the center of
the curve adjusts the midtones, and moving the points in the bottom section of the curve adjusts
the shadows. 

To delete a point, right-click it or drag it off the graph. 

Note: Do not add too much points to the curve, as it can cause image artifacts.
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Specify the darkest and lightest values in the image using the sliders under the curve and these

tools , . The tools can edit the curves in each component channel but not in the composite

channel. 

Note: When using the tools  and , all previous changes will be lost! Use them at the

beginning of the correction. 

Modifying White Point Modifying Black Point

Using the tool , you can modify the white balance in the image. Click with the eyedropper on a

neutral gray area of the image. The curves of the color channels will be adjusted accordingly. 

Note: The tool  should be used after the other two, otherwise the middle gray value will be

cleared. 

With the tool   you can apply the adjustment directly on the image. Hold down the left mouse

button over the image and drag the mouse up to lighten and down to darken this image area. Press
the mouse button to create a new point on the curve. Move the mouse to bend the curve at this
point. 

Show Clipping check-box. If the check-box is checked, the Image Window emphasizes areas with
loss of detail in shadows or highlights. To see the loss in highlights, click the white point slider. To
see the loss in shadows, click the black point slider. 

Note: The Show Clipping check-box is available only in RGB mode.

AliveColors Adjustments & Adjustment Layers: Curves

119



Loss in Highlights Loss in Shadows

The color loss is indicated by color pixels on black or white background. Red pixels indicate red
channel clipping, green pixels indicate green channel clipping, and blue pixels indicate blue channel
clipping.  Other  colors  show clipping in  multiple  color  channels.  You can analyze  clipping in  the
composite channel or individually in each color channel. 

Press on the Auto button to adjust the curve range automatically. The auto correction settings affect
only the curves in the individual color channels. 

You can adjust the auto correction parameters by clicking on Options. 

Auto Correction Settings

Choose an Algorithm: 

Enhance Monochromatic Contrast - clips all color channels using the same settings. As a
result,  the  shadows appear  darker  and  the  highlights  appear  lighter.  The  Auto Contrast
command uses this algorithm.

Enhance Per Channel Contrast - clips the color channels individually. The values of black
and white points differ for each color channel. The resulting image can be tinted. The Auto
Levels command uses this algorithm.

The Target Colors & Clipping section displays the percentages of white and black pixels which will
be removed from each end of the range. 

Save as Default check-box. If the check-box is enabled, the specified parameter values will be used
as default for the Auto command. 
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Fixed Preview Area check-box. If the check-box is enabled, the parameter changes are displayed in the
small area bounded by the dotted line. If the check-box is disabled, the changes are shown in the area
visible in the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 

AliveColors Adjustments & Adjustment Layers: Curves

121



BRIGHTNESS/CONTRAST

The Brightness/Contrast adjustment allows to make simple adjustments to the tonal range of an image.
Watch our video tutorial to learn more about this adjustment. 

Select Image -> Adjustment -> Brightness/Contrast... to display the adjustment parameters in the
Settings Panel. 

You can also use a Brightness/Contrast adjustment layer (Layers -> New -> Adjustment Layer ->
Brightness/Contrast...) which will affect all the underlying layers without changing their content. 

Parameters: 

Brightness (-200..200).  The  parameter  adjusts  the  brightness  of  an  image.  By  increasing  the
value, all pixels become lighter; by decreasing the value the image appears darker. 

Brightness = -50 Brightness = 50

Contrast (-200..200). The parameter increases (at values greater than 0) or decreases (at values
less than 0) the difference between light and dark areas of an image. 

Contrast = -50 Contrast = 50
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Fixed Preview Area check-box. If the check-box is enabled, the parameter changes are displayed in the
small area bounded by the dotted line. If the check-box is disabled, the changes are shown in the area
visible in the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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EXPOSURE

The  Exposure adjustment allows you to change the amount of light in the image, making the overall
picture brighter or darker. 

Select  Image -> Adjustment -> Exposure... to display the adjustment parameters in the Settings
Panel. 

You can also use a Exposure adjustment layer (Layers -> New -> Adjustment Layer -> Exposure...)
which will affect all the underlying layers without changing their content. 

Exposure

Parameters: 

Exposure (-20..20). The parameter is designed to correct light areas with less impact on dark
areas. 

Offset (-0.5..0.5). The parameter allows you to darken shadows and midtones with minimal impact
on the highlights in the image. 

Gamma (9.99-0.01). The parameter adjusts the gamma of the image. 

Using eyedroppers, you can set parameter values: 

 - changes the exposure by shifting the color of the selected pixel towards white; 

 - sets the offset, moving the pixel towards black; 

 - defines the exposure by assigning a middle gray color to the selected pixel. 
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Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small area indicated
by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in the Image
Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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VIBRANCE

The Vibrance adjustment allows you to gently change the color saturation of an image. It's useful when
you need to increase the intensity of muted colors in a photo and leave the already well-saturated colors. 

Select  Image -> Adjustment -> Vibrance... to  display the adjustment parameters  in  the Settings
Panel. 

You  can  also  use  the  Vibrance adjustment  layer  (Layers  ->  New  ->  Adjustment  Layer  ->
Vibrance...) which will affect all the underlying layers without changing their content. 

Parameters: 

Vibrance (-100..100). The parameter has a stronger effect on the saturation of all less saturated
colors in an image, with a weak effect on well-saturated colors. 

Vibrance = -50 Vibrance = 50

Saturation (-100..100). Changes the intensity of all colors in an image. The setting value varies
from -100 (black and white) to +100 (very bright colors). 

Saturation = -50 Saturation = 50
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Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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HUE/SATURATION

The  Hue/Saturation adjustment allows to change the color properties of  an image with subsequent
correction  of  the  saturation  and brightness.  Watch our  video tutorial to  learn  more about  the  Hue/
Saturation adjustment. 

Select  Image  ->  Adjustment  ->  Hue/Saturation... to  display  the  adjustment  parameters  in  the
Settings Panel. 

You can also use a Hue/Saturation adjustment layer (Layers -> New -> Adjustment Layer -> Hue/
Saturation...) which will affect all the underlying layers without changing their content. 

Parameters: 

In  the  drop-down  list,  select  a  color  range  for  correction.  Enable  Master to  edit  all  colors
simultaneously. 

Hue (-180..180). The parameter modifies the hue of all colors in the image or of the selected color
range. 

Hue = -100 Hue = 100

Saturation (-100..100).  The  parameter  changes  the  saturation  of  the  entire  image  or  of  the
selected color range. 

Saturation = -50 Saturation = 50
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Brightness (-100..100). The parameter allows to lighten / darken the entire image or the selected
color range. 

Brightness = -10 Brightness = 10

You can define the color range more precisely using two gradient lines and four adjustment sliders:
two outer and two inner sliders. 

The upper line shows original colors, the lower line shows the colors after correction. The colors
between the inner sliders will be affected to the full extent. The colors between the inner and the
outer sliders will change less (the farther from the inner slider, the weaker the effect will be). The
colors outside the outer sliders will stay the same. 

Note: This control is not available when selecting Master. 

Source Image Modified Hue
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Fixed Preview Area check-box. If the check-box is enabled, all changes will be displayed in a small area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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PHOTO FILTER

The Photo Filter adjustment simulates the effect of colored glass filters on a camera lens and allows you
to adjust the color tone and temperature of a photograph. 

Select  Image -> Adjustment -> Photo Filter... to display the adjustment parameters in the Settings
Panel. 

You can also use the Photo Filter adjustment layer (Layers -> New -> Adjustment Layer -> Photo
Filter...) that will affect all the underlying layers without changing their content. 

Parameters: 

Filter. Select one of the built-in color filters from the drop-down list. 

Color. Choose a color that will be blended into the image from the color selection dialog called by
clicking the color plate. 

Original Image Cooling Filter (82)

Density (1-100). Controls the amount of color applied to the image. 

Density = 25 Density = 75
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Preserve  Luminosity.  When  the  check-box  is  active,  color  changes  do  not  affect  the  overall
brightness of the image. 

Preserve Luminosity off Preserve Luminosity on

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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COLOR BALANCE

The Color Balance adjustment allows you to correct color tints in individual tonal ranges. 

Select Image -> Adjustment -> Color Balance... to display the adjustment parameters in the Settings
Panel. 

You can also use the Color Balance adjustment layer (Layers -> New -> Adjustment Layer -> Color
Balance...) that will affect all the underlying layers without changing their content. 

Color Balance

Parameters: 

In the Shadows, Midtones, Highlights tabs, select the tone range for correction. 

Using  the  Cyan/Red,  Magenta/Green and  Yellow/Blue options,  increase  or  decrease  the
amount of the desired color in the selected tonal range. 

Preserve Luminosity.  If  the check-box is  enabled, the overall  brightness of  the image will  be
preserved while changing the color. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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SELECTIVE COLOR

The  Selective Color adjustment allows you to change the selected color in an image without affecting
other colors. 

Select  Image  ->  Adjustment  ->  Selective  Color... to  display  the  adjustment  parameters  in  the
Settings Panel. 

You can also use the  Selective Color adjustment layer (Layers -> New -> Adjustment Layer ->
Selective Color...) that will affect all the underlying layers without changing their content. 

Selective Color

Parameters: 

Range. In the drop-down list, select the color/tone range to be adjusted. 

Color Components (-100..100). The Cyan, Magenta, Yellow, Black values allow you to change
the amount of the selected color within the specified range. 
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Relative. When the check-box is enabled, the parameters change the amount of cyan, magenta,
yellow, or black depending on its percentage in the selected color. When it's disabled, the color is
modified in absolute values. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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COLOR LOOKUP (3D LUT)

The  Color Lookup (3D LUT) adjustment allows you to change colors and tone of your image using a
Look Up Table (LUT) file. This feature helps you to quickly make a particular look for your image and
totally change its mood. 

Select Image -> Adjustment -> Color Lookup (3D LUT)...

You can also apply the Color Lookup (3D LUT) adjustment layer (by selecting it in Layers -> New ->
Adjustment Layer) that will affect all the underlying layers without changing their content. 

Color Lookup

If necessary, you can load a Look Up Table to AliveColors by clicking  and selecting a file or multiple

files in the .3dl or .cube format. The selected lookup table will be added to the list and can be applied to
the image. To save the file to a disk, click . To remove a LUT from the list click . 

To call the LUT Editor, use these buttons: 

The Create button opens a dialog box for creating a new lookup table; 

The Edit button opens a dialog box for editing the selected lookup table. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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LUT EDITOR: CREATING AND EDITING LOOKUP TABLES

The LUT Editor is designed for general or selective tonal correction and creating or editing color tables
(CLUTs), which can be used in the Color Lookup (3D LUT) adjustment and adjustment layer. 

LUT Editor

In the left side of the dialog box, there is an image preview where all the changes are displayed. 

In the drop-down menu, you can select the preview scale. 

When you enable the Original check-box, the original image will be shown in the preview window. 

Using the  Eyedropper tool  , you can select a color from the image for editing in the  3D LUT tab.

When you click within the preview image, a grid node closest to the specified color will be selected. 

The  color  fields  indicate  the  original  color  at  a  point  (upper)  and  the  modified  color  (lower)  with
coordinates in RGB space. 

Using the Hand , you can scroll the image in the preview window. 

In the right part of the dialog box, there are options for creating and editing color tables. 

In the File Name field, enter a short file name. 

In the Title field (optional), enter a meaningful name that describes the effect being produced. 
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Select file format: 

.3dl – can store 1D and 3D, but the 1D table is the same for all R, G, B channels; 

.cube (Ir) – IRIDAS/Adobe LUT, can store either 1D or 3D; 

.cube (Re) – DaVinci Resolve LUT, can store 1D and 3D. 

There are two stages of color correction - 1D and 3D, which are applied sequentially, that is, the result of
the 1D correction is fed to the 3D correction input. 

Set Quality separately for 1D and 3D: 

1D - the Curve Table Size in the range from 9 to 4096; 
3D - the Cube Size (size of a cube side) in the range from 2 to 256. 

The 1D data is represented by three tables of numbers (channel values) corresponding to the channels R,
G,  B.  Editing  the  1D  data  is  carried  out  in  the  1D LUT tab  using  curves.  For  1D LUT,  the  linear
interpolation is used. 

1D LUT Tab

When the All Channels check-box is enabled, the curve changes simultaneously for all channels. If the
check-box is disabled, the curve can be changed individually for each channel. 

Clicking the Clear button will reset the curve to its default value. 

When you click the  Reset button, the curve will be returned to its original form (as it was when you
launched the LUT Editor). 

3D data is a table of triplets of numbers (R, G, B values) in a 3D cube. Editing 3D data is carried out in the
3D LUT tab by shifting grid nodes from their initial position. 
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3D LUT Tab

The central part of the window is occupied by a color gradient field with a grid. It is a set of points that
can be moved from the starting position. The grid nodes are located in a cylindrical space, corresponding
in meaning to the HSL (Hue, Saturation, Lightness) space. 

The number of grid nodes is determined by the Node Grid Size parameter. 

Attention! When changing the grid size, all nodes will be reset to their original state. 

Grid nodes can be free (small marker) or locked (large marker). A locked node maintains its position and
brightness regardless of the movement and brightness of its neighbors. 

Click the node to select and lock it. Adjust the brightness of the selected node using the slider located
under the grid. Select multiple nodes by holding down the Ctrl  key. 
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Original Grid and Image

Shifting a grid node from the initial position, you can replace the initial hue with the one specified by the
current position of the grid node. 

Modified Grid and Image
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When you right-click the changed node, the state will return to the initial state, the brightness and locking
will be reset. If several nodes are selected, they will all return to their original state. 

Select All - selects all grid nodes. 

Deselect - if several nodes are selected, it will be canceled for all but one. 

Color Model is a mathematical model for representing color in the coordinates of the working cylindrical
space. 

You can choose from the models:  HSL (Hue, Saturation, Lightness),  HCY (Hue, Chroma, Luma),  Lab, 
YUV. 

The choice of model depends on the original image and the task at hand. Choose a model which will not
create contours, halos, and other defects in the result. 

HSL Lab

Interpolation Method – calculating an intermediate value for a smooth transition from one table cell to
another with a fractional argument. You can choose either Trilinear or Tetrahedral method. 

Hald Image is a visual representation of a 3D LUT. It is a flat square image containing all the colors of
the cube in sequence when the R component changes first, then G and then B. 

Level – a number from 2 to 16 that matches the sizes of the cube and square. 
Save Hald - when you click the button, the image will be saved to disk as a PNG file. 

Click the Clear button to reset the grid to its default value. 

Click the  Reset button to return the grid to its original form (as it was when you launched the  LUT
Editor). 

In the Text Data tab, you can add a comment and indicate copyright. 

Click the Export button to save the configured lookup table to disk. 

Click OK to add the configured lookup table to the LUT list in the Color Lookup (3D LUT) adjustment. 

Click Cancel to close the dialog box without accepting the changes. 
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COLOR INVERSION

The  Invert adjustment  reverses  the colors  in  an image.  The brightness  value of  each pixel  in  each
channel  is  converted  to  the  inverse  value.  For  instance,  a  pixel  with  the  value  of  0  (black)  will  be
converted to the value of 255 (turns white). Watch our  video tutorial to learn more about the  Invert
adjustment. 

To apply the  Invert adjustment, go to the Control Panel menu and select  Image -> Adjustment ->
Invert. 

You can also use an  Invert adjustment layer (command  Layers -> New -> Adjustment Layer ->
Invert) which will affect all the underlying layers without changing their content. 

Inverted Colors
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THRESHOLD

The Threshold adjustment converts photos into high-contrast, black-and-white images. Watch our video
tutorial to learn more about the Threshold adjustment. 

The adjustment parameters are displayed in the Settings Panel by selecting in the menu:  Image ->
Adjustment -> Threshold...

You  can  also  use  a  Threshold adjustment  layer  (Layers  ->  New  ->  Adjustment  Layer  ->
Threshold...) which will affect all the underlying layers without changing their content. 

The dialog box contains the following elements: 

Histogram. The histogram shows the distribution of brightness in the image. 

Threshold (0-100). This parameter sets the threshold level of brightness. All pixels darker than this
value will be converted to black; all pixels lighter than this value will be converted to white. 

Threshold = 25 Threshold = 75

Fixed Preview Area check-box. If the check-box is enabled, all changes will be displayed in a small area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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POSTERIZE

The  Posterize adjustment creates a simpler image by reducing the number of lightness levels in each
color channel. Watch our video tutorial to learn more about the Posterize adjustment. 

Select Image -> Adjustment -> Posterize... to display the adjustment parameters. 

You can also use a Posterize adjustment layer (Layers -> New -> Adjustment Layer -> Posterize...)
which will affect all underlying layers without changing their content. 

Posterize

Parameters: 

Levels (1-255).  The parameter determines the degree of  posterization of  the image. At higher
values of this parameter, fewer colors are used, and the image becomes more uniform and flat. 

Simplicity (0-8). The parameter removes fine details. The boundaries become more uniform. 

Fixed Preview Area check-box. If the check-box is enabled, all changes will be displayed in a small area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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BLACK & WHITE

The Black & White adjustment lets you convert a color image to grayscale and specify the color tone.
Watch our video tutorial to learn more about the Black & White adjustment. 

Select Image -> Adjustment -> Black & White... to open the adjustment parameters. 

You can also use a Black & White adjustment layer (Layers -> New -> Adjustment Layer -> Black &
White...) which will affect all underlying layers without changing their content. 

Parameters: 

You can apply the tonal  Correction using the hexagon consisting of 6 sections, each having one
color and a control. Use the control to darken or lighten the gray tones that correspond to the
original image colors and are close to the section color. The closer the control to the center, the
darker the tone, and vice versa, the farther from the center, the lighter the tone. 

The default settings can be restored with a left-click the gray hexagon in the center. 

Default Result After Correction

Toning.  Choose a color on the gradient circle to add a color tint to the image. By default, the
control is in the center of the gradient circle and the image has gray tones. You can set a tint with a
click the gradient circle; the control will move to the defined point. The control also regulates the tint
saturation - the farther from the center, the more saturated the color shade is. 
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Light Blue Saturated Sepia

Fixed Preview Area check-box. If the check-box is enabled, all changes will be displayed in a small area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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GRADIENT MAP

The Gradient Map adjustment maps colors of the selected gradient to the brightness range of an image.
The shadows are replaced with the colors of the starting points of the gradient, the highlights are replaced
with the colors from the end of the gradient. All other colors in the image will also be replaced with the
corresponding gradient colors. 

Select  Image  ->  Adjustment  ->  Gradient  Map  ->  Solid/Noise... to  display  the  adjustment
parameters in the Settings Panel. 

You  can  also  use  the  corresponding  adjustment  layer  (Layers  ->  New ->  Adjustment  Layer  ->
Gradient Map: Solid/Noise...) which will affect all the underlying layers without changing their content. 

Gradient Map: Solid

The smooth gradient looks like a gradual transition from one color to another. 

Gradient Map: Solid

Parameters: 

Select a gradient fill from the library, which stores all available gradients, both built into the program
and created by a user. 
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You can enter a name of a gradient into the field at the bottom of the list. 

Click  to add a new gradient to the library. 

To remove the selected gradient press . 

Click  to save all gradients into a file with the .gradlib extension. 

To load the gradient library (*.gradlib), use the button .

Using the gradient line, you can change the number of gradient colors by adding or removing new
points with a left mouse click, as well as change color and transparency of the color components of
the gradient. To remove a color point from the gradient, drag it aside and release the mouse button.

Gradient Point Adjustment: 

Adjust the color, transparency, and position of the points of the gradient using the pop-up menu
called by right-clicking in the point. 

You can set the color of the point using the spectral bar in this pop-up menu. It's also possible to
use the color selection dialog called by clicking on the color square or adjust the values of the color
components. 
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The Color check-box enables/disables for the point the selected color shown in the large square to
the right. Smaller squares represent the last colors used to create the gradient. If the check-box is
disabled, the color of this point depends on adjacent pixels and cannot be changed. 

The Opacity parameter (0-100) sets the transparency of the gradient at the point. If the value is
less than the maximum, the opacity of the gradient will smoothly change from point to point. When
the check-box is disabled, the transparency of the gradient at the point cannot be changed and
depends on the overall opacity of the gradient and the opacity of adjacent points. 

With  the  Position parameter  (0-100)  you can specify  the exact  position  for  each point  of  the
gradient. 

Note: At the extreme points of the gradient, the Color and Opacity check-boxes are always
enabled, and the Position parameter cannot be changed. 

The Reverse button  reverses the order of the colors of the gradient.

The  Smoothness (0-100) parameter makes the gradient smoother by smoothing the transitions
between the individual  colors and shades of  colors.  Decreasing the value makes the transitions
between colors more visible. 

If the Show Transparency check-box is active, the transparency of the gradient will be taken into
account, if it is disabled, the gradient will be completely opaque.

Gradient Map: Noise

The noise gradient looks like a set of randomly distributed colors from a given range. 

Gradient Map: Noise
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Parameters: 

Color  Model.  The  drop-down  list  contains  the  available  color  models  that  change  the  color
components accessible for customization (RGB, HSB, LAB). 

Color Components (0-100). Depends on the chosen color model. Changing the ranges changes the
colors in the gradient. For example, for an HSB model, you can specify the ranges of hue (H),
saturation (S), and lightness (B) of the colors used in the gradient. 

Roughness (0-100). The smoothness of the gradient fill. At the value = 0, a smooth gradient is
created, increasing the value makes the gradient more noisy. 

Add  Transparency.  Enable  the  check-box  to  add  transparency  to  the  random  colors  of  the
gradient. 

Dithering. Enable the check-box to smooth out the transitions between the colors of the gradient. 

Random Seed (0-999). Generates a new gradient with the given settings. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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DESATURATE

The  Desaturate adjustment  allows  you  to  quickly  convert  a  color  image  to  black  and  white.  It
automatically  reduces  the  saturation  of  each  color  to  zero  and  converts  each  color  to  its  grayscale
equivalent. 

Select in the menu Image -> Adjustment -> Desaturate. 

Using Desaturate Adjustment
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MATCH COLOR

The Match Color adjustment allows you to transform colors of an image according to another image. 

Select Image -> Adjustment -> Match Color... to display the adjustment parameters in the Settings
Panel. 

Using Match Color Adjustment

Parameters: 

Load  Sample.  Click  the  button  and  select  an  image  that  will  be  used  as  a  sample  for  color
selection. 

Strength (0-100). Degree of application of the adjustment. To fade the effect, reduce the value. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area
indicated by the dotted line. If the check-box is disabled, the changes will be applied to the area visible in
the Image Window. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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REPLACE COLOR

The Replace Color adjustment allows you to replace the selected color with another color. 

Select Image -> Adjustment -> Replace Color... to display the adjustment parameters in the Settings
Panel. 

Replace Color

Use the eyedropper to specify the color you want to replace. 

Adjust the selected area using the following options: 

Invert. The check-box allows you to invert the selected area.

Tolerance (0-200). The parameter defines the width of the color range for the selected color.

Localized Area. The check-box allows you to limit the area to the specified Radius with the center
at the point selected with the eyedropper.

Selection Modes (in the form of icons) - modes of the eyedropper which determine the result of
the interaction between selected colors. 

New . Selecting a new color to replace.

Add .  The new color  is  added to the already selected one.  The mode is  activated by

holding down the Shift  key.

Subtract . The selected color is excluded from the processed area. The mode is activated

by holding down the Alt  key.
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The preview area shows either the original image (Image) or the selected area (Selection) as a
mask. In the latter case, the processed areas are shown in white, the unused areas in black, and the
transition zone in shades of gray.

Adjust the color in the selected area using the options: 

Hue (-180..180). The parameter allows you to adjust the color tint.

Saturation (-100..100). The parameter allows you to change the saturation of the selected color.

Lightness (-100..100). The parameter allows you to lighten or darken the selected color.

The color changes will be displayed in the color field. Left-click in the color field to call up the color
selection dialog where you can select a color to replace. 

Click Default to restore the default values. 

Click OK to apply all changes and close the dialog box. 

Click Cancel to close the dialog box without applying any changes. 
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EQUALIZE

The Equalize adjustment allows you to redistribute pixel brightness values to more evenly fill the image
brightness range: the brightest pixels become white, the darkest pixels become black, and the rest are
distributed among different shades. 

To apply this adjustment, select in the menu: Image -> Adjustment -> Equalize. 

Using Equalize Adjustment

Hint: You can duplicate the layer and then fade the equalized image to blend with the original. 
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EFFECTS

AliveColors is a powerful software for editing and correcting photos. The program provides a number of
various effects for image enhancement and photo stylization. 

Find them in the Effects menu: 

Artistic

Comics
Halftone Pattern
Linocut
Pen & Ink
Pencil Sketch
Photocopy
Stencil
Torn Edges

Blur

Gaussian Blur
Iris Blur
Lens Blur
Motion Blur
Radial Blur
Smart Blur
Surface Blur
Tilt-Shift

Brush Strokes

Accented Edges
Dark Strokes
Glowing Edges
Splatter
Spray

Channel Mixer
Combine Images

Chameleon
Emersion

Distortion

Displace
Extrude
Pinch
Polar Coordinates
Ripple
Twirl
Wave

Drop Shadow
Glamour
Glitch Art
High Pass
Lens Correction
Noise

Add Noise
Dust & Scratches
Median
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Page Curl
Pixelate

Crystalize
Mosaic

Shadow & Highlight
Sharpen

Sharpen
Unsharp Mask

Texture Fill
Two Keys

Some effects (Comics, Linocut, Pencil Sketch, Pen & Ink, Stencil, Combine Images, Drop Shadow, Glitch
Art,  High Pass, and some Blur filters) are not available in the  Free version of AliveColors, they can be
used only with the  Home/Business licenses (compare). In the Free version, you can try these effects
only with the watermark. After activating with a Home/Business license, the watermark will disappear, all
filters will become available. 

The AliveColors effects are also available in the Effects Gallery. The effects are divided into groups, each
effect with its thumbnail. Click a thumbnail to open the effect parameters. 

Effects Gallery

When you select an effect, the Settings Panel appears to the right by default. You can drag the panel to
the place where you want it and the next time the panel will appear in the selected position. 
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You can save the effect settings as Presets. Find all available presets in the drop-down list. If you modify
the parameters, the preset name automatically changes to Custom, and the Save Custom Preset button

 appears next to the list. To save the current settings, press this button. 

A new preset is automatically assigned a name (for example,  Custom_1,  Custom_2, etc.) that can be
changed as needed by entering any combination of letters and numbers in the highlighted field. After
pressing Enter , a new preset will appear in the drop-down list. 
To remove a user preset, select it and press the Delete Custom Preset button . 

Click  to export user presets to a .presets file. To load the presets into the program, press on . 

Besides, in the Effects menu, some AKVIS Built-in Plugins are available. They significantly expand the
already impressive editor's capabilities. 

It's also possible to add third-party plugins to the image editor. 

The Layer Effects are accessible here: Layers -> Layer Effects, or by clicking  in the Layers panel. 
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ARTISTIC EFFECTS

Using the Artistic effects, you can turn images into works of art. These filters allow you to stylize painting
and drawing techniques and create polygraph prints. 

Comics (unavailable in the Free version) 
Halftone Pattern
Linocut (unavailable in the Free version) 
Pen & Ink (unavailable in the Free version) 
Pencil Sketch (unavailable in the Free version) 
Photocopy
Stencil (unavailable in the Free version) 
Torn Edges

Some effects are not available in the Free version of AliveColors, they can be used only with the Home/
Business licenses (compare). In the Free version, you can try these effects only with the watermark.
After  activating  with  a  Home/Business  license,  the  watermark  will  disappear,  all  filters  will  become
available. 
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COMICS

The Comics effect transforms a picture into a poster or a cartoon drawing. With this filter, you can easily
add creative cartoon effects to your image. 

Attention! The effect is not available in the Free version of AliveColors. 

Comics Effect

The parameters of the Image group affect the simplification of the picture and the reproduction of colors. 

Radius of Simplicity (0-20). Degree of posterization of the image. This parameter effects the size
of the area which is simplified. The higher the value, the more homogeneous areas become. 

Blur (0-100). Smoothness of an image by blurring similar colors in homogeneous areas. 

Posterizing (0-100).  Merging of  similarly  colored pixels.  This  parameter  affects  the number of
distinguishable colors during simplification. At higher values of this parameter, fewer colors are used,
and the image becomes more uniform and flat. 

Smoothing (0-10).  Smoothness  of  lines  dividing  posterized  colors:  the  higher  the  value,  the
smoother the lines are between these areas. At lower values the border between colors becomes
more "jagged". 

Enable the  Outlines check-box to add black boundary lines to the image. Adjust the settings for the
boundaries: 

Level of Detail (1-100). Level of detail and strokes that form the border. 

Sensitivity (0-100). Intensity of boundary lines. The higher the value, the more lines appear in the
image. Reduce the value to remove extra lines. 

Thickness (1-100). Thickness of the black boundary lines. At the minimum value, contours are one
pixel in width, while increasing the value makes lines thicker. 
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Definition (0-8).  It  changes size,  appearance, and position of  lines and method of  designating
contours. At higher values, more lines are used and the details of an image are more defined. 

Sharpen (0-100). Sharpness of lines. At higher values, lines have more clarity and more vividly and
accurately trace areas. At lower values lines become thicker and blurred. 

All changes are displayed in a small preview area. 

To process the entire image with the selected settings, press the Run button. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect parameters. 

Click Cancel to close the dialog box without applying changes. 

AliveColors Effects: Comics

161



HALFTONE PATTERN

The Halftone Pattern effect converts a photo into an image rendered as a two-color print. Widely used in
modern design, this technique works for creating retro-style images, comic books, and pop-art posters. 

Halftone Pattern

Effect Parameters: 

Pattern. Select a pattern option: dots, lines, circles. 

Dots Lines Circles

Color. Use the color squares to set the colors for the pattern. Double-click the square and select a color
from the standard dialog. 

The button  resets colors to default (black and white). When you press , the colors will be swapped. 
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Black And White Drawing Color Drawing

Size (1-12). The parameter sets the size of the pattern elements. 

Size = 5 Size = 10

Contrast (0-50). The parameter changes the contrast of the image. 

Contrast = 10 Contrast = 40

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 
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Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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LINOCUT

The  Linocut effect imitates the method of engraving on linoleum similar in technique to woodcut. This
printmaking technique is also known as lino print, lino printing or linoleum art. The drawing is applied to a
printing plate (a sheet of linoleum) from which you can print it on paper. In a classical engraving, the
image is created by black strokes on a white background. Linocut's characteristic expressiveness, strong
contrast between black and white, and its rich and exuberant strokes are made using a soft material. 

Attention! The effect is not available in the Free version of AliveColors. 

Linocut

Posterizing (10-100). Preliminary simplification of an image by combining pixels with similar colors.

Level of Detail (1-100). Amount of detail and lines in an image. Increasing the value gives more
detail and a darker image. 

Sharpen (1-100).  Distinctness  of  the  image  lines.  Increasing  the  value  makes  strokes  appear
clearer and more precise, without affecting the overall  level of detail.  Blurry images will  appear
darker. 

More White (0-50). Increases the background areas filled in white. 

More Black (0-100). Increases the "printed" areas filled in black. 

Paint Color and  Background Color. Use the color plates to set the paint (ink) and background
colors. The default colors are black and white. Click the plate and change a color. 

All changes are displayed in a small preview area. 

To process the entire image with the selected settings, press the Run button. 

Click Default to restore the original settings. 
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Click OK to apply the changes to the image and close the effect parameters. 

Click Cancel to close the dialog box without applying changes. 
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PEN & INK

The  Pen & Ink effect converts photographs into drawings using expressive contour lines and hatching
technique. The effect imitates colored ink drawings authentically reproducing the work of a pen. A feature
of pen drawing is the contour manner of execution and the changeable nature of the lines. 

Attention! The effect is not available in the Free version of AliveColors. 

Pen & Ink

Level of Detail (1-100). Level of detail and strokes that form the border. 

Sensitivity (0-100). Intensity of boundary lines. The higher the value, the more lines appear in the
image. Reduce the value to remove extra lines. 

Thickness (1-100). Thickness of the boundary lines. At the minimum value, contours are one pixel
in width, while increasing the value makes lines thicker. 

Definition (0-8). Visualization of lines: their  size, appearance, and position, as well  as contour
generation method. At higher values, more lines are used and the details of an image are more
defined. 

Sharpen (0-100). Sharpness of lines. At higher values, lines have more clarity and more vividly and
accurately trace areas. At lower values lines become thicker and blurred. 

Paint Color. Change the color of ink by clicking the color plate that opens the Select Color dialog. 

Background Color. Select the color of a paper by clicking the color plate. 

All changes are displayed in a small preview area. 
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To process the entire image with the selected settings, press the Run button. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect parameters. 

Click Cancel to close the dialog box without applying changes. 
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PENCIL SKETCH

The Pencil Sketch effect transforms photos into sketches, imitating the technique of real drawing. 

Attention! The effect is not available in the Free version of AliveColors. 

Pencil Sketch

Color Options: 

Monochrome. The drawing will be created using one pencil. You can choose the color of the pencil
strokes and background in the color squares. 
To change the color, click the square and select a color from the color selection dialog. 
Click  to reset colors to default (black and white). Click  to reverse the background and pencil

colors.

Bright Colors. The drawing is created with bright, saturated colors. In this mode, you can change
the background color. 

Natural Colors. The drawing is made using the original color range. The background is white and
can't be changed. 

Effect Parameters: 

Refined Lines. The check-box changes the appearance of the pencil strokes. When this option is
enabled, the ends of the lines become thinner, the drawing looks more refined and elegant. 

Extra Contrast. The check-box adds bright and clear lines to dark areas creating the ink effect. 
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Brightness (10-100).  The  parameter  changes  the  color  intensity  of  the  lines  (from  pale  to
saturated). 

Level of Detail (10-100). The parameter adjusts the amount of details and lines. 

Stroke Thickness (3-30). The parameter defines the width of the lines. 

Hatching Density (0-200). The parameter changes the number of the hatching strokes that allows
you to enhance the sense of volume. 

Sensitivity (0-80). The parameter affects the intensity of hatching. The higher the sensitivity level,
the more strokes are created on the image. 

Curvature (0-12).  The  parameter  changes  the  degree  of  curvature  of  the  strokes  under  the
influence of gradients. The higher the value, the more curve will be the hatching lines. At a value of
0, the strokes will be straight. 

Dispersion (1-100). The parameter randomly changes hatching. Increase its value to make the
strokes more weak, thin, and chaotic. 

Contour  Detail (0-1000).  The  parameter  sets  the  number  of  the  small  dark  lines  which
complement the contours of the drawing. 

Contour Brightness (1-100). The parameter changes the intensity of the contours. 

Additional Effects: 

Shadows (0-50). The parameter increases shadows on the image. 

Noise (0-100). The parameter adds graininess to the image. 

Contrast (-100..100). The parameter increases the difference between highlights and shadows. 

When  the  Autorun check-box  is  enabled,  any  change  in  the  parameters  automatically  starts  the
processing. When it is disabled, the processing is started by pressing the Run button. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect parameters. 

Click Cancel to close the dialog box without applying changes. 
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PHOTOCOPY

The Photocopy filter simulates the effect of photocopying an image as a two-color print. The areas in an
image will be filled with the background color, while the edges of the areas will be highlighted with paint
color.

Photocopy

Effect Parameters: 

Detail (1-24). Enlargement of details. Small details disappear. The filled areas become larger. 

Darkness (3-50). Increasing the parameter increases the brightness of the paint. 

Paint Color and Background Color. Use color plates to set the paint and background colors. The
default colors are black and white. To change a color, call the Select Color dialog by clicking in the
corresponding color plate. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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STENCIL

The Stencil effect converts a photo into an impressive drawing with contrasting outlines. 

Stenciling is a technique of creating a monochrome print (usually black and white). Using the effect in
AliveColors, you can not only make an authentic monochrome print, but also create a multi-color drawing.
A unique algorithm allows you to create high-contrast eye-catching images. 

Attention! The effect is not available in the Free version of AliveColors. 

Stencil Drawing

Parameters: 

Blur (1-25). Preliminary smoothing of the original image. It helps to simplify the image and remove
odd details. 

Smoothness (0-100). Smoothness of borders of areas in the image. 

Shadows/Highlights (0-100). Control of fill areas. The left slider is responsible for the number of
areas filled with the dark color (in the range from gray to black), the right one - for the number of
areas filled with the light color (in the range from white to gray). 

Paint/Background. Color management. The color of the paint is used for drawing outlines and
dark areas. The background color is responsible for the light areas. To change the color, click the
square and select a color from the standard dialog. 

Midtones. The slider adjusts a tint of the intermediate zone (by default, it's gray). 

Mixing. The check-box allows you to merge the result with the original image in the Multiply mode
without leaving the filter to create vivid color drawings. 

Contours. The effect adds outlines to the image. 
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Contours

Parameters of the Contours tab: 

Sensitivity (0-100). Number of the contour lines. 

Thickness (0-100). Intensity and width of the contour lines. 

Hatching. The effect adds hatching to the midtone areas. 

Hatching
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Parameters of the Hatching tab: 

Step (1-100). Distance between lines and their number. 

Thickness (1-100). Width of lines. 

Posterizing (5-100). Number of areas with different hatching. At a value of 100, the hatching is
uniform. 

Random Tilt (0-9999). A generator that creates a random hatching direction. 

Cross-hatching.  The check-box enables the cross-hatching mode.  Strokes are drawn across in
different directions. 

Pop Art. The effect fills the midtone areas with pattern elements. 

Pop Art

Parameters of the Pop Art tab: 

Pattern. The drop-down list contains a list of elements: Circle, Square, Rhombus, Triangle, Cross,
Dollar. 

Offset. The elements located one below the other are shifted by half the interval. 

Interval (2-100). Distance between the elements. 

Size (2-20). Size of the elements. The elements can blend in to create a denser shading effect. 

Note: You can use either Hatching or Pop Art, not both at the same time. 

All changes are displayed in a small preview area. 

To process the entire image with the selected settings, press the Run button. 
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Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect parameters. 

Click Cancel to close the dialog box without applying changes. 

AliveColors Effects: Stencil

175



TORN EDGES

The  Torn Edges effect transforms photos into two-color, high-contrast drawings with rough edges and
contours, creating a loose paper look. 

Torn Edges

Balance (1-50). The ratio of areas of different colors. The higher the value of the parameter, the
more areas are filled with the paint color. 

Smoothness (1-15). Increases the blurriness of edges. 

Contrast (1-25). Enhances image contrast. 

Paint Color/Background Color. Use color plates to set colors on an image. Click the color plate to
call the color selection dialog. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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BLUR EFFECTS

Using  the  Blur menu commands,  you can blur  the  entire  image or  just  a  selected  area,  reduce  its
sharpness, amount of noise, as well as create a variety of effects. 

The program offers the following blur types: 

Gaussian Blur
Motion Blur (unavailable in the Free version) 
Radial Blur (unavailable in the Free version) 
Smart Blur
Surface Blur
Lens Blur (unavailable in the Free version) 
Iris Blur (unavailable in the Free version) 
Tilt-Shift (unavailable in the Free version) 

Gaussian Blur. When this method is selected, the program recalculates the color components (red, blue,
and green) for every point of the image, taking into account the corresponding values of the neighbouring
points; as a result the points change their colors. The calculation is based on the Gaussian distribution and
is named after it. In this way the values of the color components are averaged and the contrast between
them weakens. The sharp borders are blurred without general lightening or darkening. The image gets
dim, "cloudy". 

The Radius (0.1-250.0) parameter adjusts the strength of the effect application. It defines to what
extent  a  point  influences  on  the  neighbouring  points  when  its  color  components  are  being
recalculated. At low values only the adjacent points will  be changed. Every point will  undergo a
slight change, but the blurring will be visible. The higher the value of the parameter, the wider is the
influence  area  of  every  point.  The  image  will  get  more  blurred  till  it  becomes  completely
indiscernible and looks like one stain (at high values of the parameter). 

Radius = 10 Radius = 50

Motion Blur. This blur method imitates the straight line motion of a camera. 

Parameters: 

Angle (0-180). This parameter sets the inclination angle of the line, along which the effect will
expand to the image. The values of the parameter vary between 0 and 180 degrees. At exactly
these values the blurring will be horizontal. At value = 90 the blurring will be vertical. 
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Distance (1-500). This parameter defines the effect application area in pixels (relative to every
point of the image). 

Motion Blur

Radial Blur. This method imitates motion, too. There are two kinds of motion: 

Zoom. This mode creates blurring directed away from the center. 
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Radial Zoom Blur

Spin. This mode imitates the effect of a camera rotating around the central point of the image,
which results in circular blurring. 

Radial Spin Blur
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The rotation angle in the  Spin mode and the effect application area in the  Zoom mode can be
adjusted using the following parameters: 

Highlights (1-100). The parameter specifies the amount of blur in light areas. The higher the
value, the deeper light blurred pixels penetrate the dark areas. 

Shadows (1-100). The parameter specifies the amount of blur in dark areas. The higher the
value, the deeper dark blurred pixels penetrate the light areas. 

Spin Blur in Light Areas Zoom Blur in Dark Areas

In the  Blur Center section, you can determine the position of the central blur point. To set the

position, click the image with the tool  or enter the center coordinates in the fields X and Y. 

Smart Blur. The effect allows you to precisely control the blur. 

Radius (1-20). The parameter defines how far the filter searches for dissimilar pixels to blur. 

Threshold (0.1-50.0). The parameter allows you to specify how much pixels should differ in order
not to get blurred. 
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Smart Blur

Surface Blur. The effect blurs monochrome image areas while preserving edges. 

Radius (0.1-20.0). The parameter specifies the size of the area sampled for the comparison of
pixels. 

Threshold (0.0-100.0). The parameter determines how much the neighboring pixels should diverge
from the center pixel in order to get blurred. Pixels with a difference of less than the threshold value
are excluded from the blur. 
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Surface Blur

Lens Blur. The effect blurs the image by simulating the narrower depth of field. In the blurred area you
can observe the bokeh effect. 
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Lens Blur

The Iris Blur effect allows you to accentuate a specific object in an image and blur the rest. The light
spots in the out-of-focus area can turn into bokeh. 

Iris Blur

Tilt-Shift adds the effect of a miniature, toy-like scene to your image. The light spots in the out-of-focus
area can turn into bokeh. 
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Tilt-Shift

Effect Parameters (equal for the last three effects): 

Select a mode of displaying the parameter changes: 

Fast Preview - this option lets you try the settings on a smaller copy of the original image. 

Full Processing - the image in its original size will be processed with the chosen parameters. 

The Blur (1-100) parameter lets you adjust the strength of the blur effect. The higher the value, the
greater the blur is. 

Blur = 5 Blur = 15

All light spots in the out-of-focus region take the form of bright glare. Use these parameters to
adjust the look of the spots of light in the blurred area: 
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Bokeh Shape Parameter Group. 

Shape. Click the square button in the Settings Panel and select a shape from a list. All light
spots in the out-of-focus area will change in the selected shape. 

Bokeh Shapes

Smoothness (-100..100). At the value = 0, the spots of light have the selected form. The
higher the value, the more the edges of the light spots are blurry and out of focus. When
decreasing the value, the center of the light spot is blurred and becomes more transparent. At
the lowest value, the only contours of the shape remain visible. 

Smoothness = -75 Smoothness = 75

Deformation (-100..100). When the parameter is set to 0, the light spots have a polygonal
shape. The higher the value, the more the edges of the polygon are curved outside, making it
gradually look like a circle. The less the value, the more the edges are retracted inside the
shape, turning the polygon into a star. 
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Deformation = -50 Deformation = 50

Rotation (0-360). The parameter defines the rotation angle of the polygon around its center. 

Rotation = 0 Rotation = 45

Note: Deformation and Rotation parameters are disabled for the circle shape. 

Glow Parameter Group. 

Brightness (0-100). As the parameter increases, the brightness of the light spots increases. 

AliveColors Effects: Blur Effects

186



Brightness = 25 Brightness = 75

Saturation (0-100).  The  parameter  increases  the  color  saturation  of  light  spots.  The
parameter is associated with the Brightness parameter. The higher the Brightness, the more
saturated colors you can get. 

Saturation = 25 Saturation = 75

Range (0-255). The parameter specifies the brightness range of light spots to which the first
2 parameters will be applied. 
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Range = 165/185 Range = 235/250

If the Fixed Preview Area check-box (not available for the last three blur effects) is enabled, all changes
will be displayed in a small preview area. If the check-box is disabled, the changes will be applied to the
area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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BRUSH STROKES

Using the commands of the  Brush Strokes menu, you can create simple artistic effects, add strokes,
grain, and texture to an image. 

You can apply these Brush Strokes effects: 

Accented Edges
Dark Strokes
Glowing Edges
Splatter
Spray

Accented Edges. The effect emphasizes edges in an image with darker or lighter strokes. Depending on
the settings, it simulates a line drawing or simply highlights the edges of a photo. 

Edge Width (1-14). Sets the thickness of the lines. 

Edge Brightness (0-50). Changes the color of the lines. The lower the value of the parameter, the
darker the strokes are; increasing the values makes them lighter. With a value = 25, the edges are
not outlined. 

Smoothness (1-15).  Increasing the parameter  reduces the amount of  detail  in  the image and
smooths out uneven edges. 

Accented Edges
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Dark Strokes. Dark areas will be filled with dense, dark strokes, and light areas will be filled with light
strokes. 

Balance (0-10). The ratio of dark and light strokes. The higher the value of the parameter, the more
dark strokes will be in the image. 

Black Intensity (0-10). Darkening of dark areas. 

White Intensity (0-10). Lightening of light areas. 

Dark Strokes

Glowing Edges. The effect defines edges in an image and adds a neon glow to them, filling the rest of
the areas with black. 

Edge Width (1-14). The thickness of the glowing lines. The minimal value corresponds to one pixel
lines; increasing the parameter thickens the lines. 

Edge Brightness (1-20). The clarity of the glowing lines. The higher the value, the brighter the
color of the edges is. 

Smoothness (1-15). Reduces the number of small details. 
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Glowing Edges

Splatter. The effect simulates splatters creating splashes and blots of paint.

Radius (0.0-50.0). Scattering range of spots. 

Smoothing (1-15). Reduces splashing by combining individual spots. 

Random Seed (0-100). Sets a different distribution of spots. 
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Splatter

Spray. The effect simulates paint spraying along the specified direction. 

Direction. Specifies the direction of strokes: horizontal or vertical. 

Radius (0.0-70.0). Scattering range of strokes. 

Stroke Length (0-20). Stretching strokes along the selected direction. 

Random Seed (0-100). Sets a different distribution of strokes. 
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Spray

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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CHANNEL MIXER

This effect processes the image (changing its color tones, saturation, contrast, lightness, etc.) using three
channels: Red, Green and Blue. 

Every channel is represented by a scale with a triangle control. 

The parameter can be adjusted in the following way: 

Shifting the triangle to the right/left leads to increase/reduction of  the corresponding color
component in every image point. 

Increasing Red Color Component in Every Image Point Reducing Red Color Component in Every Image Point

Enlarge/reduce. Left-click a triangle's corner and move the cursor to or from the center of the
triangle. By increasing or reducing the triangle size, you strengthen or weaken this color component.
The color is strengthened or weakened only in the points where it was, other points of the image
stay unchanged. 
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Increasing Blue Color in the Blue Channel Reducing Blue Color in the Blue Channel

Change the color of the triangle. For this purpose, left-click the white circle at the apex of the
triangle, and drag it  to another apex. For example, if  we change the triangle's color in the red
channel to blue, the red color components in every point of the channel will become blue. 

Source Image Replacing a Color in a Channel

Change the color of the triangle to two color sectors. For this purpose, left-click the white circle
at the apex of the triangle, and drag it to one of the triangle' sides. For example, if the triangle in
the green channel consists of blue and red sectors, the new value of the green color component will
be calculated as a sum of blue and red components. Other color components will not change. 

Source Image Replacing a Color in a Channel
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Change the color of the triangle  to three color sectors. For this purpose, left-click the white
circle at the apex of the triangle, and drag it towards the middle of the triangle. For example, if the
triangle in the blue channel consists of three color sections, the new value of the blue component for
every point of the image will  be calculated as a sum of these three color sections. Other color
components on the image (in this case, red and green) will not change. 

Source Image Replacing a Color in a Channel

Attention! The triangle control does not show the result. It only shows the way the points in this
channel will be calculated. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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COMBINE IMAGES

The Combine Images menu contains effects that allow you to merge images into a composition. 

You need a top active layer with a fragment you want to embed and underlying layers with a background. 

Attention! These effects are not available in the Free version of AliveColors. 

The  Chameleon effect  completely  adapts  the  fragment  to  the  background  image:  the  edges  are
smoothed and the color of the entire fragment changes, adjusting to the colors of the background image
surrounding it. 

Chameleon Effect

The Chameleon effect does not have options and applies automatically immediately after the filter call. 

The Emersion effect merges two images so that the object is "embedded" in the background in separate
areas, thanks to which in some cases it is possible to achieve a combination of objects with complex
shape. 
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Emersion Effect

Emersion Effect Controls: 

Colors. A set of colors used for image conversion. During processing, a mask will be created from
pixels of the background image that have colors that match the colors from the set and are close to
them and will be applied to the layer with the embedded fragment. 

By default, all color fields are empty and contain no colors. 

Click one of the fields, the cursor takes the form of an eyedropper, and take a color from the image. 

Change the color by clicking the field again and selecting another color from the image. 

You can remove a color from the set and clear the color field by right-clicking on it. 

Threshold (0-100). This option expands the range of colors added to the set. As you increase the
parameter, the mask will include not only points with equal colors from the set, but also points with
similar colors. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect parameters. 

Click Cancel to close the dialog box without applying changes. 
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DISTORTION

The Distortion effects are used to distort, transform or convolute an active layer or selection. The filters
allow warping, twisting, and pulling layers in different directions. 

You can apply these Distortion effects: 

Displace
Extrude
Pinch
Polar Coordinates
Ripple
Twirl
Wave

Displace. The effect shifts the current layer based on the image selected as a displacement map. The
resulting image is covered with a pattern which depends on the form of the map. 

Map. Double-click the square to select an image to be used as a displacement map. 

The Original Size, Fit, and Tile check-boxes determine the size of the displacement map. 

If the Original Size check-box is enabled, the original size map will be used. If the map is smaller
than the size of the processed image, it will be repeated to fill the entire image. If the map is bigger,
only a part of it appears. 

If the Fit check-box is enabled, the image used as a displacement map will be stretched to the size
of the processed image. As a result, the displacement map ratio can be changed. 

If the Tile check-box is enabled, the image is filled with a map repeated in a grid. In the X and Y
fields, specify how many times the map repeats itself horizontally and vertically. 

You can shift the color channels by moving color markers and adjusting auxiliary parameters. The
Strength parameter (0-500) defines the amount of displacement. The Direction parameter (0-360)
specifies the direction in which the image should move. 

Source Image Displacement Map
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Result

Extrude. The effect gives the picture a three-dimensional structure. The image is composed of the square
blocks protruding from its center. 

Size (1-100). The parameter specifies size of the foundation of each block. 

Height (0-500). The parameter determines the height of the blocks. 

Dispersion (0-500). The parameter influences the variation in the height of the blocks. At the value
= 0, all the blocks have the same height. When increasing the parameter, the difference between
the heights of individual blocks becomes more evident. 

Density (0-100). The parameter increases the number of blocks in the image. 

Anti-Aliasing check-box. The parameter reduces the irregularities at the blocks boundaries. 
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Extrude Effect

Pinch. The effect stretches or shrinks the image. There are two types of compression: 

Spherical. At negative values of the Strength parameter, the image is shrinked toward its center.
At positive values, it stretches from the center. 

Spherical Shrinking Spherical Stretching

Linear.  The  image  is  stretched  or  shrinked  separately  in  horizontal  and  vertical  direction.  At
negative values, the image is shrinked. At positive values, the image is stretched. 
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Horizontal Shrinking Vertical Stretching

Polar Coordinates. The effect distorts the image by converting the rectangular coordinates of each point
to polar ones (and vice versa). 

Shift Х (1.0-100.0). It allows you to shift the center of the effect horizontally. 

Shift Y (1.0-100.0). It allows you to shift the center of the effect vertically. 

Scale (1.0-100.0). It controls the effect scaling. 

Transform. Select the conversion option: from polar coordinates to rectangular or from rectangular
to polar ones. 

Overlap (0.0-100.0). It hides the seam line. 

Flip. It swaps top and bottom. 
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Polar Coordinates Effect

Ripple. The effect distorts the image by adding the perturbations in the form of small waves. 

Wave Height (1-50). The parameter determines the height of the waves. 

Wave Length (1-100). The parameter specifies the distance between the crests of waves. The
higher the value, the larger the distance. 

Reflection (0-50). When increasing the parameter, the wave is reflected about a certain axis. The
higher the value, the more reflected waves appear in the image. 

Small Waves (0-100). The parameter breaks large waves into smaller ones. The higher the value,
the more often they are repeated. The parameter works only if the Reflection parameter is non-
zero. 
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Large Waves Small Waves

Twirl. The effect twists the edges of the image around its center. 

The effect is influenced by the  Rotation parameter (-1000..1000) determining the direction and
intensity  of  the  twist.  Positive  values  indicate  clockwise  rotation;  negative  values  indicate
anticlockwise rotation. 

Weak Rotation Intensive Rotation

Wave. The effect adds distortions in the form of waves, creating undulating pattern. 
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Wave Effect

Number of Generators (1-999). Number of wave formation centers. 

Min/Max Wave Height (1-999). The range within which the distance between the top and bottom
points of the wave varies. 

Min/Max Wave Length (1-999). The range over which the distance between wave crests varies. 

Horizontal Scale (1-100). Changing the scale of waves horizontally. 

Vertical Scale (1-100). Changing the scale of waves vertically. 

Wave Type. In the drop-down list, select the wave form: Square, Triangle or Sine. 

Edge Type. In the drop-down list, select the method for filling empty areas on the image edges: 

Repeat - filling with repeating edge pixels, 
Wrap Around - filling with fragments that are outside the image, 
Mirror - filling with mirrored fragments. 

Random Seed (0-100). The parameter randomly changes the position of the waves. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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DROP SHADOW

The Drop Shadow effect adds a perspective shadow to the selected area. 

Attention! The effect is not available in the Free version of AliveColors. 

Drop Shadow

Effect Parameters: 

Opacity (0-100). The parameter determines the transparency of the effect. 

Opacity = 30 Opacity = 80
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Color. Call the Select Color dialog by clicking on the color plate. 

Navy-Blue Shadow Dark Red Shadow

Fading (0-100). The parameter determines at what distance from the object the shadow become
transparent. 

Fading = 30 Fading = 90

Angle (0-360).  The  parameter  specifies  the  position  of  the  light  source.  Depending  on  the
parameter value, the position of the shadow changes. 
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Angle = 110 Angle = 160

Altitude (0-90). The parameter regulates the height of the light source. The higher the value, the
longer the shadow. 

Altitude = 20 Altitude = 50

Blur (0-100). The parameter determines the blurriness of the effect. The higher the value, the more
blurred the boundary of the shadow. 
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Blur = 10 Blur = 50

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 

AliveColors Effects: Drop Shadow

209



GLAMOUR EFFECT

The Glamour effect is designed for processing portrait photos. It allows you to brighten and even the skin
tone, get rid of wrinkles, conceal minor flaws, etc. 

Glamour Effect

The effect has the following controls: 

Colors. This field includes a set of colors that will be used for processing an image. 

Color Set

This set has 6 color squares. By default these color squares are empty. If you start image processing
with default settings, there will be no changes. 

Click within an empty square, the pointer will be transformed into an eyedropper, and pick a color
from the image with a left-click. This square will display the chosen color. 

To change the color of the square, left-click it and choose a color from your image. 

To delete a color and clear the square, right-click the square. The square will return to the default
state. 
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The Threshold parameter defines colors that will be used for processing. At minimum value of the
parameter only the colors from the color set are involved into the process. If you increase the value
of the parameter the colors similar to the colors of the set will change, too. The higher the value of
the parameter, the more colors will be changed. 

The  Smoothness parameter softens and blurs the image by reducing the color contrast between
the neighbouring pixels. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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GLITCH ART

The  Glitch Art effect brings digital noise and distortions giving the impression of an allegedly spoiled
image.  In  reality,  such  interferences  appear  due  to  errors  in  the  reproduction  of  digital  recordings,
technical failures, or physical damage of a device. Now this effect is achieved intentionally. This visual
technique is used to increase the aesthetic value of the pictures and provides an added impact on a
viewer. 

Attention! The effect is not available in the Free version of AliveColors. 

Glitch Art

The effect parameters are presented in two tabs: Interferences and Stripes and Shifts. 

Interferences tab 

Channel Shift.  The parameters of this group separate and shift  the color components of the image,
forming additional color outlines (the so-called 3D anaglyph effect). 

Red. Shift of the red channel. 

Green. Shift of the green channel. 

Blue. Shift of the blue channel. 
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Red Channel Green Channel Blue Channel

Scan Lines. Raster lines that simulate an old TV noise effect. 

Blend Mode:  Overlay or  Soft Light. The mode affects the degree of contrast between the lines
and the image. 

Overlay Soft Light

Thickness. Thickness of the scan lines. 
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Thickness = 5 Thickness = 20

Sharpness. Sharpness of the edges of the lines. 

Sharpness = 0 Sharpness = 50

Intensity. The degree of visibility of the lines. At 0, there is no scan line effect. 

Intensity = 25 Intensity = 75
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Noise. Adding digital noise and film grain to the image. 

Strength. The degree of visibility of noise. 

Strength = 0 Strength = 100

Stripes and Shifts Tab 

Size and Position. A group of the parameters responsible for the geometry of the stripes. 

Min/Max Height. Range of change of the height of the stripes. 

Min/Max Height = 1/10 Min/Max Height = 50/100

Min/Max Length. Range of change of the length of the stripes. 
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Min/Max Length = 20/30 Min/Max Length = 190/200

Displacement. Shift amount (for simple and inverted stripes). 

Displacement = 0 Displacement = 15

Simple Shifts. The number of stripes created by displaced rectangles. 

Simple Shifts = 60 Simple Shifts = 90

Simple Stretches. The number of stripes formed by stretching of rectangles. 
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Simple Stretches = 60 Simple Stretches = 90

Min/Max Stretch. Range of change of the length of the stretches. 

Min/Max Stretch = 12/12 Min/Max Stretch = 14/15

Inverted Shifts. The number of stripes with color inversion. 

Inverted Shifts = 40 Inverted Shifts = 60

The Vertical check-box enables vertical effects instead of horizontal ones. 
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Vertical Check-Box Is Disabled Vertical Check-Box Is Disabled

The Random Seed button generates a different distribution of stripes in the image. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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HIGH PASS

The  High Pass effect reveals details along the edges, improving the contrast and making the image
sharper. The other parts of the image become flat gray (areas without the edge contrast effect). 

One of the widespread techniques is applying various blending modes to the layer processed with High
Pass. The most commonly used are the contrast improvement modes: Overlay, Soft Light, Hard Light,
Vivid Light, Linear Light. This method is useful for photo enhancement. 

Attention! The effect is not available in the Free version of AliveColors. 

High Pass Effect
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Radius (0.1-250.0). The parameter defines the area along the edges where the original details will
be kept. 

Radius = 1 Radius = 10

Grayscale. If the check-box is enabled, the layer will be desaturated. It helps to reduce color noise
and halo along the edges. 

Check-Box Disabled Check-Box Enabled
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If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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LENS CORRECTION

The  Lens Correction filter  allows you to correct  optical  distortions and adjust  the perspective of  an
image. 

Distortion (-100..100). The parameter straightens lines that are concave or convex relative to the
center of the image. 

Lens Correction

Vertical Perspective (-100..100). It's a perspective correction that makes slanted vertical lines
appear parallel. 

Horizontal Perspective (-100..100). It's a perspective correction that makes slanted horizontal
lines appear parallel. 
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Perspective Correction

Vertical Shift (-100..100). The parameter allows you to move the image up or down. 

Horizontal Shift (-100..100). The parameter allows you to move the image left or right. 

Scale (50-150). The parameter changes the image scale; it's used to hide transparent areas at the
edges of the adjusted image. 

Angle (-180..180). Sets the image rotation angle and can be used to correct a tilted horizon. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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NOISE EFFECTS

The Noise menu allows to add or remove graininess in your image. 

It contains the effects: 

Add Noise
Dust & Scratches
Median

To remove digital noise, you can also use the AI-powered Noise Removal filter and the Noise Buster
built-in plugin. 

Add Noise. The filter adds noise to an image. 

In the Distribution section, choose a type of noise distribution: Uniform, Impulse, or Gaussian. 

Uniform Noise Distribution Gaussian Noise Distribution Impulse Noise Distribution

Color Noise check-box. If the check-box is enabled, the color noise will be added to an image. If
the check-box is disabled, only the b&w noise will be added. 

Monochromatic Noise Color Noise

Amount (0-100). The parameter adjusts the overall amount of noise in an image. 

AliveColors Effects: Noise Effects

224



Amount = 10 Amount = 50

Dust & Scratches. The filter reduces noise by blurring dissimilar pixels within the specified radius. 

Radius (1-100). The parameter determines the size of the area, within which the dissimilar pixels
will be blurred. 

Threshold (0-100). The parameter determines how much the pixels must differ in order to get
blurred. 

Effect Applied

Note: Apply this filter to a small selected area containing defects, as it can reduce not only noise
but also image detail. 
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Median. The filter reduces noise in an image by averaging the color values of similar pixels within a
predetermined radius. 

Radius (1-100). The parameter sets the radius of the area within which the colors of individual
pixels will be compared and averaged. 

Original Image Effect Applied

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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PAGE CURL

The Page Curl effect creates a page curl on an image. The color of the curl, its form and the torsion level
are adjusted in the Settings Panel. 

The Settings Panel offers the following parameters for this effect. 

Curl Color. The color plate allows you to set the color of the curl’s underside. Double-click the color
plate to choose a color from the Select Color dialog box. 

Orange Curl Green Curl

Background Color. You can change the color of the area under the curl. Double-click the color
plate to choose a color from the Select Color dialog box. 
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Black Background White Background

Transparency. When the check-box  Transparency is enabled, the area under the curl becomes
transparent. One may need it on an image with several layers; in this way, for example, another
photo can be visible under the page curl. 

Transparency Check-Box Is Enabled

Torsion (0-100). This parameter sets the level of torsion of the curl. The higher the value, the more
twisted the curl is. 
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Torsion = 25 Torsion = 75

Obliquity (0-100). This parameter sets the form of the curl. At values from 1 to 49 the corner of
the image curls to form a cone (the vertex is on one end); at 50 the corner curls to form a cylinder;
and at values from 51 to 100 it forms a cone again, but the vertex is on the opposite end. 

Obliquity = 10 Obliquity = 60

Line with markers on both ends defines the corner to be curled, the position of the curl line and
the curling direction. Use the markers to set the position of the line. To move a marker, bring the
cursor on it, press the left mouse button and drag the marker to a new position. It is impossible to
curl more than half of the image. 
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Vertical Horizontal

Gradient (0-100). This parameter adds volume to the curl by adjusting the contrast of mid-tones. 

Gradient = 25 Gradient = 75

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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PIXELATE

The Pixelate effects (Crystalize and Mosaic) merge neighboring pixels of the image into monochrome
cells. Let us consider each of them in detail: 

Crystalize.  The effect  groups neighboring pixels  into various polygons.  The color  of  each polygon is
obtained by averaging the colors of grouped pixels. 

Size (5-300). This parameter determines the size of polygons. The higher the value, the larger the
polygons. 

Small Polygons Large Polygons

Mosaic. The effect groups neighboring pixels into square blocks. The color of each block is obtained by
averaging the colors of grouped pixels. 

Size (2-300). The parameter sets the lateral length of the square blocks in the original pixels. 
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Small Blocks Large Blocks

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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SHADOW & HIGHLIGHT

The Shadow & Highlight effect allows to reveal details in bright and dark areas of an image and reduce
contrast. 

Shadow & Highlight Effect

The effect panel contains two parameters sections. 

The Shadows section lightens the dark areas of the image. 

Amount (0-100). The parameter determines the intensity of lightening of dark areas. 

Amount = 25 Amount = 75
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Range (0-100). The parameter determines the range of tones that are modified. Smaller values
restrict  the  adjustments  to  the  darker  areas.  Larger  values  increase  the  range  of  tones  to  be
adjusted. 

Range = 10 Range = 100

Radius (0-100). The parameter sets the width of the area around the pixel  used to determine
whether it is in the shadow or highlight. 

Radius = 10 Radius = 50

The Highlights sections allows to darken light areas. 

Amount (0-100). The parameter controls the amount of darkening of light areas. 
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Amount = 25 Amount = 75

Range (0-100). The parameter determines the range of tones that are modified. Smaller values
restrict  the  adjustments  to  the  highlights.  Larger  values  increase  the  range  of  tones  that  are
adjusted. 

Range = 10 Range = 100

Radius (0-100). The parameter sets the width of the area around the pixel  used to determine
whether it is in the shadow or highlight. 
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Radius = 10 Radius = 50

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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SHARPEN EFFECTS

Using the Sharpen menu, you can increase the sharpness and enhance the image detail. It includes the
effects: Sharpen and Unsharp Mask. 

The Sharpen improves the sharpness of the image by increasing the contrast of individual pixels. 

Amount (0.0-30.0).  The  parameter  determines  the  amount  of  contrast  enhancement.  When
increasing the parameter, light pixels become lighter, while the dark ones become darker. 

Sharpen Effect

The  Unsharp Mask effect increases the contrast of the edges in the image while leaving other areas
untouched. The program compares the resulting image with its blurred copy and if the pixel of the image
contrasts with the corresponding pixel of the blurred copy, the contrast is increased; otherwise, the pixel
stays unchanged. The program processes all image pixels in this way. 

Radius (0.1-250.0). The parameter indicates the number of pixels around the pixel to be corrected
(that is the sharpen contour size). 

Contrast (1-500). The parameter controls the amount of sharpening. 

Threshold (0-255). This parameter determines the size of the areas to be sharpened. At smaller
values, the Contrast parameter affects even the individual pixels. At higher values, the parameter
affects only the sharpness of distinguished boundaries. 
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Unsharp Mask Effect

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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TEXTURE FILL

The Texture Fill effect allows you to fill a layer or selection with a selected pattern. 

Texture Fill

Fill Parameters: 

Method. Select the texture overlay method from the drop-down list: 

Repetition 
Reflection 
Random 
Alignment 

Blend Mode. Choose the method of blending texture with the processed layer. The program provides 27
blending modes. You can learn more about them here. 

Opacity (1-100). Texture transparency in relation to background colors. The lower the value, the paler
the fill colors and the stronger the interaction with the background colors. 

Scale (10-400). Texture pattern size.

Horizontal Shift (0-100). Horizontal fill offset. 

Vertical Shift (0-100). Vertical fill offset. 

Angle (-180..180). Texture rotation angle.

Texture Library contains all available textures. 
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Texture Library

Below the texture list, there are the following elements (for custom textures): 

Add Texture . Load a image to be used as a texture. 

Delete Texture . Remove the selected user texture from the library. 

Texture Name. Click the field to make it editable, enter a new texture name, and press Enter  to
apply it. 

Import Library . Load a texture library from the disk (a .brush_textures file). 

Export Library . Save a texture library into a .brush_textures file. 

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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TWO KEYS

The Two Keys effect allows you to transform an image (change color tints, replace colors, adjust contrast
and brightness etc.) using two key colors. 

Two Keys Effect

The effect has the following controls that are represented by two color boxes: 

Original Key Colors

In the Black Point color plate choose a color that will be used as a black key. In the White Point color
plate choose a color that will be used as a white key. By default the corresponding colors are chosen, and
your image is in its original state. 

How to define the other key colors: 

- Click the color plate (the pointer will transform into an eyedropper), choose the necessary color on
the image and left-click it. The color box will change its color to the selected one. 

- Double-click the color plate to open the Select Color dialog. 
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New Key Colors

Note: The color of the black point cannot be lighter than the color of the white point and vice versa.

As a result, all colors that are darker than the black key will shift to the black color; all colors that are
lighter than the white key will shift to the white color. 

You can also set only one key color (black key or white key). If you define only the black key, the dark
colors will shift to the black color, while the light colors will not change. 

Please note, that the lighter the black key color is, the darker the image will be; the darker the white key
color is, the lighter your image will be. 

Note: If you don't want to change the color shades on your image, use the color grey as the key
color (in this case the color components (green, red and blue) are equal). 

Two Keys Effect

If the Fixed Preview Area check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the area visible in the Image Window. 

Click Default to restore the original settings. 

Click OK to apply the changes to the image and close the effect dialog box. 

Click Cancel to close the dialog box without applying changes. 
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BUILT-IN PLUGINS

Some popular AKVIS plugins are available in AliveColors image editor (Effects -> Built-in Plugins).
These filters expand the already impressive capabilities of AliveColors even further. 

The built-in plugins are not available in the  Free version of AliveColors. Only for  Home and  Business
licenses! 
In the free version, you can try these effects only with the watermark. After activating with a  Home/
Business license, the watermark will disappear, all plugins will become available. 

You can also add the AKVIS plugins or third-party tools as  external plugins to the image editor. This
method is available even in the Free version of AliveColors. 

AliveColors Effects: Built-in Plugins
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EXTERNAL PLUGINS

AliveColors is a powerful tool for editing and correcting photos. 

You can extend the editor's functionality by adding external third-party plugins (except the Linux version).

Proceed as follows to add the plugins to AliveColors on Windows and Mac: 

Open the  Preferences dialog box by clicking   in  the upper  right  corner  of  the AliveColors

window or using the File -> Preferences... command. 
Go to the Filters & Plugins tab. In the Plugins Directory field, browse the folder with the plugins
(the  .8bf file on Windows, the plugin file on Mac). To add a new folder, click   and select the

desired directory. 

Actually, you can use any folder which contains the plugin files: 

A folder created specifically for this purpose: for example, "My Plugins". Copy all the plugin
files into this folder to make them appear in the effects list.
A native plugin folder. For example, on Windows, AKVIS plugins are installed into C:\Program
Files\AKVIS.
A plugins folder of another graphics editor. You may need this option if you're using several
graphic editors on the same machine. 
For example, to add the Photoshop CC plug-ins to AliveColors choose the folder: 

Windows: C:\Program Files\Common Files\Adobe\Plug-Ins\CC; 
Mac: Macintosh HD/Library/Application Support/Adobe/Plug-Ins/CC. 

You can choose several folders, all of them will be active. All selected paths are visible in the drop-
down list. To remove the folder, select it in the list and click . 

Click OK to apply changes. 

Restart AliveColors and call the plug-in from the menu Effects. 

List of compatible AKVIS plugins for Windows and Mac (some features are available in AliveColors): 

AKVIS  AirBrush —  Airbrushing  Techniques  on  Your  Photos  (the  built-in  AirBrush plugin  is
available). 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration (also available as the AI-
powered filter in AliveColors: AI -> JPEG Artifact Remover). 

AKVIS ArtSuite — Frames and Effects for Your Photos. 

AKVIS ArtWork — Collection of Painting & Drawing Techniques. 

AKVIS Chameleon — Photo Collage Creation. 

AKVIS Charcoal — Charcoal & Chalk Drawings. 

AKVIS Coloriage AI — Add Color to Black and White Photos. 

AKVIS Decorator — Resurface and Recolor. 

AKVIS Draw — Hand-made Pencil Drawing Effect. 

AKVIS Enhancer — Bring Detail To Your Pictures (the built-in Enhancer plugin is available). 

• 

• 

◦ 

◦ 

◦ 

• 
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AKVIS Explosion — Fabulous Particle Explosion Effects. 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality! (the built-in HDRFactory
plugin is available). 

AKVIS Inspire AI — Artistic Stylization of Images 

AKVIS LightShop — Light and Star Effects (the built-in LightShop plugin is available). 

AKVIS MakeUp — Retouch Your Portrait Photos! (the built-in MakeUp plugin is available). 

AKVIS NatureArt — Bring Nature to Your Photos (the built-in NatureArt plugin is available). 

AKVIS Neon — Glowing Drawings from Photos (the built-in Neon plugin is available). 

AKVIS Noise Buster AI — Digital Noise Reduction (the traditional algorithm is accessible in the
built-in Noise Buster plugin; the AI-based filter is available in AI -> Noise Removal). 

AKVIS OilPaint — Oil Painting Effect. 

AKVIS Pastel — Turn Photos into Pastel Paintings. 

AKVIS Points — Apply Pointillism Effect to Your Photos (the built-in Points plugin is available). 

AKVIS Refocus AI — Focus Improvement & Blur Effects (one of the options is available in AI ->
Motion Deblur). 

AKVIS Retoucher — Image Restoration Software. 

AKVIS Sketch — Turn Your Photos into Pencil Sketches. 

AKVIS SmartMask AI — Save Time on Complex Selections!  (the built-in  SmartMask plugin is
available). 

AKVIS Watercolor — Aquarelle Art from Photos. 

List of other compatible third-party plugins: 

Corel ParticleShop plugins (for Windows and Mac) 

Auto FX Software plugins (for Windows and Mac) 

Topaz Labs plugins (for Windows only) 

Nik Collection plugins (for Windows only) 

Exposure  Software (ex  Alien  Skin  Software)  plugins:  Exposure,  Snap  Art,  Eye  Candy  (for
Windows only) 

Imagenomic plugins (for Windows only) 

To get the information about the version and license status of any plugin, select in the menu: Help ->
About Plugins. 
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BUILT-IN PLUGINS

In the Effects -> Built-in Plugins menu, some popular AKVIS plugins are available, which significantly
expand the capabilities of the AliveColors image editor. 

The built-in plugins are not available in the Free version of AliveColors! In the free version, you can try
these effects only with the watermark. After activating with a Home/Business license, the watermark will
disappear, all plugins will become available. 

In the trial period, all features are fully available to test. 

For the Home and Business licenses, the following built-in plugins are available: 

AirBrush (airbrush painting effect in Monochrome and Original Colors modes) 

Enhancer (Improve Detail, Tone Correction, and Prepress Processing modes) 

HDRFactory (Creating HDR Images, Ghost Removal, Local Correction) 

LightShop (light effects, Sparkle Brush) 

MakeUp (skin retouching with a tone mask, portrait retouching tools) 

NatureArt (Rain, Water, Clouds, Rainbow, Lightning, Frost, and Aurora effects) 

Neon (glow lines drawing effects) 

Noise Buster (traditional noise reduction algorithm) 
The AI-based filter is available in the menu: AI -> Noise Removal. 

Points (pointillism painting effect) 

SmartMask (Magic Brush, Chroma Key, Refine Edges) 

You can also install AKVIS plugins and third-party plugins as external modules. This method is available
even in the Free version of AliveColors. 
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AIRBRUSH BUILT-IN PLUGIN: AIRBRUSH DRAWING EFFECT

The built-in  AirBrush plug-in allows you to imitate the technique of spray paint and transform a photo
into an airbrush painting. 

Attention! The effect is not available in the free version of AliveColors. 

Airbrushing is a painting technique that involves spraying a mist of dye, ink or paint through an air-
operated tool. They are typically associated with automotive and graffiti art; however, airbrushes are often
used in fine art. Spray paintings are characterized by exceptional smoothness and high detail. 

The airbrush effect is fully adjustable with the parameters. 

In the built-in AirBrush plugin, two color modes are available: 

Original Colors. Creating a photorealistic image using the original colors. 

Original Colors

Monochrome. Creating a monochrome drawing composed of one color and its shades. 

AliveColors Built-in Plugins: AirBrush Built-in Plugin: Airbrush Drawing Effect
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Monochrome

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS AirBrush software (available as a plugin and as a standalone program) to get more options
for converting a photo into an airbrush drawing. The original software offers 3 modes: Original Colors, 
Monochrome, and Multicolor. 
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ENHANCER: IMPROVE DETAIL, TONE CORRECTION, PREPRESS PROCESSING

The built-in Enhancer plugin is designed to improve the detail of a photograph, correct the dark areas,
increase the sharpness of the borders and contrast of images, etc. In AliveColors, the plugin is available as
three  effects  in  the  Enhancer group  (three  image  enhancement  modes):  Improve  Detail,  Tone
Correction, and Prepress Processing. 

Attention! The effects are not available in the free version of AliveColors. 

The following effects are available in the Enhancer menu: 

Improve Detail. It allows you to enhance details in light and dark areas of an image. Learn more
about the effects settings here. 

Improve Detail

Tone Correction. It improves an image through correction of certain color areas. Learn more about
the effects settings here. 
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Tone Correction

Prepress Processing. It allows you to increase the sharpness of borders and the contrast of the entire
image before printing or publishing. Learn more about the effects settings here. 
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Prepress Mode

The Enhancer effects are equipped with a set of Presets that allow you to make instant changes to your
image with one click of a button. Presets can be used as-is or modified as needed. 

You can also try the AKVIS Enhancer software (available as a plugin and as a standalone program). 
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HDRFACTORY: CREATING HDR IMAGES

The built-in HDRFactory plugin is designed to create images with high dynamic range. 

Attention! The effect is not available in the free version of AliveColors. 

HDRFactory allows you to get an HDR image by merging several photos taken with different exposures
into a composite image. Alternatively, you can apply the HDR effect to a single photo. 

HDR feature allows overcoming the dynamic range limitations of current camera technology and makes
the scene much more vivid and closer to what our eye can see. 

The following features are available in the built-in HDRFactory plugin: 

Creating HDR Images. The mode allows producing an image with a high dynamic range. Find
more information about the effect options at the pages:  Creating HDR Images,  Adjustment, and
Effects. 

HDR Image

Local  Correction.  The  mode  allows  performing  additional  processing  of  individual  areas  of  an
image. Learn more about the Local Correction parameters here. 
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Local Correction

Ghost  Removal.  The  mode  allows  removing  so-called  ghosts.  These  semi-transparent  defects
sometimes appear when creating an HDR image. Find more information about this feature here. 
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Ghost Removal

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the  AKVIS HDRFactory software (available as a plugin and as a standalone program) to get more
options for creating HDR images and tone correction. 
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LIGHTSHOP: LIGHT & STAR EFFECTS

The built-in LightShop plugin allows adding light effects to an image. 

Attention! The effect is not available in the free version of AliveColors. 

LightShop includes various glow elements for  creating light effects.  You can move and change each
element of the effect as well as the entire effect, adjust the blending mode and the effect area. 

The following features are available in the built-in LightShop plugin: 

Adding Light Effects. Creating complex light effects consisting of several simple elements. Learn
more about how to create light effects. 

Light Effect

Sparkle Brush . The tool scatters small glowing elements - stars, hearts, flowers, etc.  Learn

more about the brush. 
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Sparkle Brush

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS LightShop software (available as a plugin and as a standalone program) to get more options
for creating light and star effects. 
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MAKEUP: PORTRAIT RETOUCHING

The built-in MakeUp plugin allows retouching and enhancing portrait photos. 

Attention! The effect is not available in the free version of AliveColors. 

MakeUp automatically eliminates minor defects and smooths the skin, making it look radiant and even-
toned.  The  unique  retouching  algorithm  grants  professional  results  without  making  the  face  look
unnaturally smooth. 

The  plugin  improves  and  rejuvenates  the  skin,  without  affecting  other  areas  of  a  photo  (eyes,  hair,
background). 

Portrait Retouching

The following features are available in the built-in MakeUp plugin: 

Skin Smoothing. The plugin automatically recognizes the face and creates a mask on which the

skin retouching will be applied. You can edit the selection with these mask editing tools: , ,

.

Adjust the smoothing effect with the MakeUp parameters. 
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Mask

Retouching Tools , , , , . The tools allow to manually remove minor defects. Use

them to make final touches and correct the result of skin smoothing. Learn more about the tools. 
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Retouching Tools

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS MakeUp software (available as a plugin and as a standalone program) to get more portrait
retouching features. 
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NATUREART: NATURE EFFECTS

The built-in NatureArt plugin offers a collection of unique effects that imitate natural phenomena. 

Attention! The effect is not available in the free version of AliveColors. 

NatureArt allows  you  to  add  the  following  effects  to  a  photo:  Rain,  Clouds,  Rainbow,  Water, 
Lightning, Frost, and Aurora. 

Rain. It allows you to add precipitation to an image: from various types of rain (from drizzle to
rainfall) up to snow (with certain parameter settings). Learn more about the effect parameters here.

Rain Effect

Water. Using this effect, you can add a water body to a photo. It is also possible to adjust the glare
settings to bring the image as close as possible to the given environmental conditions. Learn more
about the effect parameters here. 
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Water Effect

Clouds. The effect allows you to add clouds, fog or smoke to an image. Learn more about the effect
parameters here. 
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Fog Using Clouds Effect

Rainbow.  Using the effect,  you can add a  rainbow to  an image.  Learn more about  the effect
parameters here. 
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Rainbow Effect

Lightning. The effect allows you to add lightning of any size and number to an image. Learn more
about the effect parameters here. 
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Lightning Effect

Frost. This effect allows you to adorn an image with an openwork of frost crystals. Learn more
about the effect parameters here. 
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Frost Effect

Aurora. The effect allows you to embellish the night sky with a unique natural phenomenon - the
northern lights. Learn more about the effect parameters here. 
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Aurora Effect

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS NatureArt software (available as a plugin and as a standalone program) to get more nature
effects (including Sun, Fire, Ice, Night Sky, and Snow). 
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NEON: GLOWING LINES EFFECTS

The built-in Neon plugin is designed to apply neon effects to an image. It turns digital photos into bright
and vivid drawings, made with luminous lines. 

Attention! The effect is not available in the free version of AliveColors. 

The following features are available in the built-in Neon plugin: 

Glowing Lines Effect. Converting a photo into a drawing made with luminous lines. 

Adjust the parameters of the neon effect. 

Neon Drawing

Additional Effects: 

Colorizing. This option lets you add a color tint to an image. 
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Colorizing with Blue

Deformation. The effect lets adding some distortions to an object. 
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Deformation Effect

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS Neon software (available as a plugin and as a standalone program) to get more neon effect
features (including Boost parameters, Hatching effect, Color adjustment, and Decoration options). 
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NOISE BUSTER: DIGITAL NOISE REMOVAL

The built-in Noise Buster plugin allows reducing digital noise in photographs. Digital noise occurs when
the camera sensor does not capture the information properly during the shot. 

Attention! The filter is not available in the free version of AliveColors. 

Noise Buster allows eliminating digital noise, reducing the graininess, and getting rid of non-uniform
color spots without smearing fine image detail and while keeping the sharpness of the borders. 

In the Effects, you can find a traditional noise reduction algorithm. The AI-based filter is available here:
AI -> Noise Removal. 

Find the description of the noise reduction parameters here. 

The following features are available in the built-in Noise Buster plugin: 

Digital  Noise Reduction (traditional  algorithm). The plugin removes both luminance and color
noise on photos. 

Digital Noise Reduction

Remove Moiré. The option allows reducing unwanted moiré patterns and removing halftone from
scanned newspaper photos. 
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Remove Moiré

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS Noise Buster AI software (available as a plugin and as a standalone program) to get more
options for removing digital noise. 
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POINTS: POINTILLISM PANTING EFFECT

The built-in Points plugin allows transforming photos into paintings in the pointillism technique. 

Attention! The effect is not available in the free version of AliveColors. 

Pointillism is a special way of painting in which small separate dots of pure color are used to form images.
It grew out of the Impressionism movement and was used by artists such as Claude Monet, Paul Signac,
and George Seurat. Pointillism is based on the optical mixing effect by which the eyes blend dots of pure
color placed next to each other in an image. 

The pointillism effect is fully adjustable with the parameters. 

Pointillism Effect

The plugin is equipped with a set of Presets that allow you to make instant changes to your image with
one click of a button. Presets can be used as-is or modified as needed. 

Try the AKVIS Points software (available as a plugin and as a standalone program) to get more pointillism
effect features (including the additional parameters and the Decoration options). 
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SMARTMASK: COMPLEX SELECTION & BACKGROUND REMOVAL

The built-in SmartMask plugin allows masking and cutting out parts of photos. 

Attention! The effect is not available in the free version of AliveColors. 

SmartMask lets users quickly and effortlessly create precise selections and isolate an object from the
background. 

The plugin works equally well with both soft and hard edges of a fragment. With just a few clicks, you can
select objects with clearly drawn borders as well as with blurred, translucent edges. 

The following features are available in the built-in SmartMask plugin: 

Magic Brush . The tool helps you easily select complex objects. It works with color sets: it

keeps some colors and deletes others. Fill both lists and draw with the brush along the borders of an
object and over the background. 
Learn more about the tool. 

Magic Brush

Chroma Key. The mode allows you to quickly and precisely remove a monochrome background
(usually green or blue). Learn more about the parameters. 
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Chroma Key

Refine  Edges.  The  mode  allows  editing  edges  of  selections  or  cutout  objects.  It  significantly
improves the edges of the selection and make it softer and more natural.  Learn more about the
feature. 
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Refine Edges

You can also try the AKVIS SmartMask AI software (available as a plugin and as a standalone program). 
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AI FILTERS

The AliveColors image editor contains AI filters based on neural networks for fast and high-quality image
processing. Different filters are available for different types of licenses. Some filters are not available in
the free version. 

AI-powered filters: 

JPEG Artifact Remover
Motion Deblur
Noise Removal
Image Enlargement

The Motion Deblur, Noise Removal, and Image Enlargement modules are only available in the Home
and Business versions. In the Free version, when using these filters, a watermark will be added to the
processing result. 

Note: The program uses NVIDIA CUDA® and TensorFlow. To take full advantage of the AI functionality,
you need an NVIDIA graphics card with CUDA Compute Capability 3.5+ and the latest driver for the
graphics card. 

Mac-users need at least macOS 10.12 or later to use the neural filters. 
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JPEG ARTIFACT REMOVER

The  JPEG Artifact Remover filter uses machine learning algorithms to remove JPEG artifacts, reduce
pixelation, and clean up edges. 

JPEG Artifact Remover

Select in the main menu AI -> JPEG Artifact Remover. The Settings Panel will appear with the options: 

Original Image. Select one of the AI-modes depending on the quality of your photo: 

Low Compression - to enhance images of high or above-average quality; 
High Compression - to restore images saved with low quality; 
High Compression with Noise - to improve low quality photos with digital noise; 
Extreme - to restore badly damaged photos that have undergone multiple changes: resized,
resaved in different quality and in different formats, etc. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the entire image. 

Click Default to reset the settings to default. 

Click OK to apply the changes to the image and close the filter's dialog box. 

Click Cancel to close the dialog box without applying changes. 
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MOTION DEBLUR

The Motion Deblur filter uses a trained neural network to fix blurry photos ruined by subject movement
or camera shake. The neural filter eliminates motion blur and recovers out-of-focus images. 

Note: The filter is not available in the free version of AliveColors. 

Motion Deblur

The Settings Panel will appear when you select in the main menu: AI -> Motion Deblur. 

Remove Artifacts (0-30). Reduction and removal of artifacts and non-existent details in a photo.
Higher values can lead to blurry results. 

Focus (2-9). Improvement of sharpness of a photo. Use the parameter value depending on the
initial motion blur: the stronger the blur on an image, the higher the value to set. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the entire image. 

Click Default to reset the settings to default. 

Click OK to apply the changes to the image and close the filter's dialog box. 

Click Cancel to close the dialog box without applying changes. 
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NOISE REMOVAL

The  Noise Removal filter uses machine learning algorithms to remove digital  noise while preserving
edges and details. 

Note: The filter is not available in the free version of AliveColors. 

Noise Removal

Select in the main menu: AI -> Noise Removal. Adjust the parameters in the Settings Panel. 

Noise Level. Select the noise suppression mode depending on the quality of a photo: 

Weak Noise; 
Strong Noise; 
Strong Compression with Noise. 

Post-Processing. You can refine the result obtained by the neural network. Enable the check-box
to remove residual defects. You can also change the parameters: 

Edge Intensity (0-100). The parameter makes the edges more clear and well-defined. 

Sharpness (0-100).  The  parameter  changes  the  clarity  of  the  image  by  enhancing  the
contrast between pixels. 

Fixed Preview Area. If the check-box is enabled, all changes will be displayed in a small preview area. If
the check-box is disabled, the changes will be applied to the entire image. 
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Click Default to reset the settings to default. 

Click OK to apply the changes to the image and close the filter's dialog box. 

Click Cancel to close the dialog box without applying changes. 
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IMAGE ENLARGEMENT

Image Enlargement uses modern artificial  intelligence technologies  to  increase photos up to  800%
enhancing their quality. 

Note: This feature is not available in the free version of AliveColors. 

Image Enlargement

Select in the main menu: AI -> Image Enlargement. 

Adjust the parameters: 

New Size. In the Width or Height field, set the new size of the image (in pixels, percent, mm, cm,
or inches) taking into account the Resolution. The maximum magnification is 800%. 

Magnification Algorithm (depending on the AI model): 

A. Standard. It allows you to enlarge photos, preserving details and texture and enhancing
contrast. It's recommended to process photos of good quality without noticeable noise and
compression artifacts. 
B.  Intensified. It  allows  you  to  enlarge  images  providing  noise  removal  and  defects
compression, emphasizing edges on a picture. It works great for illustrations, artworks, low-
res images from the Internet, images with text. 

Smoothing (0-25).  Preliminary  smoothing  of  irregularities  in  the  image.  Higher  values  cause
blurring. 

Start image processing by clicking the Run button. 

Click Default to reset the settings to default. 
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Click OK to apply the changes to the image and close the filter's settings. 

Click Cancel to close the settings without applying changes. 
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SELECTION TOOLS

AliveColors provides a wide range of image editing options. The program includes selection tools that
allow you to create selections for editing areas of an image or combining parts of different images. Some
tools are available in the Toolbar, some of them - as commands in the Select menu. 

Basic Selection Tools (Rectangular Selection, Elliptical Selection, Lasso, Polygonal Lasso) 

Magic Wand Tool

Quick Selection Tool

Object Selection Tool (AI-based) 

Select Subject (AI-based) 

Color Range

Refine Edges

Modify a Selection
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BASIC SELECTION TOOLS

Basic selection tools are designed to create selection areas in the form of rectangles, ellipses, various
polygons, and areas of arbitrary shape. 

Selection

Basic Selections Tools in AliveColors: 

Rectangular Selection  lets selecting rectangular and square areas. Drag over the area you

want to select with the left mouse button. 

Elliptical Selection  lets selecting elliptical or circular areas. 

Lasso  allows creating freehand selections. Drag to draw a selection line around an object. When

you release the left mouse button, the contour will be closed, the final point will be connected to the
start one. 

Polygonal Lasso  lets creating a freehand selection from straight segments. Move the cursor

and left-click on each point, the program will automatically draw a straight line between two points.
To close the contour bring the cursor to the first point or make a double-click in the final point. 

Magnetic Lasso  allows you to create a selection outline that sticks to the edges of the image

when you move the cursor. When you release the left mouse button, the outline closes. 

Hold Shift  to make a square or a circle and to draw a perfectly vertical/horizontal line. 
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The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. 

Parameters (may vary depending on the tool): 

Selection Mode defines the result of the interaction of selections: 

New . When creating a new selection, the previous selection disappears. 

Add .  The selection area will  be increased by adding new fragments. To activate this

mode, you can also press the Shift -key. 

Subtract . This mode lets removing the part of the selection. To activate this mode, press

the Alt -key. 

Intersect .  This  mode  lets  keeping  only  the  intersection  area  of  the  selections.  To

activate this mode, press Shift+Alt . 

Add to Selection Subtract from Selection

Feather (0-250). The parameter lets blurring edges of the selection. 

Feather = 0 Feather = 10
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Anti-Aliasing. The check-box smooths the jagged edges of the selection. 
Enable this option before creating a selection. 

Anti-aliasing is Disabled Anti-aliasing is Enabled

Width (0-250). It changes the radius of the area within which the boundary search will take place

(for the Magnetic Lasso ). 

Width = 25 Width = 75

From Center. The check-box lets creating a selection (a rectangle or an ellipse) using a start point,
where the cursor is, as a center. Otherwise, selections are created from a corner. 
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Selection from Corner Selection from Center

Style. You can specify a size of a selection: 

Normal. The size of a selection is determined by dragging the cursor. 

Fixed Size. This option lets you create a selection with exact dimensions (height and width, in
pixels). 

Fixed Ratio. The ratio of height and width of a selection remains fixed. 

In the View Mode drop-down list, choose a mask view mode. All view modes except for "marching
ants" allows to edit the selection using the standard brushes. 

Selection: Marching Ants Selection: Fill with Red

Click the Default button to reset the settings to their original values. 

Using the Refine Edges feature you can quickly adjust edges of selections. 

To create and manipulate selections, you can also use the standard commands. 

All selections are displayed in the Selections Panel. 
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MAGIC WAND TOOL

The Magic Wand mask tool  selects consistently colored areas with a single click. 

The tool's parameters are shown in the Tool Options panel above the Image Window or by right-clicking
the image. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Tool's Parameters: 

Selection Modes (in  the  form of  icons)  -  logic  operations,  which  determine  the  result  of  the
interaction between selected areas. 

New . When creating a new selection, the previous selection disappears. 

Add .  The selection area will  be increased by adding new fragments. To activate this

mode, you can also press the Shift -key. 

Subtract . This mode lets removing the part of the selection. To activate this mode, press

Alt . 

Intersect .  This  mode  lets  keeping  only  the  intersection  area  of  the  selections.  To

activate this mode, press Shift+Alt . 

Tolerance (0-250). The higher the value, the more colors are included in the selection. 

Tolerance = 10 Tolerance = 50

Contiguous check-box. If  the check-box is enabled, only adjacent pixels of the same color are
selected. Otherwise, all pixels of the same color throughout the image will be selected. 
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Check-box is disabled Check-box is enabled

Anti-Aliasing check-box. The check-box smooths the jagged edges of the selection. Enable this
option before creating a selection. 

Check-box is disabled Check-box is enabled

All Layers check-box. If the check-bos is enabled, the pixels are selected based on the merged
color data from all visible layers. Otherwise, based on the color data of the current layer. 

Check-box is disabled Check-box is enabled
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In the View Mode drop-down list, you can choose a mask view mode. All view modes except for
"marching ants" allows editing the selection using the standard brushes. 

Selection: Marching Ants Selection: Fill with Red

Click the Default button to reset the settings to their original values. 

Using the Refine Edges feature you can quickly adjust edges of selections. 

To create and manipulate selections, you can also use the standard commands. 

All selections are displayed in the Selections Panel. 
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QUICK SELECTION TOOL

The Quick Selection tool  selects an object by analyzing colors of neighboring pixels. Draw with this

brush over the image, and the selection expands, automatically finding edges and filling areas. 

The tool's parameters are shown in the Tool Options panel above the Image Window or by right-clicking
the image. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Tool's Parameters: 

Selection Modes (in  the  form of  icons)  -  logic  operations,  which  determine  the  result  of  the
interaction between selected areas. 

New . When creating a new selection, the previous selection disappears. 

Add .  The selection area will  be increased by adding new fragments. To activate this

mode, you can also press the Shift -key. 

Subtract . This mode lets removing the part of the selection. To activate this mode, press

the Alt -key. 

Intersect .  This  mode  lets  keeping  only  the  intersection  area  of  the  selections.  To

activate this mode, press Shift+Alt . 

Size (1-250). This parameter specifies the diameter of the tool. All similar colors will be selected
considering the edges of the objects and the value of the Tolerance parameter. 

Tolerance (0-250). When the value of this parameter is increased, more colors are included in the
selected area. If it is set to 0 the brush selects only the areas where it's applied. 

Tolerance = 10 Tolerance = 50

Feather (0-250). The parameter lets blurring edges of the selection. 
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Feather = 0 Feather = 10

All Layers check-box. If the check-box is enabled, the pixels are selected based on the merged
color data from all visible layers. Otherwise, based on the color data of the current layer. 

Check-box is disabled Check-box is enabled

In the View Mode drop-down list, you can choose a mask view mode. All view modes except for
"marching ants" allows editing the selection using the standard brushes. 
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Selection: Marching Ants Selection: Black Background

Click the Default button to reset the settings to their original values. 

Using the Refine Edges feature you can quickly adjust edges of selections. 

To create and manipulate selections, you can also use the standard commands. 

All selections are displayed in the Selections Panel. 
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OBJECT SELECTION TOOL

The Object Selection tool  is designed to automatically select objects or areas in an image using a

specially trained neural network. This tool is helpful when you need to separate an object from the other
ones. 

Enable the Object Selection tool  in the Toolbar, create an approximate selection around the object

you want to select - a precise selection will be created automatically after releasing the mouse button. 

Object Selection

Tool's Parameters: 

Selection Modes (in  the  form of  icons)  -  logic  operations,  which  determine  the  result  of  the
interaction between selected areas. 

New . When creating a new selection, the previous selection disappears. 

Add .  The selection area will  be increased by adding new fragments. To activate this

mode, you can also press the Shift -key. 

Subtract . This mode lets removing the part of the selection. To activate this mode, press

the Alt -key. 

Intersect .  This  mode  lets  keeping  only  the  intersection  area  of  the  selections.  To

activate this mode, press Shift+Alt . 
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Selection Type.  In the drop-down list,  select  a tool  for  creating a rough selection around the
object: Rectangular Selection or Lasso. 

Contrast. When the check-box is enabled, clearer selection borders are created. 

Check-Box is Enabled Check-Box is Disabled

In  the  drop-down list,  you  can  select  the  View Mode of  the  selection.  When the  selection  is
rendered in any way other than "marching ants", it can be edited with brushes. 

Selection: Marching Ants Selection: Highlighted in Red

Using the Refine Edges feature you can quickly adjust edges of selections. 

To create and manipulate selections, you can also use the standard commands. 

All selections are displayed in the Selections Panel. 
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SELECT SUBJECT

The  Select  Subject command  allows  you  to  create  an  automatic  selection  of  the  main,  the  most
noticeable subject (or several noticeable subjects) in an image using a specially trained neural network. 

Choose from the menu: Select -> Subject, and the selection will be created immediately. 

Subject Selection

Use the Refine Edges feature to quickly adjust edges of selections. 

To create and manipulate selections, you can also use the standard commands. 

All selections are displayed in the Selections Panel. 

AliveColors Selection Tools: Select Subject

296



COLOR RANGE

The Color Range tool selects areas with the specified color or tonal range. To call it, choose Select ->
Color Range…

The pixels of the current layer are selected based on all visible colors in the image. 

You can save the settings as Presets. Find all available presets in the drop-down list. If you modify the
parameters, the preset name automatically changes to Custom, and the Save Custom Preset button 

appears next to the list. To save the current settings, press this button. 
A new preset is automatically assigned a name (for example,  Custom_1,  Custom_2, etc.) that can be
changed as needed by entering any combination of letters and numbers in the highlighted field. After
pressing Enter , a new preset will appear in the drop-down list. 
To remove a user preset, select it and press the Delete Custom Preset button . 

Click on  to export user presets to a .presets file. To load the presets into the program, press on . 

Adjust the color selection using the following parameters: 

Selection Modes (in  the  form of  icons)  -  logic  operations,  which  determine  the  result  of  the
interaction between selected areas. 

New . When creating a new selection, the previous selection disappears. 

AliveColors Selection Tools: Color Range

297



Add .  The  selection  area  will  be  increased  by  adding  new  fragments.  The  mode  is

activated by holding the Shift  key. 

Subtract . This mode lets removing the part of the selection. The mode is activated by

holding the Alt  key. 

Use  a  drop-down  list  to  select  one  of  the  standard  color  (red,  yellow,  etc.)  or  tonal  ranges
(highlights, midtones, shadows). Also, you can pick a color using the Eyedropper tool. Only the
pixels corresponding with the chosen color or brightness will be selected. 

Red areas are selected Light areas are selected

Tolerance (0-200). The parameter specifies the width of the color range included into the selection
when picking a color from the image. 

Tolerance = 20 Tolerance = 100
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Local Area check-box. Using the check-box, you can create a selection with the specified radius,
whose center is located at the point where you clicked with the eyedropper. 

Radius = 25 Radius = 50

The Invert check-box. The option inverts the selection. 

Selection Inverted Selection

The Preview Window displays either the source image or the selected area in the grayscale mode.
In the second case, white indicates the selected areas, black - not selected areas, and gray - the
transition zone. 

In the View Mode drop-down menu, you can determine how the selection will be displayed in the
Image Window. 

Press OK to create a selection, or Cancel to close the window without saving the changes. 
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To create and manipulate selections, you can also use the standard commands. 

All selections are displayed in the Selections Panel. 
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REFINE EDGES

The Refine Edges feature is extremely helpful for quick editing edges of selections or masks. It is called
using the Select -> Refine Edges… command. 

Refine Edges

The  Refine Radius tool   allows you to more accurately define the area of edge refinement for the

selection or mask (blue zone). 

The Restore Edge tool  restores the original selection/mask (red zone). 

The Eraser tool  allows you to remove strokes, both blue and red. 

The tool's options: 

Size (10-3000). The maximum line width that can be achieved with a brush (in pixels). 

Hardness (0-100). The degree of blurriness of the outer edge of the brush. 

Show Strokes check-box. When the check-box is enabled, the area drawn with the tool is always
displayed; when it is inactive, it is hidden. 

Using the buttons  /  you can undo/redo the operations with the tools. 
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Adjust edges with the following parameters: 

Radius (0-250). The parameter specifies the width of the area around the selection/cutout, where
the edge refinement is applied. 

Radius = 5 Radius = 50

Threshold (-10..90).  The  parameter  specifies  the  brightness/color  range  of  pixels  that  will  be
deleted when increasing the parameter. 

Threshold = -5 Threshold = 25

Transition (0-100). The parameter increases the smoothness of the transition within the specified
area. 
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Transition = 25 Transition = 75

Note: The  Threshold and  Transition parameters affect the image only if the value of the
Radius parameter is not zero or the Refine Radius tool was used. 

The  Radius parameter and the  Refine Radius tool work in a similar way, with the main
difference being that the parameter sets the same width for the area along the entire edge,
and the tool allows you to change the size of the area in different parts of the border. 

Smoothness (0-100). The parameter smoothes the corners of the area, makes the selection/mask
contour smoother. 

Smoothness = 5 Smoothness = 50

Feather (0-100).  The  parameter  softens  the  transition  between  the  selection/mask  and  the
surrounding background creating a semi-transparent area. 

Feather = 5 Feather = 25

Contrast (0-100). The parameter sharpens the edges of the selection or mask. 
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Contrast = 10 Contrast = 50

Shift (-100..100). The parameter reduces or enlarges the selection/mask within the transition area. 

Shift = -50 Shift = 50

In the View Mode menu, choose how to display the selection/mask in the Image Window. 

In the Result menu, choose how the result with the refined edges will be shown: selection, mask,
layer, or layer with a mask. 

You can save the settings as Presets. Find all available presets in the drop-down list. If you modify the
parameters, the preset name automatically changes to Custom, and the Save Custom Preset button 

appears next to the list. To save the current settings, press this button. 
A new preset is automatically assigned a name (for example,  Custom_1,  Custom_2, etc.) that can be
changed as needed by entering any combination of letters and numbers in the highlighted field. After
pressing Enter , a new preset will appear in the drop-down list. 
To remove a user preset, select it and press the Delete Custom Preset button . 

Click on  to export user presets to a .presets file. To load the presets into the program, press on . 

Press OK to apply changes, or Cancel to close the options. 
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MODIFY SELECTIONS

To change the selection edges, you can use the commands in the Select menu. 

Modify Commands: 

The Expand command allows you to move the selection border outward by the specified number of
pixels. 

Original Selection Expand Command

The Contract command allows you to move the selection border inward by the specified number of
pixels. 

Original Selection Contract Command

The Smooth command allows you to smooth the corners of a selection. 
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Original Selection Smooth Command

The  Border command allows you to select a line of pixels of a specified width along an existing
selection border. 

Original Selection Border Command

The  Feather command allows you to soften the edges of a selection by gradually decreasing the
sharpness. 
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Original Selection Feather Command

The  Grow Selection command in the  Select menu allows you to extend the selection with adjacent
pixels. 

Original Selection Grow Selection Command
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The Similar command in the Select menu allows you to include pixels of similar colors throughout the
image in the selection. 

Original Selection Similar Command
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SELECTION COMMANDS

The standard editor commands are available to create and manipulate a selection. 

Select menu commands: 

Select All - selects the entire image (Ctrl+A  on Windows, ⌘+A  on Mac). 

Deselect - cancels the selection (Ctrl+D  on Windows, ⌘+D  on Mac). 

Reselect - restores the previous selection (Ctrl+Shift+D  on Windows, ⌘+⇧+D  on Mac). 

Invert - unselects currently selected parts and selects currently unselected parts (Ctrl+Shift+I
on Windows, ⌘+⇧+I  on Mac). 

Transform Selection - lets transform the selection edges without affecting the image content. 

Edit menu commands: 

Cut - cuts the selected area of the current layer to the clipboard (Ctrl+X  on Windows, ⌘+X  on
Mac). 

Copy - copies the selected area of the current layer to the clipboard (Ctrl+C  on Windows, ⌘+C
on Mac). 

Copy  Merged -  copies  the  selected  area  of  merged  layers  and  places  it  on  the  clipboard
(Ctrl+Shift+C  on Windows, ⌘+⇧+C  on Mac). 

Paste - inserts the contents of the clipboard into a new layer (Ctrl+V  on Windows, ⌘+V  on Mac).

Erase - removes the selected area of the current layer (Delete ). 

Layers -> New menu commands: 

Layer via Copy - creates a new layer by copying the selected area of the current layer (Ctrl+J
on Windows, ⌘+J  on Mac). 

Layer  via  Cut -  creates  a  new  layer  by  cutting  the  selected  area  of  the  current  layer
(Ctrl+Shift+J  on Windows, ⌘+⇧+J  on Mac). 
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STANDARD BRUSHES

Using  AliveColors you can edit a photo, improve a portrait, create a colorful image, etc. The program
features a wide range of versatile tools for any purpose. 

Among them, you can find the standard (essential) brushes for retouching, colorization, cloning, painting,
etc. They are always at hand in the program's Toolbar. These brushes can only be applied on raster layers.

Standard Brushes: 

Color Brush

Color Pencil

Spray

Recolor Brush

Texture Brush

Eraser

History Brush

Paint Bucket

Gradient Fill

Clone Stamp

Chameleon Brush

Blur

Sharpen

Smudge

Lighten

Darken

Saturation

Brush Editor: Advanced Brush Settings
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COLOR BRUSH

The  Color Brush  is used to draw free-form lines with soft borders. Using this tool, you can draw

either a clear or blurry line, but they will always be soft. 

You can change the brush color using the  Color panel,  Swatches panel,  Color Wheel panel,  or by
clicking the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then
click the image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active
again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). The maximum width of a line which can be drawn with the brush (in pixels). 

Hardness (0-100).  The  amount  of  blurriness  of  the  outer  edge.  The  higher  the  value  of  this
parameter, the harder the edge of the brush becomes. At almost 100%, the brush draws almost as
hard as a pencil; while at a lower value the transition from the edge to the background is processed
more smoothly. 

Hardness = 40 Hardness = 90

Opacity (1-100). Opacity of the brush strokes in relation to the background color. As the value is
decreased, the line becomes paler and its interaction with the background grows stronger. 
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Opacity = 25 Opacity = 75

Fill (1-100).  The  paint's  density  in  a  single  brush  stroke.  When  strokes  are  painted  over  one
another, the paint becomes denser (as opposed to the Opacity parameter). At lower values of this
parameter, the color of applied strokes is weaker. When the parameter is set to 100%, the brush
paints with maximum opacity. 

Fill = 25 Fill = 75

Blend Mode. It defines how the brush strokes blend with the background. The program provides 27
blend modes. 
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Multiply Mode Overlay Mode

Beside the above-listed settings, there are some additional parameters that regulate the shape of the
brush stroke. 

Press the Default button to set all settings to their default values. 

To draw a straight line, first specify the starting point with the left mouse button, then, while keeping
Shift  pressed, move the cursor to the desired end point of the line and release Shift . If Shift  is not
released, a new line will be drawn to each point where the mouse is clicked.
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COLOR PENCIL

The Color Pencil  is designed to draw free-form lines with hard edges. 

You can change the pencil’s color using the  Color panel,  Swatches panel,  Color Wheel panel, or by
clicking the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then
click the image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active
again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). The maximum width of a line made by the brush (in pixels). 

Opacity (1-100).  The  opacity  of  the  pencil  strokes  against  the  color  of  the  background.  This
parameter sets the opacity color, by which a line is drawn: at lower values, the color of the line is
paler and its interaction with the color of the background increases. 

Opacity = 25 Opacity = 75

Fill (1-100). The parameter determines the density of paint in the brush stroke. If you hold the
mouse button while drawing, the strokes are overlapped and the filling effect increases (unlike the
Opacity parameter). The smaller the parameter, the thinner and more transparent the layer of the
color is. At the value = 100%, the brush strokes are as opaque as possible. 
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Fill = 25 Fill = 75

Blend Mode. It defines how the pencil strokes blend with the background. The program provides 27
blend modes. 

Multiply Mode Overlay Mode

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

In order to draw a straight line, click the left mouse button at its starting point, then, press Shift , click
the end point, and let go of Shift . If Shift  is not released, a new line will be drawn to each point where
the mouse is clicked. 
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SPRAY

The Spray  brush imitates spraying paint on an image. It does not apply paint in a continuous layer

but rather as droplets scattered along the stroke. 

You can change the paint color using the Color panel, Swatches panel, Color Wheel panel, or by clicking
the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then click the
image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (10-1000). The maximum width of a line made by the brush (in pixels). 

Opacity (1-100).  The  transparency  of  the  brush  strokes  against  the  background  color.  This
parameter sets the opacity of paint applied to the image: at lower values drop color becomes lighter
and interacts more with the background color. 

Opacity = 40 Opacity = 90

Blend Mode. The parameter defines how the pixels of the brush strokes mix with the pixels of the
layer being processed. The program provides 27 blend modes. 
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Multiply Mode Overlay Mode

Drop Density (1-100). The amount of spots in a stroke. At higher values of this parameter the
spray becomes denser. 

Drop Density = 10 Drop Density = 50

Drop Size (1-50). The diameter of individual drops. Larger drops will merge, forming an irregularly
shaped line with rough edges. 
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Drop Size = 5 Drop Size = 30

Intensity (1-100).  The  intensity  of  drop  color  in  a  single  stroke.  As  drops  are  sprayed  their
interaction with one another increases. The lower the value of this parameter, the paler the paint
color. 

Intensity = 10 Intensity = 50

The parameters in the Dynamics tab affect the dynamic changes when applying paint drops. 

Drop Density Variation (0-100). The parameter defines how the density of paint drops varies for
each spacing interval. 
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Drop Density Variation = 10 Drop Density Variation = 100

Drop Size Variation (0-100). The parameter defines how the size of paint drops varies for each
spacing interval. 

Drop Size Variation = 25 Drop Size Variation = 75

Color Intensity Variation (0-100). The parameter defines how the intensity of paint color varies
for each spacing interval. 
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Color Intensity Variation = 20 Color Intensity Variation = 90

In addition to the above-mentioned parameters, you can adjust the advanced settings. 

Press the Default button to set all settings to their default values. 

To spray paint along a straight line, click to set the starting point, then hold down  Shift , move the
cursor, click the end point, and release Shift . If Shift  is not released, the line will be drawn following all
selected points.
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RECOLOR BRUSH

Recolor Brush  is used to colorize the layer with the selected color. 

You can adjust the brush color in the  Color,  Swatches,  or  Color Wheel panel as well  as sample it
directly from the image. To select a color from the image, hold down the I  key to access the Eyedropper
tool. When you release the hotkey, the tool will be activated again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). The maximum width of a line drawn with the tool (in pixels). 

Hardness (0-100). The amount of blurriness of the brush’s edge. As the value of this parameter
increases the edge of the brush becomes harder. Near 100% the border between processed and
unprocessed areas will be more distinct; at lower values the boundary between these areas will be
smoother. 

Hardness = 40 Hardness = 90

Strength (1-100). The amount of influence on the image. The higher the value of the parameter,
the more intense the color overlay is when drawing with the brush. 
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Strength = 25 Strength = 75

Fill (1-100). The parameter determines the density of paint in the brush stroke. If you hold the
mouse button while drawing, the strokes are overlapped and the filling effect increases. The smaller
the parameter, the thinner and more transparent the layer of the color is. At the value = 100%, the
brush strokes are as opaque as possible. 

Fill = 25 Fill = 75

Mode.  The option indicates how the brush color pixels blend with the pixels of the layer being
processed. There are 2 coloring modes for the brush: 

Contrast - the contrast of the image is preserved; the color will be lighter in the light areas
and darker in the dark areas. Light colors have greater saturation. 

Uniform - the coloring is more uniform; the color becomes darker in dark areas, the light
areas get colorized. Dark colors have greater saturation. 
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Contrast Mode Uniform Mode

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

To draw a straight line, first select the starting point by clicking the left mouse button, then, while keeping
Shift  pressed, bring the cursor to the desired end point and release Shift . If  Shift  is not released,
additional lines will be drawn to each point where the mouse is clicked. 
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TEXTURE BRUSH

Texture Brush  is designed to draw lines of arbitrary shape with soft edges filled with the specified

texture. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

The current appearance of the stroke, as well as all changes made to the parameters, are displayed in the
preview window at the bottom of the expanded Tool Options panel. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). The maximum width of a line drawn with the tool (in pixels). 

Hardness (0-100). The amount of blurriness of the brush’s edge. As the value of this parameter
increases the edge of the brush becomes harder. Near 100% the border between processed and
unprocessed areas will be more distinct; at lower values, the boundary between these areas will be
smoother. 

Hardness = 40 Hardness = 90

Opacity (1-100). The amount of transparency of the brush strokes against the background colors.
The parameter sets the opacity of the texture used when generating strokes: the smaller its value,
the paler the color of the drawn lines is and the stronger their interaction with the background colors
is. 
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Opacity = 25 Opacity = 75

Fill (1-100). The parameter determines the density of the texture in the base element. If you hold
the mouse button while drawing, the elements are overlapped and the filling effect increases (unlike
the Opacity parameter). The smaller the parameter, the thinner and more transparent the layer of
the applied texture is. 

Fill = 25 Fill = 75

Blend Mode. The parameter defines how the pixels of the brush strokes mix with the pixels of the
layer being processed. The program provides 27 blend modes. 
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Blend Mode: Normal Blend Mode: Multiply

You can select and adjust the texture in the Texture tab by clicking the button  in the expanded Tool

Options panel. 

In the Texture Library, the available textures are shown as thumbnails. 

Texture Library

Under the texture list, the following options are located: 

New Texture . The button creates a texture from the contents of the active document (also, you

can use the New Texture command in the Edit menu). 

Add Texture . The button loads an image from the disk, which will be used as a texture. 

Delete Texture . The button removes the selected texture from the list. 

Attention! If you delete the texture that is recorded in the brush preset, the default texture
will be used in the preset instead of it. 

Texture Name. Make the field editable by clicking it, enter a new texture name and press the
Enter  key to apply it. 
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Import Library . The button allows you to load a texture library from the disk (.brush_textures

file). 

Export  Library .  The  button  allows  you  to  save  a  texture  library  to  the  disk  (with  the

.brush_textures extension). 

The parameters of the selected texture: 

Properties tab: 

Scale (1-200). The parameter sets the size of the texture pattern. The default  texture scale is
100%. 

Scale = 50% Scale = 100% Scale = 150%

Tile. When the check-box is enabled, the texture is repeated several times to fill the entire area of
the brush cursor (if Scale is less than 100%). 

Check-box disabled Check-box enabled

Mirror. When the check-box is enabled, adjacent textures are mirrored. 
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Check-box disabled Check-box enabled

Flip Horizontal. Enable the check-box to interchange the left and the right parts of the texture. 

Flip Vertical. Enable the check-box to interchange the top and the bottom parts of the texture. 

Source Texture Flipped Horizontally Flipped Vertically

Color Tab: 

Apply per Tip. When the check-box is enabled, color variations will be will be applied to individual
elements of the brush stroke. When the check-box is disabled - to individual strokes. 
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Check-box enabled Check-box disabled

Hue (-100..100). The parameter shifts all colors by the same hue value. 

Hue = -25 Hue = 25

Hue Variation (0-100). The parameter sets the variation of shades of the brush marks. At the
value = 0, all the elements have the same color. The higher the value, the more shades are used. 

AliveColors Standard Brushes: Texture Brush

329



Hue Variation = 20 Hue Variation = 70

Saturation (-100..100). The intensity of the colors of the texture: from neutral gray (-100) to the
brightest colors (+100). 

Saturation = -50 Saturation = 50

Saturation Variation (0-100). The parameter sets the variation of saturation of the base element.
At the value = 0, all the elements have the same saturation. At higher values, the saturation of
individual elements will change. 
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Saturation Variation = 40 Saturation Variation = 90

Brightness (-100..100). The parameter adjusts the brightness of the texture. As the parameter
increases, the texture becomes brighter, and when the parameter decreases, the texture becomes
darker. 

Brightness = -25 Brightness = 25

Brightness Variation (0-100). The parameter sets the variation of brightness of the base element.
At the value = 0, all the elements have the same brightness. At higher values, the brightness of
individual elements may change. 
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Brightness Variation = 10 Brightness Variation = 50

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

If the preset's settings have been changed, you can restore them using the Default button. 

To draw an arbitrary straight line, you need to left-click to specify the starting point, then hold  Shift ,
move the mouse cursor, click at the end point and release the Shift  key. If you do not release Shift , all
the new points will be connected into a single line. 
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ERASER

The Eraser tool  alters the transparency of an image (on the selected raster layer). Processed sections

are shown as transparent areas, with a checkerboard background. 

Attention!
When saving a file into a format that does not support transparency (JPEG), the transparent
areas will be replaced by white. To keep the transparency, use PNG format. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000).  The maximum width of  the transparent  line which the eraser  leaves behind (in
pixels). 

Hardness (0-100). The amount of blurriness of the brush’s edge. As the value of this parameter
increases  the  edge  of  the  brush  becomes  harder.  Near  100% the  border  between  erased  and
unerased areas will be more distinct; at lower values the boundary between these areas will be
smoother. 

Hardness = 40 Hardness = 90

Strength (1-100). The amount of influence on an image. As this parameter’s value is increased, the
degree of transparency left by the brush increases. 
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Strength = 30 Strength = 80

Fill (1-100).  The parameter  affects  the  intensity  of  the  Strength parameter  in  a  single  brush
stroke. At the value = 100%, the Strength parameter is not affected. 

Fill = 30 Fill = 80

Mode. In the drop-down list, select the operation mode of the eraser: 

Brush - the tool has a soft edge, like a brush; 
Pencil - the tool has a hard edge, like a pencil. 
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Brush Mode Pencil Mode

Color Sampling. When the check-box is disabled, the tool removes pixels of all colors. When the
check-box is enabled, you can adjust the  Tolerance value. At low values, the tool deletes colors
similar to the pixel you click on. The higher the value, the wider the range of removable colors will
be. 

Color Sampling is disabled Color Sampling is enabled

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

In order to erase in a straight line, select the starting point of the line with the left mouse button, then,
press and hold down Shift , move the cursor to the desired endpoint, and release Shift . If Shift  is not
released, then successive lines will be drawn to each point where the mouse is clicked. 
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HISTORY BRUSH

The  History  Brush  partially  or  fully  restores  the  processed  image  layer  to  the  selected  state,

weakening or canceling the applied changes or effects. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). The maximum width of a line made by the brush (in pixels). 

Hardness (0-100). The degree of blurriness of the brush’s edges. As the value of this parameter is
increased the brush’s edges become harder. At values near 100% the border between the brush’s
edges and the background is very distinct; at lower values the transition between these areas is
smoother. 

Hardness = 40 Hardness = 90

Strength (1-100). The degree of restoration to the selected state. At lower values there will be less
restoration and more blending with the effect; at values near 100% the image will  be restored
completely. 
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Strength = 25 Strength = 75

Fill (1-100).  The parameter  affects  the  intensity  of  the  Strength parameter  in  a  single  brush
stroke. At the value = 100%, the Strength parameter is not affected. 

Fill = 25 Fill = 75

In the Restore to drop-down list, select one of the previous states of the image. Areas processed
with the tool will return to this state. By default, the brush restores the image to its initial state. 

In addition to the above-mentioned parameters, you can adjust the advanced settings. 

Press the Default button to set all settings to their default values. 

To draw a straight line, first specify the starting point with the left mouse button, then, while keeping
Shift  pressed, move the cursor to the desired end point of the line and release Shift . If Shift  is not
released, a new line will be drawn to each point where the mouse is clicked. 
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PAINT BUCKET

The Paint Bucket tool  is used to quickly fill solid areas of an image with color or texture. 

You can change the fill color using the Color panel,  Swatches panel, or by clicking the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

You can also use the Fill command in the Edit menu to fill an entire layer or a selection area. When using
the command, you can choose between the following fill types: Color, Pattern, and History. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Opacity (0-100). The transparency of the fill relative to the background. The parameter determines
the opacity of the color: the smaller the value, the more transparent the fill color and the stronger
its interaction with background colors. 

Opacity = 25 Opacity = 75

Tolerance (0-250). At the minimum value, the tool fills only pixels of the same color nearby to the
one you click. The higher the value, the wider the range of colors to be filled. 

Tolerance = 5 Tolerance = 50
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Blend Mode. The parameter controls how the fill pixels are mixed with the ones of the layer. The
program provides 27 blend modes. 

Multiply Blend Mode Overlay Blend Mode

Contiguous check-box. If the check-box is activated, only adjacent pixels of the same color are
filled. If it is deactivated, all pixels of the same color throughout the image will be filled. 

Check-box is Disabled Check-box is Enabled

Anti-Aliasing check-box. The check-box eliminates irregularities in the boundaries of the fill area.
To make the edge smoother, enable the check-box before using the tool. 
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Check-box is Disabled Check-box is Enabled

All Layers check-box. If the check-box is enabled, the pixels are filled based on the merged color
data from all visible layers. Otherwise, based on the color data of the current layer. 

Check-box is Disabled Check-box is Enabled

Fill with Pattern check-box. When the check-box is enabled, the area will be filled with the selected
pattern. 

Open the Texture Library by left-clicking on the selected texture sample. 
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Texture Library

In the Library, below the list of texture samples, there are the following icons: 

Add Texture . Upload an image to be used as a pattern. 

Delete Texture . Remove the selected pattern from the library. 

Texture Name. Click to make the field editable. Enter a new pattern name and press  Enter  to
apply it. 

Import Library . Load the library from disk (.brush_textures file). 

Export Library . Save the library to disk (to the .brush_textures file). 

Texture Parameters: 

Scale (10-400). The size of the texture pattern. 

Scale = 50 Scale = 150

Angle (-180..180). The texture rotation angle. 
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Angle = -10 Angle = 50

Mirror. When the check-box is enabled, adjacent textures are mirrored. 

Check-box is Disabled Check-box is Enabled

Flip Horizontal. Enable the check-box to interchange the left and the right parts of the texture. 

Flip Vertical. Enable the check-box to interchange the top and the bottom parts of the texture. 

Without Flip Flipped Vertically
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When using the Fill command in the Edit menu, in addition to the Color and Pattern fills, the following
fill type is available: 

History. The layer will be filled with the selected history state. You can select the state to fill with
the Source for History Brush command in the context menu of the History panel. By default, the
original state of the document is selected. 

Preserve Transparency (only for the Fill command). If the check-box is enabled, the transparency of
the areas will be preserved when filling. 

Press the Default button to set all settings to their default values. 
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GRADIENT FILL

The Gradient Fill tool   lets you apply a gradual blend of colors to a layer. You can use it on raster,

shape, and Fit Text to Path layers. 

To apply a gradient, press the left mouse button at the starting point of the gradient, drag the cursor to
the place where the end point of the gradient should be located, and release. If you hold down the Shift

key while applying the gradient, the angle of inclination will change in steps of 45o. Once a gradient has
been applied, it can be modified using a guide. While holding down the Alt  key, the gradient guide can be
moved with the mouse beyond its extreme points. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Select the Gradient Type from the drop down list: 

Linear Gradient . The option draws the gradient from the starting point to the end point in

a straight line. 

Radial Gradient . The option defines a fill pattern that radiates out from the center of an

object. 
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Angular Gradient . The option defines a spiral fill pattern which rotates counterclockwise

back to its starting point. 

Reflected Gradient . The option draws the linear gradient which extends in both directions

from the starting point. 
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Diamond Gradient . Creates a gradient extending from the center point in a diamond

shape. 

Reverse . The button reverses the order of colors in the gradient fill. Click the button again to

restore the original sequence. 
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Original Sequence Reverse Sequence

Blend Mode. The parameter defines how the pixels of the gradient blend with the pixels of the
current layer. The program provides 27 blend modes. 

Multiply Overlay

Angle (-180..180).  The parameter  allows you to rotate the gradient  around the starting point.

Holding down the  Shift  key will change the angle in increments of 5o, while holding down the

Ctrl  - in increments of 10o. 
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Angle = 60 Angle = 120

Opacity (0-100). The transparency of the gradient in relationship to the colors of the background.
The parameter sets the overall opacity of the gradient: the lower the value, the paler the color of the
gradient and the stronger the interaction with the colors of the background. 

Opacity = 40 Opacity = 90

Smoothing (0-100). The parameter makes the gradient smoother by smoothing the transitions
between the individual colors and shades of colors. As the value of this parameter is reduced, the
transitions become more visible. 
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Smoothing = 0 Smoothing = 100

Dithering check-box.  Activate  the  check-box  to  make  the  gradient  smoother  and  reduce  the
number of stripes. 

Check-box is disabled Check-box is enabled

After the gradient is created, you can edit it using the options in the  Tool Options panel. Using the
gradient line you can increase the number of gradient colors and adjust the color and transparency of the
gradient components. 

To add colors to the gradient, click the gradient line in the Image Window. To remove a color point from
the gradient, drag it aside and release the mouse button. 

To adjust the color, transparency and position of the gradient points, call the menu by right-clicking on a
point. 
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Using the spectral bar, you can specify the color of the point. Also, you can use the color selection dialog,
which is displayed by clicking on the color square. 

The  Color check-box enables/disables for the point the selected color shown in the square box to the
right.  Smaller  squares represent the last  colors used when creating the gradient.  If  the check-box is
disabled, the color of this point is determined depending on adjacent pixels and cannot be changed. 

The  Opacity (0-100) check-box controls the transparency of the gradient at that point. If the  Opacity
value is less than the maximum, the transparency of the gradient varies smoothly from point to point. If
the check-box is disabled, the transparency of the gradient at that point cannot be changed and depends
on the total opacity of the gradient. 

Using the Position (0-100) parameter you can specify the exact position of each point of the gradient. 

Nota: At  the  extreme  points  of  the  gradient  the  Color and  Opacity check-boxes  are  always
enabled, and the Position parameter cannot be changed. 

You can save the gradient to use it in the future. Click the tool's icon in the Tool Options panel (F5 ) to
see the full list of gradients - the Gradient Library. 

To name the new gradient or rename the selected one, enter a new name in the field at the bottom of the
list and press Enter . 

Click  to create a new list item. 

Click  to delete the selected gradient from the library/list. 
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Click  to save all gradients to a file with the .gradlib extension. 

Click  to load a gradient library. 

To apply a gradient to the image, click anywhere in the image or select another tool. 
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CLONE STAMP

The Clone Stamp tool  is designed for copying areas of an image while maintaining the original color

range, shadows, texture, illumination, and other characteristics of the cloned part. Cloning can be done
within one layer, between different layers, or between loaded images. 

To clone an object, first select the area to be cloned: do this by first holding down Alt  on Windows
(Option  on Mac), and then clicking on the area from which the clone will be taken. 

Once the reference point is defined, place the cursor over the area you wish to place the clone. Left-click
to  apply  the  clone.  When  you  left-click  a  cross-shapped  cursor  will  appear  over  the  source  image,
identifying the original fragment. 

Note: The sample can be selected from any type of layers, but copied only to a raster layer. 

Attention! On  Linux,  by default,  the system intercepts  Alt+click to move a window with the
mouse. For the Clone Stamp tool, you can use Alt+Ctrl  or change the system settings and set a
different keyboard shortcut for moving the window. 

Clone Stamp

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). The maximum diameter of the source used for cloning (in pixels). 

Hardness (0-100).  The  degree  of  blurriness  of  the  fragment's  edges.  At  higher  values  of  this
parameter, the less the fragment's border interacts with the background. At values near 100% the
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border between the fragment and the image is very distinct; at lower values the border between
these areas will be smoother. 

Hardness = 10 Hardness = 100

Opacity (1-100). The opacity of the fragment in relation to the background. This parameter affects
the opacity of the fragment where it is stamped: at lower values, the fragment is paler and its
interaction with the background is greater. 

Opacity = 40 Opacity = 90

Fill (1-100). The opacity of the clone in a single brush stroke. When applying strokes to each other,
the opacity of the clone increases. 
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Fill = 40 Fill = 90

Blend Mode. It defines how the cloned fragment blends with the background. The program provides
27 blend modes. 

Multiply Mode Overlay Mode

Aligned check-box. This option sets how the fragment is cloned. When the check-box is activated, a
single clone will be created using information from around the selected source: in this case each
time the left mouse button is pressed a clone will be selected from the relevant area. When the
check-box is not activated, each time the mouse button is released the cursor returns to the source
area, and new clone fragments are created from this same area. 
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Aligned check-box is disabled Aligned check-box is enabled

Sample. Set a source for the sample: 

Current Layer - active layer data, 
Current & Below - data from the active and all visible underlying layers, 
All Layers - data from all visible layers. 

Clone Source settings . The changes are applied when the settings menu is closed: by pressing

the Enter  key or by clicking anywhere in the program window. 

Clone Source Settings

You can set  up  to  five  different  patterns  in  the  drop-down list  and switch  between them.  The
selected samples are stored in the list as "document name/layer name" until the source (document
or layer) is closed. To add a new sample, select an "empty" list item, switch to the image and,
holding down the  Alt  key, set a new source point. If, when adding a new clone point from an
image, an existing sample is selected in the list, it will be overwritten. 

AliveColors Standard Brushes: Clone Stamp

355



Transformation of the cloned area. For each sample in the list there are separate transformation
settings: 

Shift. In the X and Y fields, you can specify the coordinates of the starting point for copying
the sample. The values will be set automatically when selecting the source point with the Alt
key pressed. 

Scale. The size of the clone relative to the original fragment. In the W and H fields, you can
set new scale values. To maintain the clone's proportions, close the link icon . 

Clone Scaling (Left to Right: 50%, 100%, 75%)

Flip Horizontal . The command allows a clone to be mirrored along the standing axis, i.e.

interchanging the left and right sides. 

Flip Vertical . The command mirrors a clone by turning it upside down. 
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Original Image Regular Clon

Flip Horizontal Flip Vertical

Rotate. Rotation of the cloned area. 

Reset. Press the button to return the transformation settings to the original ones. 
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Sample Preview: 

Show  Overlay.  When  the  check-box  is  enabled,  the  copied  area  of  the  image  will  be
displayed inside the cursor. 

Opacity.  The parameter  allows you to  change the transparency of  the sample inside the
cursor. 

Check-Box is Disabled Check-Box is Enabled

Beside the above-listed settings, some additional parameters are available for this tool. 

Press the Default button to set all settings to their default values. 

To draw a straight line, first specify the starting point with the left mouse button, then, while keeping
Shift  pressed, move the cursor to the desired end point of the line and release Shift . If Shift  is not
released, a new line will be drawn to each point where the mouse is clicked. 
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CHAMELEON BRUSH

The Chameleon Brush  copies a fragment of an image from one part to another with respect to the

color range, tone, texture, illumination, and other characteristics of the background, to which the clone is
applied. Unlike the Clone Stamp tool, this preserves the characteristics of the background, adapting the
cloned object to a new environment. Cloning can be performed within the same layer, between different
layers, or between loaded images. 

To clone an object first choose Chameleon Brush from the left, and select an image source by holding
down  Alt  (Option  on  Mac),  and click  the  left  mouse button  over  the  area  from which  the  cloned
fragment will be selected. 

Once the reference point is defined, move the cursor to another location. To place the cloned fragment
click the left mouse button. When the left mouse button is released, a cross-shaped cursor will appear
over the source area, to indicate from where the clone fragment is selected. 

Note: The sample can be selected from any type of layers, but copied only to a raster layer. 

Attention! On  Linux,  by default,  the system intercepts  Alt+click to move a window with the
mouse. For the Chameleon Brush tool, you can use Alt+Ctrl  or change the system settings and
set a different keyboard shortcut for moving the window. 

Chameleon Brush

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
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the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). Diameter of the source area, from which the fragment is cloned (in pixels). 

Fill (1-100). The opacity of the clone in a single brush stroke. When applying strokes to each other,
the opacity of the clone increases. 

Fill = 25 Fill = 75

The  Aligned check-box sets  the cloning method.  When the check-box is  enabled,  one clone is
created from an area: in this case each new line draws information from the relevant area around
the source point. When the check-box is deactivated, each time the mouse button is clicked, a cross-
shaped cursor will appear above the source area, and new lines will create a clone from only this
area. 

Aligned check-box is enabled Aligned check-box is disabled
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Sample. Set a source for the sample: 

Current Layer - active layer data, 
Current & Below - data from the active and all visible underlying layers, 
All Layers - data from all visible layers. 

Clone Source settings . The changes are applied when the settings menu is closed: by pressing

the Enter  key or by clicking anywhere in the program window. 

Clone Source Settings

You can set  up  to  five  different  patterns  in  the  drop-down list  and switch  between them.  The
selected samples are stored in the list as "document name/layer name" until the source (document
or layer) is closed. To add a new sample, select an "empty" list item, switch to the image and,
holding down the  Alt  key, set a new source point. If, when adding a new clone point from an
image, an existing sample is selected in the list, it will be overwritten. 

Transformation of the cloned area. For each sample in the list there are separate transformation
settings: 

Shift. In the X and Y fields, you can specify the coordinates of the starting point for copying
the sample. The values will be set automatically when selecting the source point with the Alt
key pressed. 

Scale. The size of the clone relative to the original fragment. In the W and H fields, you can
set new scale values. To maintain the clone's proportions, close the link icon . 
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Clone Scaling (Left to Right: 30%, 60%, 100%)

Flip Horizontal . The command allows a clone to be mirrored along the standing axis, i.e.

interchanging the left and right sides. 

Flip Vertical . The command mirrors a clone by turning it upside down. 

Original Image Regular Clon
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Flip Horizontal Flip Vertical

Rotate. Rotation of the cloned area. 

Reset. Press the button to return the transformation settings to the original ones. 

Sample Preview: 

Show  Overlay.  When  the  check-box  is  enabled,  the  copied  area  of  the  image  will  be
displayed inside the cursor. 

Opacity.  The parameter  allows you to  change the transparency of  the sample inside the
cursor. 

Check-Box is Disabled Check-Box is Enabled

The Artistic Cloning mode temporarily disables the consideration of the neighboring pixels when applying
a clone fragment. In this mode, you can change the brush size, choose a new source from which to copy a
clone, remove parts from a clone area, etc. To remove a part of the clone, press the  Ctrl -key on the
keyboard (⌘  on Mac) and, keeping it pressed, draw over the area. 

This mode is useful when cloning from a large image or creating a clone from different parts of an image. 

To process the fragment and close the Artistic Cloning mode, you can use one of the methods: 

- press the button  in the Tool Options panel, 

- disable the Artistic Cloning check-box in the Tool Options panel, or 
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- press the Exit AC Mode button  in the History panel. 

To exit the Artistic Cloning mode without applying the changes, click  in the Tool Options panel. 

Note: When  using  the  Artistic  Cloning mode,  only  the  actions  performed  in  this  mode  are
displayed in the History panel. When you exit the mode, the full image processing history will be
restored. 

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the clone. 

Press the Default button to set all settings to their default values. 

To draw a straight line, first specify the starting point with the left mouse button, then, while keeping
Shift  pressed, move the cursor to the desired end point of the line and release Shift . If Shift  is not
released, a new line will be drawn to each point where the mouse is clicked. 
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BLUR

The Blur tool  reduces image sharpness by decreasing color contrast between neighboring pixels. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-500). Blur brush size (in pixels). 

Hardness (0-100). The width of the tool’s outer edge, where the image is partially blurred. The
higher the value, the larger the area within the brush where blur is applied completely. 

Hardness = 40 Hardness = 90

Radius (0.1-5.0). Intensity of the effect on an image. This parameter specifies the area where
points are searched for blurring: at higher values the blurring radius is larger. 

Radius = 1.0 Radius = 4.0
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Fill (1-100).  The amount of  blur  in a single brush stroke.  If  you hold the mouse button while
drawing, the strokes are overlapped and the blur effect increases. 

Fill = 25 Fill = 75

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

To draw a straight line, first specify the starting point with the left mouse button, then, while keeping
Shift  pressed, move the cursor to the desired end point of the line and release Shift . If Shift  is not
released, a new line will be drawn to each point where the mouse is clicked. 
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SHARPEN

The Sharpen tool  improves the clarity of an image by increasing the color contrast between pixels. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-500). Sharpen tool size (in pixels). 

Hardness (0-100). The width of the tool’s  outer edge, where sharpness is partially applied. At
higher values the amount of sharpness applied to the inner area of the tool increases. 

Hardness = 40 Hardness = 90

Amount (1-250). The amount of contrast between pixels. At a value of 100% contrast is increased
2 times, at 200% by 4 times, etc. 

Amount = 50 Amount = 150
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Radius (0.1-20.0).  The  degree  of  edge  sharpness.  This  parameter  specifies  the  number  of
neighboring pixels that are affected by the sharpness of a pixel. When the value is increased, the
intensity of transition between colors increases. 

Radius = 1.0 Radius = 10.0

Fill (1-100). The sharpen intensity with a single brush stroke. If you hold the mouse button while
drawing, the strokes are overlapped and the sharpen effect increases. 

Fill = 25 Fill = 75

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

To enhance sharpness along a straight line, select a starting point with the left mouse button, then, while
keeping Shift  pressed, move the cursor to the end point and release Shift . If Shift  is not released, a
new line will be drawn each time the mouse is clicked over the image. 
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SMUDGE

The Smudge tool  mixes colors by displacing pixels, like a finger passing through wet paint. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-500). Width of the Smudge Tool. 

Hardness (0-100). The amount of blurriness of the outer edge. The higher the value, the harder
the brush edge is. 

Hardness = 10 Hardness = 90

Strength (1-100). The lengthiness of a stroke’s colors. The higher the value of this parameter, the
more the element is smeared. 

Strength = 30 Strength = 65
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Use Color (0-100). Intensity of primary colors at the beginning of each stroke. The higher the
value, the brighter the color at the beginning of the stroke. If this parameter is set to zero the
stroke will be applied in the normal way (without using the primary color). 

The primary color can be selected in the Color/Swatches panels. To select a color, move the cursor
to the spectral strip (the cursor will take the form of a pipette) and click the desired color, or choose
a color from the standard Select Color dialog box. In some cases it is more convenient to change
colors manually, by adjusting the sliders. 

Use Color = 20 Use Color = 90

In addition to the above-mentioned parameters, you can adjust the advanced settings. 

Press the Default button to set all settings to their default values. 

To spread color along a straight line, first select a starting point by clicking the left mouse button and
while  holding  Shift ,  move the  cursor  to  the  desired  endpoint  and release  Shift .  If  Shift  is  not
released, then new lines will be drawn to each point where the mouse is clicked. 
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LIGHTEN

The Lighten tool  tones an image by enhancing the brightness of colors. Each stroke applied increases

the lightening effect. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). Diameter of the Lighten Tool. 

Hardness (0-100). The degree of softness of the tool's edge. The higher the value, the sharper the
tool's edge are. At 100% there is a sharp transition between the affected area and the unaffected
area; at lower values the transition between these areas is smoother. 

Hardness = 40 Hardness = 90

Strength (1-100). Amount of Lighten applied to an image. When Strength = 100% the maximum
amount of lightening is applied to an image. 
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Strength = 25 Strength = 75

Fill (1-100). The intensity of lighten effect with a single brush stroke. If you hold the mouse button
while drawing, the strokes are overlapped and the lighten effect increases. 

Fill = 25 Fill = 75

The drop-down menu Range contains three ways to process pixels: 

Shadows. Darker areas are processed more than lighter areas. 

Midtones. The brush affects both light and dark areas equally. 

Highlights. Lighter areas of the image are processed more than darker areas. 
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Shadows Midtones Highlights

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

To lighten an area in a straight line, first select the starting point by clicking the left mouse button, then,
while keeping Shift  pressed, bring the cursor to the desired end point and release Shift . If Shift  is
not released, additional lines will be drawn to each point where the mouse is clicked. 
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DARKEN

The Darken tool  tones an image by decreasing the brightness of colors. The effect is increased with

each successive brush stroke. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). Size of the Darken brush. 

Hardness (0-100). The degree of softness of the tool's edge. The higher the value, the sharper the
tool's edges are. At values near 100%, the boundary between the darkened area and untreated area
is more distinct; at lower values there is a smoother transition between these areas. 

Hardness = 40 Hardness = 90

Strength (1-100). The amount the image is darkened. At a Strength value near 100% the colors
are darkened near maximum. 
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Strength = 25 Strength = 75

Fill (1-100). The intensity of darken effect with a single brush stroke. If you hold the mouse button
while drawing, the strokes are overlapped and the darken effect increases. 

Fill = 25 Fill = 75

The drop-down menu Range provides three methods for darkening an image: 

Shadows. Dark areas are processed more strongly than light areas. 

Midtones. Dark and light areas are processed equally. 

Highlights. Light areas are processed more strongly than dark areas. 
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Shadows Midtones Highlights

Beside the above-listed settings, some additional parameters are available for this tool. 

Press the Default button to set all settings to their default values. 

To darken colors in a straight line, first select a starting point for the line by left-clicking over the desire
point, then, while pressing Shift , move the cursor to the desired end point and release Shift . If Shift
is not released, additional lines will be drawn to each point where the mouse is clicked. 
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SATURATION

The Saturation tool  tones an image by changing the saturation and contrast of neighboring pixels. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Element - in the drop-down list,  select the type of the basic element of the brush:  Ellipse or
Select Shape.

Size (1-5000). Size of the Saturation tool. 

Hardness (0-100). The softness of the tool’s edge, where the effect is applied partially. At higher
values the boundary between treated and untreated areas is more distinct; at lower values the
transition between these areas is processed more smoothly. 

Hardness = 40 Hardness = 90

Strength (1-100). The strength of the effect. The higher the value, the stronger the change. 

Strength = 25 Strength = 75
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Fill (1-100). The intensity of the effect in a single brush stroke. If you hold the mouse button while
drawing, the strokes are overlapped and the saturation/desaturation effect increases. 

Fill = 25 Fill = 75

The tool works in two modes: in  Saturate mode colors become more saturated, in  Desaturate
mode colors become less saturated. 

Saturate Mode Desaturate Mode

In addition to the above-mentioned parameters, you can adjust the advanced settings that affect the
shape and position of the brush marks. 

Press the Default button to set all settings to their default values. 

To change saturation in a straight line, pick a starting point by left-clicking the mouse, then, while pressing
Shift , move the cursor to the desired end point and release Shift . If Shift  is not released, then a new
line will be drawn to each point where the mouse is clicked.
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BRUSH EDITOR: ADVANCED BRUSH SETTINGS

Use the advanced brush settings to create new brushes and modify existing ones. 

Advanced settings are the same for most standard brushes. The parameters are located in the expanded
Tool Options panel, which is opened by clicking the tool icon or by using the F5  key. 

To change the value of a parameter, enter a numeric value in the input field of this parameter or move the
slider. 

Standard Parameters: 

Spot Spacing (1-500). Distribution of elements, from which the line is comprised. Increasing this
parameter creates a line that is composed of a series of brush marks; the distance between the
brush marks depends on the parameter’s value.

Spot Spacing = 10 Spot Spacing = 100

Aspect (1-100). The compression of the base element. At value = 1 the brush is flattened into a
line, at 100 it is a circle, and at intermediary values it is an ellipse. The lower the value for this
parameter, the further the ellipse is compressed in the direction specified by the Angle parameter.

Aspect = 30 Aspect = 80
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Angle (-180..180). The angle of the base element.

Angle = -30 Angle = 45

Round Brush. If the check-box is enabled, the brush has a shape of an ellipse, if disabled - a
rectangular shape.

Round Brush

(check-box enabled)

Square Brush

(check-box disabled)

Noise. The check-box adds noise to the soft edge of the brush. At a lower value of Hardness and a
higher value of Spot Spacing, the noise effect is more prominent.
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Check-Box Disabled Check-Box Enabled

Auto Repeat. The check-box activates the automatic (continuous) drawing mode when holding the
cursor over any point of the image.

Check-Box Disabled Check-Box Enabled

Smoothing. Activate the check-box to make the stroke edge smoother.
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Check-Box Disabled Check-Box Enabled

Advanced  Settings are  accessible  in  the  menu,  which  is  called  by  clicking  the  button   in  the

expanded Tool Options panel.

In the Shape tab, you can select the shape of the basic element of the brush. The tab is only visible when
Element = Select Shape is selected.

Brush Shape Library

Under the shape list the following options are located: 

New Shape  - creates a brush shape from the contents of the active document (alternatively, you can

use the New Brush command from the Edit menu).

Add Shape  - loads an image to be used as a brush shape.
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Delete Shape  - removes the selected brush shape from the list.

Note: If you delete the shape recorded in the brush preset, the default shape will be used in the
preset instead.

Shape Name. Make the field editable by clicking it, enter a new shape name and press the Enter  key to
apply it.

Import Library  - allows you to load a shape library from the disk (.brush_shapes file).

Export Library  - allows you to save a shape library to the disk (with the .brush_shapes extension).

The Dynamics tab contains parameters that define random changes of the base element (they can vary
for different tools and brush types): 

Size Variation (0-100). The parameter defines the variation of size of the brush marks (as a
percentage of the specified brush size). At the value = 0, the size of all elements is the same; when
increasing the parameter, smaller elements appear.

Min Size (0-100). The parameter sets the minimum percentage by which the brush marks can
scale. The parameter has an impact if the Size Variation value is not 0 and/or one of the Control
commands is enabled.

Size Variation = 25 Size Variation = 75

Hardness Variation (0-100). The parameter specifies how the hardness of brush marks varies for
each spacing interval. At the value = 0, all the elements have the same hardness; when increasing
the parameter, the hardness of certain elements decreases.

AliveColors Standard Brushes: Brush Editor: Advanced Brush Settings

383



Hardness Variation = 25 Hardness Variation = 75

Pressure Variation (0-100). The parameter sets the variation of brush pressure. At the value = 0,
the pressure is invariable; as the parameter increases, the pressure of certain elements decreases.

Pressure Variation = 25 Pressure Variation = 75

Opacity Variation (0-100). The parameter sets the variation of the opacity of the brush marks. At
the value = 0, all the elements have the same opacity. At higher values, the transparency of certain
elements increases.
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Opacity Variation = 25 Opacity Variation = 75

Fill  Variation (0-100).  The parameter  specifies  how the filling of  brush marks varies  for  each
spacing interval. At the value = 0, all the elements have the same filling density; when increasing
the parameter, the filling of certain elements decreases.

Fill Variation = 25 Fill Variation = 75

Aspect Variation (0-100). The parameter specifies how the shape of brush marks varies for each
spacing interval. At the value = 0, all  the elements have the same shape; when increasing the
parameter, the compression of certain elements increases.
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Aspect Variation = 25 Aspect Variation = 75

Angle Variation (0-100). The parameter specifies how the rotation angle of brush marks varies for
each spacing interval.  At  the value = 0,  all  the elements have the same rotation angle;  when
increasing the parameter, the rotation angle of certain elements increase.

Angle Variation = 25 Angle Variation = 75

The  Scattering tab contains parameters that affect the quantity and position of basic elements in the
stroke. 

Scatter (0-1000). The parameter sets the distribution of brush marks. The higher the value of the
parameter, the farther from the brush cursor the elements can be located. 
When the X-Axis check-box is enabled, the elements are distributed along the direction of the brush
movement. When the Y-Axis check-box is enabled, the elements are distributed across the direction
of the brush movement. If both check-boxes are enabled, then brush marks will be distributed in
both directions.

AliveColors Standard Brushes: Brush Editor: Advanced Brush Settings

386



Scatter = 50 Scatter = 150

Count (1-20). The parameter sets the number of brush marks applied at each spacing interval.

Count = 2 Count = 5

Count Variation (0-100). The parameter specifies how the number of brush marks varies for each
spacing interval. At the value = 0, the number of elements is equal to the number specified by the
previous parameter. As the parameter increases, the number of elements in each spacing interval
may decrease.
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Count Variation = 10 Count Variation = 100

The Color tab contains parameters that affect the hue, saturation, and brightness of the basic elements or
strokes. 

Apply per Tip. When the check-box is enabled, color variations will be will be applied to individual
elements of the brush stroke. When the check-box is disabled - to individual strokes.

Check-Box Enabled Check-Box Disabled

Hue Variation (0-100). The parameter sets the variation of shades of the brush marks. At the
value = 0, all the elements have the same color. The higher the value, the more shades are used.

AliveColors Standard Brushes: Brush Editor: Advanced Brush Settings

388



Hue Variation = 10 Hue Variation = 50

Saturation Variation (0-100). The parameter sets the variation of saturation of the base element.
At the value = 0, all the elements have the same saturation. At higher values, the saturation of
certain elements will change.

Saturation Variation = 30 Saturation Variation = 90

Brightness Variation (0-100). The parameter sets the variation of brightness of the base element.
At the value = 0, all the elements have the same brightness. At higher values, the brightness of
individual elements may change.
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Brightness Variation = 10 Brightness Variation = 50

Control. Next to some variation parameters the control button is located. If you click this control button
with the left mouse button, the selected control command is turned on/off. If you right-click or hold down
the left mouse button on this control key, a drop-down list opens, where you can adjust how this brush
parameter should be operated: 

Pressure  -  varies  the parameter  settings  by using the pen pressure values  provided by a

graphic tablet. 

Tilt  - varies the parameter settings by using the pen tilt values provided by a graphic tablet. 

Rotation  - varies the parameter settings by using the pen rotation values provided by a graphic

tablet. 

Fade -  reduces  the  value  of  the  selected  parameter  to  the  minimum in  the  number  of  steps
indicated in the field next to it. 

Brush Size Fading
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Direction - the given angle of inclination of the element is kept along the direction of movement (at
Angle Variation = 0). 

Angle Is Kept Along the Direction of Movement

Initial Direction - the given angle of inclination of the element is kept regardless of the direction of
movement (at Angle Variation = 0). 

Initial Angle Is Kept

When clicking the Reset button, the parameters of the selected tab will be reset to zero, and the control
settings will be disabled. 
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You can save the specified settings of the brush as a preset. The list of presets is located in the  Tool
Options panel on the left (in both minimized and expanded views). To add a new preset, click the New
Brush Preset button . To delete a preset from the list, click the Delete Brush Preset button . 

Click the button  to save the list of your brush presets into a file with the .brush_presets extension. 

You can load brushes (.brush_presets or .abr files) with the button . When loading brush presets, the

associated shapes and textures will be loaded into the appropriate libraries. 

Click  the  Default button  to  reset  all  the  modified  parameters  of  the  selected  preset  to  the  original
settings. 
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RETOUCHING TOOLS

AliveColors allows you to edit a photo and improve a portrait. The program provides a number of useful
tools. 

Retouching tools are designed to improve portrait shots - enhancing colors and tones, removing small skin
imperfections, correcting red eyes, whitening teeth. All brushes can be found in the Toolbar. You can use
retouching brushes only on a raster layer. 

Retouching Tools: 

Tuning Brush

Spot Remover

Red Eye Remover

Teeth Whitening
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TUNING BRUSH

The  Tuning Brush  allows you to slightly change the colors of an object,  add shades, midtones,

smooth creases, folds, and wrinkles, get rid of odd tones or unnecessary details. 

Note: This premium tool is available for the Home and Business licenses (not in the Free version). 

Using Tuning Brush

Adjust the brush color in the Color, Swatches, or Color Wheel panel as well as sample it directly from
the image. To select a color from the image, hold down the I  key to access the Eyedropper tool. When
you release the hotkey, the tool will be activated again. 

The tool settings are shown in the Tool Options panel above the Image Window or by right-clicking on
the image. You can also show the parameters by clicking the tool icon in the Tool Options panel or using
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (1-5000). The diameter of the brush (in pixels). 

Hardness (0-100). The amount of blur of the outer edge of the brush. The higher the value of the
parameter, the harder the edge becomes. 
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Strength (1-100). The amount of influence on the image. 

Smoothing Radius (1-10).  At  low values,  the  parameter  smoothes  out  large  details.  At  large
values, it smoothes out smaller details and keeps large ones. 

Sample (0-100). When set to 0, the brush uses the color from the starting point of the stroke. The
higher the value of the parameter, the weaker the original color and the brighter the color from the
palette appears. At the value = 100, the original color is not used. 

Color Mixing (0-100). The amount of blending with the selected color. 

Click Default to reset all settings to their default values.
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SPOT REMOVER

The Spot Remover tool  allows you to get rid of small imperfections with a mouse click. It not only

heals the skin problems but also recovers images by removing spots, blemishes, and small defects while
keeping the texture. 

Using Spot Remover

The tool settings are shown in the Tool Options panel above the Image Window. To display the list of the
parameters, click the tool icon in the Tool Options panel or press the  F5  key. You can also open the
parameters of  the tool  in the floating dialog by right-clicking in the image. To specify the parameter
settings, enter a numerical value in the parameter’s field or use the slider. 

Size (7-200). The size of the tool. 

Click the Default button to reset to the default settings. 
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RED EYE REMOVER

The  Red Eye Remover tool   allows you to fix the red-eye defect and bring your natural eye color

back. 

Using Red Eye Remover

The tool settings are shown in the Tool Options panel above the Image Window. To display the list of the
parameters, click the tool icon in the Tool Options panel or press the  F5  key. You can also open the
parameters of  the tool  in the floating dialog by right-clicking in the image. To specify the parameter
settings, enter a numerical value in the parameter’s field or use the slider. 

Size (10-300). The size of the tool. 

Brightness (-25..25). Makes the processed area darker or lighter. 

Click the Default button to reset to the default settings. 
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TEETH WHITENING

The  Teeth Whitening tool   allows you to improve the color of the teeth, make them whiter, and

remove dark plaque. A white smile symbolizes health and enhances any portrait. 

Using Teeth Whitening

The tool settings are shown in the Tool Options panel above the Image Window. To display the list of the
parameters, click the tool icon in the Tool Options panel or press the  F5  key. You can also open the
parameters of  the tool  in the floating dialog by right-clicking in the image. To specify the parameter
settings, enter a numerical value in the parameter’s field or use the slider. 

Size (20-200). The size of the tool. 

Smoothing (0-10). The softness of the tool’s edge. 

Tolerance (0-100). Sensitivity of the tool: the higher the value, the more areas are changed. 

Strength (10-100). The strength of the effect. 

Click the Default button to reset to the default settings.
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DEFORMATION TOOLS

The AliveColors image editor allows you to edit a photo, improve a portrait, create a colorful drawing.
The program provides a large number of different tools. 

The deformation tools   are designed to distort parts of an image. They allow you to retouch portrait

shots, edit facial features, reshape face or body, or create caricatures and various striking effects. 

Using Deformation Tools

Deformation Tools: 

Forward Warp

Push

Bloat

Pucker

Twirl

Reconstruct

When you select any of these tools, the Deformation mode is activated. 
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A deformation mesh allows you to track distortions more precisely. In the tool options, you can set the
size of the grid cells and its color, as well as enable or disable its visibility. 

After creating a distortion, you can save the deformation mesh for later application to other images. Press

the button  in the Tool Options panel. To load the saved deformation, click  and select a file with

the .dmesh extension. 

To close the Deformation mode applying all changes, press  in the Tool Options panel or  in the

History panel. 

To exit the Deformation mode without accepting the changes, press  in the Tool Options. 

Note: After activating the Deformation mode, the History panel will display only the actions
performed in this mode. When you exit the mode, the full image processing history will be shown. 

To return to the mode to continue editing, in the History panel, go to the Deformation group and
select any of the actions. 

After the mode is closed, a new use of any deformation tool will create a new Deformation group in the
History. 
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FORWARD WARP TOOL

The Forward Warp tool  allows you to stretch objects in the image. 

Using the Forward Warp Tool

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use the
F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (20-500). The size of the brush. 

Hardness (0-100). The softness of the tool’s edge. The effect is strongest in the center of the brush
and lighter at the edge. Increasing the value intensifies the effect at the edge of the brush. 

Strength (1-100). The strength of the effect. The higher the value, the stronger the changes are. 

Click the Default button to reset all settings to their default values. 
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PUSH TOOL

The Push tool  allows you to move the boundaries of objects in an image inward (when moving the

cursor counterclockwise) or outward (when moving clockwise). 

Using the Push Tool

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use the
F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (20-500). The size of the brush. 

Hardness (0-100). The softness of the tool’s edge. The effect is strongest in the center of the brush
and lighter at the edge. Increasing the value intensifies the effect at the edge of the brush. 

Strength (1-100). The strength of the effect. The higher the value, the stronger the changes are. 

Click the Default button to reset all settings to their default values. 
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BLOAT TOOL

The Bloat tool  allows you to increase the size of the processed object. 

Using the Bloat Tool

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use the
F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (20-500). The size of the brush. 

Hardness (0-100). The softness of the tool’s edge. The effect is strongest in the center of the brush
and lighter at the edge. Increasing the value intensifies the effect at the edge of the brush. 

Strength (1-100). The strength of the effect. The higher the value, the stronger the changes are. 

Rate (0-100). Frequency of application of deformations. 

Click the Default button to reset all settings to their default values. 
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PUCKER TOOL

The Pucker  tool allows you to reduce the size of the processed object, shrinking it while you move

the cursor along the edges. 

Using the Pucker Tool

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use the
F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (20-500). The size of the brush. 

Hardness (0-100). The softness of the tool’s edge. The effect is strongest in the center of the brush
and lighter at the edge. Increasing the value intensifies the effect at the edge of the brush. 

Strength (1-100). The strength of the effect. The higher the value, the stronger the changes are. 

Rate (0-100). Frequency of application of deformations. 

Click the Default button to reset all settings to their default values. 
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TWIRL TOOL

The Twirl tool  rotates processed pixels around the center of the cursor into a spiral. 

Using the Twirl Tool

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use the
F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (20-500). The size of the brush. 

Hardness (0-100). The softness of the tool’s edge. The effect is strongest in the center of the brush
and lighter at the edge. Increasing the value intensifies the effect at the edge of the brush. 

Strength (1-100). The strength of the effect. The higher the value, the stronger the changes are. 

Rate (0-100). Frequency of application of deformations. 

Clockwise. When the check-box is enabled, the twirling is clockwise, when it's disabled, the twirling
is counterclockwise. 

Click the Default button to reset all settings to their default values. 
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RECONSTRUCT TOOL

The Reconstruct tool  allows you to weaken the added distortions or cancel them restoring the image

to its original state. 

Note: The tool removes distortions only within the Deformation group in which they were added, i.e.

before pressing .

Using the Reconstruct Tool

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use the
F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (20-500). The size of the brush. 

Hardness (0-100). The softness of the tool’s edge. The effect is strongest in the center of the brush
and lighter at the edge. Increasing the value intensifies the effect at the edge of the brush. 

Strength (1-100). The strength of the effect. The higher the value, the stronger the changes are. 

Rate (0-100). Frequency of application of changes. 

Click the Default button to reset all settings to their default values. 
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FX BRUSHES

AliveColors allows you to edit photographs, improve portraits, create unique picturesque images. The
program provides a collection of impressive brushes for creative inspiration and implementation of your
design ideas. 

The FX brushes are presented as a collection of exciting drawing and painting tools for creating amazing
effects. 

In the Toolbar, a full set of the FX brushes is accessible by clicking on . You can switch between the

special effects brushes in the drop-down list, in the tool options. Use these tools on raster layers. 

FX Brushes: 

Fluffy Brush
Hair Brush
Bristle Brush
Thread Brush
Veil Brush
Smoke Brush
FX Sparkle Brush
Energy Brush

The Free version does not include the FX brushes. You can only use these tools with the Home/Business
licenses. 
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FLUFFY BRUSH

Activate the FX Brush tool  and choose the Fluffy Brush from the drop-down list. 

The Fluffy Brush leaves a trace that looks like a bunch of thin curly stripes diverging from the center. A
distinctive feature of this tool is its strong fluffiness. With this brush, you can draw any kinds of fuzzy and
fluffy creatures. It is also helpful for creating objects with airy loose texture, wool, angora, dandelion
florets, haze and mist effect, etc. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (2-100). The size of the base element of the brush (in pixels). 

Line Length (0-100). The parameter sets the length of fluffy lines. 

Line Length = 30 Line Length = 70

Line Width (1-100). The parameter sets the thickness of fluffy lines. At low values, the lines are
thinner and harder, increasing the value makes them wider and softer. 
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Line Width = 25 Line Width = 75

Density (1-100). The parameter sets the number of lines in a brush stroke. 

Density = 20 Density = 80

Strength (10-100). The parameter defines the stroke brightness. At low values, the lines are more
transparent, increasing the value makes them brighter and denser. 
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Strength = 25 Strength = 75

Click Default to reset all settings to their default values. 
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HAIR BRUSH

Activate the FX Brush tool  and choose the Hair Brush from the drop-down list. 

The Hair Brush leaves a trace that looks like a strand of thin long flowing lines starting from one point.
Drawing realistic looking hair is essential when creating a portrait. The brush is also useful for making
long-haired animals,  drawing whiskers,  grass,  creating mesh and striped textures,  and other  thrilling
effects. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (5-500). The size of the base element of the brush (in pixels). 

Line Width (1-100). The parameter defines the thickness of lines in a brush stroke. At low values,
the lines are thinner and harder, increasing the value makes them wider and softer. 

Line Width = 30 Line Width = 80

Density (1-100). The parameter sets the number of lines in a brush stroke. 
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Density = 10 Density = 50

Strength (10-100). The parameter defines the stroke brightness. At low values, the lines are more
transparent, increasing the value makes them brighter and denser. 

Strength = 25 Strength = 75

Click Default to reset all settings to their default values. 
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BRISTLE BRUSH

Activate the FX Brush tool  and choose the Bristle Brush from the drop-down list. 

The Bristle Brush produces a stroke consisting of multiple thin long parallel lines. The tool offers great
creative opportunities and lets you draw everything that your imagination tells you. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (10-400). The size of the base element of the brush (in pixels). 

Line Width (1-100). The parameter defines the thickness of lines in a brush stroke. At low values,
the lines are thinner and harder, increasing the value makes them wider and softer. 

Line Width = 20 Line Width = 50

Density (1-100). The parameter sets the number of lines in a brush stroke. 
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Density = 5 Density = 50

Strength (10-70). The parameter defines the stroke brightness. At low values, the lines are more
transparent, increasing the value makes them brighter and denser. 

Strength = 25 Strength = 70

Click Default to reset all settings to their default values. 
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THREAD BRUSH

Activate the FX Brush tool  and choose the Thread Brush from the drop-down list. 

The Thread Brush creates strokes consisting of multiple thin interwoven lines and allows you to achieve a
wide  variety  of  decorative  effects.  It's  useful  when  creating  abstract  backgrounds  and  eye-catching
textures, scribble and doodle effects. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (5-200). The size of the base element of the brush (in pixels). 

Line Width (1-100). The parameter defines the thickness of lines in a brush stroke. At low values,
the lines are thinner and harder, increasing the value makes them wider and softer. 

Line Width = 25 Line Width = 75

Density (1-100). The parameter sets the number of lines in a brush stroke. 
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Density = 5 Density = 50

Strength (10-50). The parameter defines the stroke brightness. At low values, the lines are more
transparent, increasing the value makes them brighter and denser. 

Strength = 10 Strength = 30

Spread (0-100). The parameter sets the distribution of the lines. At low values, the lines are located
closer to the center of the cursor, increasing the value makes the expansion stronger. 
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Spread = 30 Spread = 80

Curvature (10-100).  The parameter  adjusts  the shivering and woolliness of  the stroke.  At  low
values, the lines are located denser and closer to the center, along the main stroke. Increasing the
value makes them more curved and deviated from the main direction. 

Curvature = 25 Curvature = 75

Click Default to reset all settings to their default values. 
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VEIL BRUSH

Activate the FX Brush tool  and choose the Veil Brush from the drop-down list. 

The Veil Brush creates strokes in the form of translucent ribbons smoothly bending like colorful waves.
This spectacular tool will help you to create exciting illustrations and stunning backgrounds and textures.
It will take your photos to the next level. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (10-1500). The size of the base element of the brush (in pixels). 

Line Width (1-100). The parameter defines the thickness of lines in a brush stroke. At low values,
the lines are thinner and harder, increasing the value makes them wider and softer. 

Line Width = 25 Line Width = 75

Strength (15-100). The parameter defines the stroke brightness. At low values, the lines are more
transparent, increasing the value makes them brighter and denser. 
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Strength = 25 Strength = 75

Count (1-8). The parameter sets the number of ribbons in a stroke. 

Count = 1 Count = 3

Click Default to reset all settings to their default values. 
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SMOKE BRUSH

Activate the FX Brush tool  and choose the Smoke Brush from the drop-down list. 

The  Smoke Brush draws strokes in the form of light translucent streams of smoke. The tool lets you
easily add candle or cigarette smoke to your picture or create a mystical haze effect. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (1-500). The size of the base element of the brush (in pixels). 

Line Width (1-100). The parameter defines the thickness of lines in a brush stroke. At low values,
the lines are thinner and harder, increasing the value makes them wider and softer. 

Line Width = 25 Line Width = 75

Strength (10-100). The parameter defines the stroke brightness. At low values, the lines are more
transparent, increasing the value makes them brighter and denser. 
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Strength = 30 Strength = 80

Count (1-6). The parameter sets the number of streams of smoke in a brush stroke. 

Count = 1 Count = 3

Click Default to reset all settings to their default values. 
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FX SPARKLE BRUSH

Activate the FX Brush tool  and choose the FX Sparkle Brush from the drop-down list. 

The  FX Sparkle Brush looks like a bundle of thin sharp rays radiating from the bright center. You can
adjust the color of the rays, while the center of the sparkling element always remains white. With this
tool, you can add stars, sparkles, and light flashes to your pictures, create eye-catching shining graphics. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (10-1000). The size of the base element of the brush (in pixels). 

Density (1-100). The parameter sets the number of rays. 

Density = 5 Density = 50

Line Width (1-100). The parameter defines the thickness of rays. 
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Line Width = 25 Line Width = 75

Strength (10-50). The parameter defines the stroke brightness. Increasing the parameter increases
the amount of white in the center of the stroke. 

Strength = 10 Strength = 50

Click Default to reset all settings to their default values. 

AliveColors FX Brushes: FX Sparkle Brush

423



ENERGY BRUSH

Activate the FX Brush tool  and choose the Energy Brush from the drop-down list. 

The  Energy Brush leaves a trace that looks like a ball of energy with a bright center surrounded by
sparkling dust. You can adjust the color of the glowing contour, while the center always remains white. 

Choose the brush color in the  Color,  Swatches, or  Color Wheel panel, or from the image with the
Eyedropper tool. To pick a color sample, press and hold the  I  key and then click the image with the
Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window or by right-clicking
on the image. To display the full list of parameters, press the tool icon in the Tool Options panel or use
the F5  key. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Size (10-500). The size of the base element of the brush (in pixels). 

Density (1-100). The parameter sets the number of glowing particles. 

Density = 20 Density = 70

Line Width (1-100). The parameter defines the thickness of glowing particles. 
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Line Width = 25 Line Width = 75

Strength (10-50). The parameter defines the stroke brightness. Increasing the parameter increases
the amount of white. 

Strength = 10 Strength = 30

Click Default to reset all settings to their default values. 
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ARTISTIC BRUSHES

AliveColors lets you not only retouching photos, but also adding amazing artistic effects and creating
outstanding hand-made artworks. 

The program offers a wide range of Artistic Brushes which reliably simulate working with real painting
and drawing tools (mixing colors, paint drying, etc.). Use them to decorate your photos and add some
interesting detail, that will instantly give your images an edge! Paint a new oil or chalk masterpiece! 

You will find the artistic brushes in the program's Toolbar. They can only be used on raster layers. 

Artistic Brushes: 

Oil Brush

Roller

Felt-Tip Marker

Chalk

Artistic Pencil

Artistic Spray

Artistic Smudge

The Free version does not include these brushes. You can only use these tools with the Home/Business
licenses. 
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OIL BRUSH

The Oil Brush  was designed to imitate painting with an oil brush and paints strokes with a relief. The

density of the stroke varies across the entire line. 

You can change the brush color using the  Color panel,  Swatches panel,  Color Wheel panel,  or by
clicking the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then
click the image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active
again. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. To specify the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (1-300). The maximum line width which can be obtained by the brush (in pixels). 

Relief (0-100). The prominence of stroke details. As this parameter is increased, the pattern left by
the brush’s hairs in the paint is more pronounced and the relief of strokes is stronger. 

Relief = 20 Relief = 70

Paint Reserve (0-100). The length of painted lines. When the paint runs out, the brush stops
painting on the surface and leaves a raised, faded stroke of paint. 
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Paint Reserve = 5 Paint Reserve = 25

Color Mixing check-box. This defines the state of the paint in a brush stroke. When this check-box
is activated, the strokes mix together as if the paint is wet. If the check-box is deactivated, the paint
applies as if it is drying, and the strokes do not mix together. 

Color Mixing check-box is disabled Color Mixing check-box is enabled

Flat Brush. The check-box changes the shape of the edges of the brush strokes. If it is enabled, the
strokes look like drawn with a flat brush or a palette knife. When this option is disabled, the brush
strokes look like created with a round brush or as if paint squeezed out of a tube. 
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Flat Brush is disabled Flat Brush is enabled

Press the Default button to set all settings to their default values. 
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ROLLER

The  Roller  simulates rolling paint on an image. The brush leaves flat, porous strokes. The paint's

density varies along the line's length. 

You can change the paint color using the Color panel, Swatches panel, Color Wheel panel, or by clicking
the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then click the
image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. To specify the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (10-300). The maximum width of a line made by the brush (in pixels). 

Fill (0-100).  The  paint’s  density  in  a  single  brush  stroke.  When  strokes  are  painted  over  one
another, the paint becomes denser. At lower values of this parameter, the color of applied strokes is
weaker. When the parameter is set to 100%, the brush draws strokes in the full  density of the
chosen color. 

Fill = 20 Fill = 70

Paint Reserve (0-100). Affects the brush strokes length. When the paint runs out, the brush stops
painting on the surface and leaves behind a raised transparent trace of paint. 
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Paint Reserve = 1 Paint Reserve = 10

Color Mixing check-box. This defines the state of the paint in a brush stroke. When this check-box
is activated, the strokes mix together as if the paint is wet. If the check-box is deactivated, the paint
applies as if it is drying, and the strokes do not mix together. 

Color Mixing check-box is disabled Color Mixing check-box is enabled

Press the Default button to set all settings to their default values. 
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FELT-TIP MARKER

The  Felt-tip  Marker  is  a  special  tool  with  constantly  flowing  paint.  It  draws  smooth,  elegant,

translucent lines. 

You can change the paint color using the Color panel, Swatches panel, Color Wheel panel, or by clicking
the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then click the
image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. To specify the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (3-100). The maximum width of a line which the tool will draw (in pixels). 

Fill (0-100). The ink’s density in a single brush stroke. When strokes are drawn over one another,
the ink becomes denser. At lower values of this parameter, the color of applied strokes is weaker.
When the parameter is set to 100%, the tool draws strokes in the full density of the chosen color. 

Fill = 10 Fill = 100

Color Mixing check-box. This defines the state of the paint in a brush stroke. When this check-box
is activated, the strokes mix together as if the paint is wet. If the check-box is deactivated, the paint
applies as if it is drying, and the strokes do not mix together. 
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Color Mixing check-box is disabled Color Mixing check-box is enabled

Press the Default button to set all settings to their default values. 
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CHALK

Chalk  draws soft, textured lines with porous edges. 

You can change the chalk’s color using the  Color panel,  Swatches panel,  Color Wheel panel, or by
clicking the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then
click the image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active
again. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. To specify the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (3-200). The maximum width of a line drawn by the tool (in pixels). 

Strength (0-100). The strength of the tool’s influence on an image. At higher values, the line drawn
by the chalk will be thicker and its edges will be sharper. 

Strength = 10 Strength = 50

Press the Default button to set all settings to their default values. 
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ARTISTIC PENCIL

The Artistic Pencil  draws lines with sharp boundaries and applies paint smoothly (without relief). 

You can change the pencil’s color using the  Color panel,  Swatches panel,  Color Wheel panel, or by
clicking the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then
click the image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active
again. 

The basic tool settings are shown in the Tool Options panel the Image Window. To display the full list of
parameters,  press  the  tool  icon  in  the  Tool  Options  panel,  or  right-click  the  image.  To  specify  the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (3-100). The maximum width of a line drawn by the tool (in pixels). 

Fill (0-100). The lead’s density in a single pencil stroke. When strokes are drawn over one another,
they becomes denser. At lower values of this parameter, the color of applied strokes is weaker. When
the parameter is set to 100%, the pencil draws strokes in the full density of the chosen color. 

Fill = 10 Fill = 80

Tilt (-100..100). Imitates a pencil's tilt: pressure on one edge of the line is weakened. The stronger
the pencil's tilt, the greater the difference between edges. 
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Tilt = 10 Tilt = 100

Grain (0-100). It adds noise to the pencil strokes, makes the lines less dense. The effect is visible
at the low values of the Fill parameter. 

Grain = 30 Grain = 100

Press the Default button to set all settings to their default values. 
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ARTISTIC SPRAY

Artistic Spray  simulates spray painting on an image. The brush does not apply paint in a continuous

line, but rather in raised drops, scattered along the stroke. 

You can change the paint color using the Color panel, Swatches panel, Color Wheel panel, or by clicking
the image with the Eyedropper tool. To pick a color sample, press and hold the I  key and then click the
image with the Eyedropper tool. After the hotkey is released, the painting tool becomes active again. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. To specify the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (10-300). The maximum width of a line applied by the brush (in pixels). 

Drop Density (1-100). The density of drops in the total area of a stroke. At higher value more
drops are applied in a stroke. 

Drop Density = 25 Drop Density = 75

Drop Size (1-50). The diameter of individual dots. Larger dots will merge, forming strangely shaped
line with irregular edges. 
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Drop Size = 10 Drop Size = 30

Press the Default button to set all settings to their default values. 
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ARTISTIC SMUDGE

The  Artistic  Smudge  is  designed for  mixing different  colors  and changing the relief  of  painted

strokes. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, press the tool icon in the Tool Options panel, or right-click the image. To specify the
parameter settings, enter a numerical value in the parameter’s field or use the slider. 

Size (1-300). The maximum line width which can be obtained by the brush (in pixels). 

Relief (0-100). The prominence of stroke details. As this parameter is increased, the pattern left by
the brush’s hairs in the paint is more pronounced and the relief of strokes is stronger. 

Relief = 20 Relief = 70

Color Mixing (0-100). The parameter defines the state of the paint when drawing with the brush.
At  value = 0 the strokes do not  mix together.  The higher  the value,  the more strokes will  be
smeared and mix. 

Color Mixing = 25 Color Mixing = 75
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Flat Brush. The check-box changes the shape of the edges of the brush strokes. If it is enabled, the
strokes look like drawn with a flat brush or a palette knife. When this option is disabled, the brush
strokes look like created with a round brush or as if paint squeezed out of a tube. 

Check-box is disabled Check-box is enabled

Press the Default button to set all settings to their default values. 
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TEXT TOOLS

AliveColors image editor allows adding text to images. The text appears on text layers. 

Learn more about the text tools: 

Text Tool

Fit Text to Path

AliveColors Text Tools: Artistic Smudge

441



TEXT TOOL

The Text tool  allows you to add text to an image. The hot-key for the tool is T . 

The text automatically appears on a special text layer. You can convert this layer to a raster one with the
Rasterize Layer command. 

The text layer can also be converted to the shape layer using the Vectorize Text Layer command. After
vectorization, each character will be represented as a separate vector shape. If the text symbol consists of

several separate parts, you can select and move each part with the Edit Shape tool  while holding the

Alt  key. 

After rasterization/vectorization of text, you couldn't change or re-format it. 

Drag the cursor while holding left mouse button - the bounding box will appear where you can enter text.
You can change the size of the box by dragging the markers on the frame. Hold down Shift  to constrain

the proportions. To move the block, place the cursor outside  and drag. 

Alternatively, you can add text by clicking with the tool on an image, just start typing. In this case, text
lines are not limited in length. 

Adding a Text Block Free Typing

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, click the tool's icon in the Tool Options (top) panel or use F5 . 
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Text Parameters

Character Tab: 

Font Family. The drop-down list contains a set of system fonts that can be used when typing. 

Style. The list contains different variations of the chosen font. 

Font Size (1-1500). The parameter sets the size of the characters (in points). 

Text Settings: 

 - ALL UPPERCASE 

 - all lowercase 

 - Capitalize (All Initial Caps) 

 - Subscript

 - Superscript

 - Underline

 - Strikethrough

Color. The current text color is shown on the color plate. Click the color plate to open the Select
Color dialog box where you can specify the color of the text. You can sample color directly from the
image with the Eyedropper tool. Also, the color of the text can be set using the Color, Swatches,
or Color Wheel panels. 

Intervals: 

 - Tracking (Letter Spacing). It's the distance between characters within a word. 

 - Leading (Line Height). It's the distance between lines of text. 
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Paragraph Tab: 

Alignment Options: 

 - Align Left 

 - Align Center 

 - Align Right 

 - Justify 

Margin Options. You can adjust the indent width in pixels in the input fields. 

 - Indent First Line 

 - Left Margin 

 - Right Margin 

 - Space Before Paragraph 

 - Space After Paragraph 

Note: To open the formatting options panel, you can double-click the thumbnail of the text layer in the
Layers panel. 

Right-click text to open a context menu with standard commands: 

Undo. The command lets you undo a last change. The hotkey is Ctrl+Z . 
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Redo. The command lets you reapply a previously undone change. The hotkey is Ctrl+Y . 

Cut. The command removes the selected fragment while taking it to a clipboard. The hotkey is
Ctrl+X . 

Copy. The command duplicates the selected fragment to the clipboard. The hotkey is Ctrl+C . 

Paste. The command lets inserting data from the clipboard. The hotkey is Ctrl+V . 

Delete. The command removes the selected fragment without saving it to the clipboard. The hotkey
is Delete . 

Select All. The command selects entire text on this layer. The hotkey is Ctrl+A . 

Convert to Text Block/Convert to Free Text. The command changes the type of text. 

You can transform the text block using the Move tool . The transformation parameters will appear in

the Settings Panel if you click the frame. 

It’s also possible to transform text with the pressed  Ctrl -key. It is important to distinguish this mode
from simple changing of the bounding box. 

Transforming Text Block

To apply text press OK in the Settings Panel or select another tool in the Toolbar. To cancel click Cancel or
use Esc . 
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FIT TEXT TO PATH TOOL

The Fit Text to Path tool  is designed for adding an inscription along the outline of the selected vector

object. 

Fit Text to Path

Text is attached to a path (a vector line or a shape). When changing a path, the text changes accordingly. 

The inscription is created on a separate text layer. You can turn it into a raster one by selecting the
Rasterize Layer command in the Layers menu. 

The text layer can also be converted to the shape layer using the Vectorize Text Layer command. After
vectorization, each character will be represented as a separate vector shape. If the text symbol consists of

several separate parts, you can select and move each part with the Edit Shape tool  while holding the

Alt  key. 

After text rasterization/vectorization, you will not be able to change or re-format it. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full
list of parameters, click on the tool's icon in the Tool Options panel or use F5 . 
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Tool Parameters

Text Field. Here, you can enter text that will be applied along the selected vector path.

Font Family. The drop-down list contains a set of system fonts that can be used when typing. 

Style. The list contains different variations of the chosen font. 

Font Size (1-1500). The parameter sets the size of the characters (in points). 

Choose Path. In the drop-down list in the options panel, select the vector layer with the desired
curve. If there are several shapes on the layer, the text will be linked to the first one created. You

can also select a vector layer from the image after clicking the button . 

Text Settings: 

 - ALL UPPERCASE 

 - all lowercase 

 - Capitalize (All Initial Caps) 

 - Subscript

 - Superscript

Text Color. Click on  to open a dialog box with two tabs. In the Fill Shape tab, you can adjust

the text color. In the Stroke tab, you can add and customize the text outline. 

Click on  to sample color directly from the image. Also, the color of the text can be changed

using the Color, Swatches, or Color Wheel panels. 

Anti-Aliasing. The button  turns on anti-aliasing for the font. 
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Text Reflection Options: 

 - Reverse Text 

 - Mirror Text 

Alignment Options: 

 - Align Left 

 - Align Center 

 - Align Right 

 - Justify 

Shift Options: 

 - Shift Left/Right 

 - Shift Up/Down 

 - Letter Spacing 

Note: You can open the tool's options panel by double-clicking on the thumbnail of the text layer in
the Layers panel. 

Right-clicking on text opens a menu of standard commands. 

Undo. The command lets you undo a last change. The hotkey is Ctrl+Z . 

Redo. The command lets you reapply a previously undone change. The hotkey is Ctrl+Y . 

Cut. The command removes the selected fragment while taking it to a clipboard. The hotkey is
Ctrl+X . 

Copy. The command duplicates the selected fragment to the clipboard. The hotkey is Ctrl+C . 

Paste. The command lets inserting data from the clipboard. The hotkey is Ctrl+V . 

Delete. The command removes the selected fragment without saving it to the clipboard. The hotkey
is Delete . 

Select All. The command selects entire text on this layer. The hotkey is Ctrl+A . 

To apply text, press OK. To cancel click on Cancel or use Esc . 
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SHAPE TOOLS

AliveColors provides a wide range of  possibilities for creating images. In addition to retouching and
painting brushes, the program offers Shape Tools that let you create and edit vector shapes. These tools
are used on shape layers. 

Learn more about the shape tools: 

New Shape

Edit Shape

Fill Shape

Outline Shape
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NEW SHAPE TOOL

Shape Tools are designed to create and edit vector shapes. Shapes are created on a special shape layer
labeled .

New Shape . The tool allows you to create a vector shape by dragging the cursor while holding down

the left mouse button.

You can select a Shape Type from the drop-down list in the Tool Options panel: 

Rectangle. The tool creates a rectangle of arbitrary size. 

Rounded Rectangle. The tool creates a rectangle with rounded corners. 

Ellipse. The tool creates oval shapes. 
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Pie. The tool creates a partial ellipse bounded by the circular arc and two radius. 

Hint: To create a perfect circle or square, hold down the Shift  key when drawing a shape. 

Polygon. The tool creates a regular polygon with the specified number of sides. 

Star. The tool creates star with the specified number of rays. 
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Freeform. The tool allows you to create a variety of shapes by adding anchor points with a mouse
click. 

To cancel the addition of a new anchor point, press  Backspace . To delete an incomplete shape,
press the Esc  key. 

To complete the creation of a shape, connect the start and end points of the curve. To create an
open-curve shape, click the Apply button. To close the curve, click Close Shape. 

Freehand. The tool draws lines that follow the movement of your pointer. When you release the
mouse button, the line turns into a curve repeating the line drawn. 

Connect the start and end points to create a closed curve. If they are not connected, the shape will
be displayed as an open curve. 
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The tool settings are displayed in the Tool Options panel above the Image Window or by clicking the tool
icon in the Tool Options. 

Parameters (may vary for different shape types): 

Modes -  logic  operations  that  determine  the  outcome  of  the  interaction  between  the  created
shapes. 

New Shape . Each new shape is created on a separate layer. 

Add To Shape Area . The new shape is added to the existing ones. 

Subtract From Shape Area . The new shape is excluded from the existing one. 

Intersect Shape Areas . The option keeps only the overlapping area of the shapes. 

Note: In Add, Subtract and Intersect modes, the shapes are created on the same layer. 

Add To Shape Area Subtract From Shape Area

The From Center check-box defines a way to create a shape. If the check-box is enabled, the shape
is drawn by dragging outward from the central point. If the check-box is disabled, the shape is
drawn by dragging diagonally from one corner to another. 

Note: The Polygon and Star shapes are always created from the center.
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From the corner From the center

Constrain Proportions check-box. Enable the check-box to create perfect squares and circles. 

Radius (0-100). The parameter sets the corner radius of the rounded rectangle. 

Radius = 20 Radius = 100

Start Angle (0-360). The parameter sets the starting position for drawing the sector. 

End Angle (0-360). The parameter defines the end angle of the sector. 
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Start Angle = 45,

End Angle = 295

Start Angle = 30,

End Angle = 120

Corners (3-100). The parameter specifies the number of corners of a polygon or a the number of
beams of a star. 

Corners = 3 Corners = 8

Indent (1-100). Specifies the depth of the star’s indentations. The higher the value, the longer,
sharper, and thinner the star beams. 

Indent = 25 Indent = 75
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Smoothing (0-200). The parameter controls the degree of smoothing of the line drawn by hand.
When increasing the parameter,  the number  of  anchor  points  decreases,  and the lines  become
smoother. 

Smoothing = 10 Smoothing = 100

Click on  in the Tool Options panel to show the dialog box with Fill Shape and Stroke tabs. 

Use the Fill Shape tab to customize the color of the selected shape. 
Use the Stroke tab to add a stroke to the selected shape and edit it. 

Immediately after the creation of the shape you can adjust its position on the layer using the X and
Y parameters.  When you change the  X parameter,  the shape is  moved horizontally.  When you
change the Y parameter, the shape is moved vertically. 

Use the Width and Height parameters to adjust the size and aspect ratio of a Rectangle/Rounded
Rectangle/Ellipse/Pie. 

Use the Rotation and Radius parameters to adjust the angle and increase the size of a Polygon/
Star. 

Note: These parameters become unavailable after selecting another tool or clicking in the
Image Window. 

Use the Edit Shape tool  to change the shape and its position. 
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EDIT SHAPE TOOL

Shape Tools are designed to create and edit vector shapes. Shapes are created on a separate shape
layer labeled .

Edit Shape . The tool allows you to adjust the form and position of the shape.

You can drag the shape by placing the cursor inside the frame and moving it holding down the mouse
button. 

If the tool is active, the anchor points of the selected shape are available for editing. You can edit one or
more points simultaneously. It's possible to change the shape by dragging its segments. 

Dragging the Point Dragging the Segment

The points chosen for editing are black. Selected points can be moved or deleted. You can select multiple
anchor points by holding down the Shift  key. 

The anchor point can be of two types: smooth point and corner point. Editing of different points types will
be different. 

Smooth Point Corner Point

You can move corner points with the mouse cursor. When editing smooth points you can not only drag
them with the cursor, but also change adjacent segments using two direction lines. To change the length
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and direction of the direction lines adjust round marks located on their ends. Increasing the length of the
direction line increases the curvature of the adjacent curve. 

The direction of both vectors of the selected smooth point changes simultaneously. Hold down the Ctrl
key to change not only the direction of the lines but also their size. Hold down the Alt  key to change the
direction and size of each line separately. 

Simultaneous Adjustment Separate Adjustment

To add a new point, double click on the outline of the shape. 

To remove a point, double-click on it. Press the Delete  key to delete the anchor point and the adjacent
segments of the shape. 

Editing Options (in the Tool Options panel): 

Modes - logic operations, which determine the result of the interaction of shapes on the layer. 

Add To Shape Area . The selected shape is combined with other shapes.

Subtract From Shape Area . The selected shape is excluded from the existing one.

Intersect Shape Areas . The option keeps only the overlapping area of the shapes.

The following buttons change the order of  the shapes on the layer (valid only within the same
layer): 

 - brings the selected shape to the fore. 

 - shifts the selected shape one position forward. 

 - shifts the selected shape one position backwards. 

 - brings the selected shape to the back. 
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The Smooth Corners button  converts corner points into smooth points. 

The Sharp Corners button  turnes smooth points into corner points. 

Sharp Corners Smooth Corners

The following buttons are used to align multiple selected shapes on the same layer relative to each
other: 

 - align top edges, 

 - align vertical centers, 

 - align bottom edges, 

 - align left edges, 

 - align horizontal centers, 

 - align right edges. 

If  the  Auto Select check-box is  enabled,  left-clicking on any shape automatically  activates the
appropriate shape layer. 

Click on  in the Tool Options panel to show the dialog box with Fill Shape and Stroke tabs. Use

the Fill Shape tab to customize the color of the selected shape. Use the Stroke tab to add a stroke
to the selected shape and edit it. 
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FILL SHAPE

You can fill shapes as well as text along a path with a color or gradient. The settings affect all the vector
objects within the selected shape layer. 

Fill Settings

The fill settings are displayed by clicking the  icon next to the name of the selected shape layer or by

pressing   in the  Tool Options panel and switching to the  Fill Shape tab. The parameters will be

applied to the selected shape. 

Fill Types: 

No Fill . The created shape will be transparent. 
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No Fill

Color Fill . The created shape will be filled with one color. 

Color Fill

To choose a color bring the cursor over the spectral line (the cursor takes the form of a pipette) and
click on the desired color. 

The  rectangular  plate  below  indicates  the  selected  color.  Double-click  on  it  to  open  the  color
selection dialog. The recent colors are displayed in the adjacent fields to the right. 

Gradient Fill . The created shape will be filled with the selected gradient. 

Gradient Fill
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You can specify gradient colors using the gradient line. Click on the gradient line to create a color
point. You can adjust the color and opacity of any point by double-clicking on it. 

Also, you can fill the shape with a gradient using the Gradient Fill  tool. Select the tool from the

Toolbar and apply it  to  the shape layer.  The settings can be adjusted using the Gradient  tool
parameters or using the Fill Shape parameters. 

Gradient Settings: 

Gradient Type: 

 - Linear, 

 - Radial, 

 - Angular, 

 - Reflected, 

 - Diamond. 

Reverse . The button reverses the order of colors in the gradient fill. 

Original Sequence Reverse Sequence

Dithering check-box. Activate the check-box to make the gradient smoother and reduce the
number of stripes. 
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Check-box is disabled Check-box is enabled

Aligned check-box. If  the check-box is enabled, the gradient is aligned to the shape and
moves  appropriately  with  it.  If  the  check-box  is  disabled,  the  gradient  is  aligned  to  the
document and doesn't move when dragging the shape. You can scale the gradient by turning
the check-box on/off. 

Check-box is disabled Check-box is enabled

Scale (10-150%).  The  parameter  sets  the  distance  between  the  extreme  points  of  the
gradient. The default value is 100% and matches the size of the shape. 

Scale = 20 Scale = 120
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Angle (-180..180). The parameter allows you to rotate the gradient. 

Angle = 30 Angle = 90

Smoothing (0-100).  The  parameter  makes  the  gradient  smoother  by  smoothing  the
transitions between the individual colors and shades of colors. 

Smoothing = 10 Smoothing = 100

Opacity (0-100). The parameter is common to both fill types and sets the overall fill opacity: the
lower the value, the more pale and transparent the shapes are on the selected layer. 
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Opacity = 40 Opacity = 90

To outline the selected shape, configure the settings in the Stroke tab. 
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OUTLINE SHAPE

You can outline shapes as well as text along a path with color borders. The outline will be added to all the
vector objects within the selected shape layer. 

Stroke Settings

The outline settings are displayed by clicking the  icon next to the name of the selected shape layer or

by pressing  in the Tool Options panel and switching to the Stroke tab. 

Stroke Types: 

No Stroke . There is no outline. 

No Stroke

Color Stroke . The border of the selected shape is highlighted with the desired color. 
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Color Stroke

Select the color of the outline in the spectral line - the cursor takes the form of an eyedropper. 

The rectangular plate below indicates the selected color. Double-click on it to open the Select Color
dialog. The recent colors are displayed in the adjacent fields to the right. 

The Width parameter (1-100) defines the thickness of the color stroke. 

Width = 5 Width = 25

Choose a line type from the drop-down list: 

Solid Line Dashed Line

Select an edge type of the dashed line in the drop-down list: 
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Short Strokes Long Strokes Rounded Strokes

Select the appearance of the outline at the corners of the shape in the drop-down list: 

Sharp Corner Chamfered Corner Rounded Corner

To change the color of a shape, adjust the settings in the Fill Shape tab.
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COMMON TOOLS

AliveColors provides a wide range of features for editing and retouching photos. 

In addition to its retouching and artistic brushes, the program has also a set of auxiliary tools that help to
edit images. 

Follow the links below to learn more about these tools: 

Alignment Tools (Rulers, Guidelines, Grid) 

Move

Crop

Perspective Crop

Transform (Free Transform, Transform) 

Eyedropper

Hand

Zoom
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ALIGNMENT TOOLS

To make it  easier  to move and align objects (layers) and selected areas,  use rulers and a grid with
guidelines. The alignment lines are displayed only on the screen; you can turn them off at any time. 

Alignment Tools

To adjust the alignment settings, use the Workspace menu in the Control Panel: 

Rulers. When this option is enabled, you can see the rulers along the edges of the Image Window.
Right  mouse  clicking  on  a  ruler  lets  you  select  the  units  of  measurement  (pixels,  inches,
centimeters, etc.). 

Marks on the rulers indicate the position of the cursor. 

To change the origin (zero), place the cursor over the intersection of the rulers in the upper left
corner of the Image Window and drag diagonally to the desired point in the image. To restore the
default origin, double-click this corner. 

Grid.  When this  option is  checked,  the grid appears over the image. The grid’s  point  of  origin
depends on the rulers origin. 

Pixel Grid.  If  this menu item is checked, a light grid outline is putted around each pixel  once
beyond 600% zoom level. 

Guidelines... The command opens a dialog in which you can create, move, and delete guidelines. 

Show  Guidelines.  If  this  menu  item  is  checked,  all  guidelines  will  be  shown  in  the  image;
otherwise, the lines are hidden. Hiding guidelines disables them and makes it impossible to align
objects with them. 
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Lock Guidelines. This option prevents any accidental movement of guidelines. 

Clear Guidelines. This command removes all guidelines. 

Snap. This feature helps to precisely position the object which "clings", when moving, to the edge of
a selected element. You can move objects within 5 pixels of the anchor point by rotating the mouse
wheel while holding the left mouse button. 

Snap to... In the drop-down list, specify elements to which to snap: 

- Grid; 
- Guidelines; 
- Selection; 
- Layers; 
- Document. 

Working with Guidelines:

To create a horizontal or vertical guideline, place a cursor over a corresponding ruler, and holding
the left mouse button, drag a blue line. 

You  can  also  create  a  guideline  in  the  Guidelines dialog  box.  Call  the  dialog  by  selecting

Workspace - > Guidelines... or by pressing the button  in the Move tool's  options. 

In the X and Y fields, specify the position of the center of rotation of the guideline, and in the Angle

field - the rotation angle. With an angle value of = 0o a horizontal guideline will be created, with a

value of 90o a vertical guideline will be created. Click the  Add button to add a guideline to the
image. 

List of Guidelines
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You can move the guidelines with the  Move tool  .  When you hover over a guideline, these

controls appear: 

Round markers are used to rotate the guideline. When you hover over them, the cursor will
change to . If you hold down the left mouse button and move the cursor, the guideline will

rotate around the center. You can move the center of rotation along the guideline using the
mouse. 

Square markers at the ends of the line allow you to adjust the tilt of the guideline. When you
hover over them, the cursor will change to . Hold down the left mouse button and move the

cursor to change the tilt angle of the guideline. 

When you hover over a line, the cursor will appear  and the guideline can be moved. When you

hold down the Ctrl  key, the guideline will move in 10 pixel increments. 

To create a copy of a guideline, hold down the Shift+Alt  keys while moving it. 

You can also change the position of the guideline in the Guidelines dialog box. Select the line in the
list, set new values in the X, Y, and Angle fields, and click the Change button. 

To remove a guideline, drag it outside the Image Window or select it from the list and click the
Delete button. 

Click   in the upper right corner of the program window or select  File - Preferences... to open the

Preferences dialog box. Switch to the Guides & Grid tab to adjust rulers, guidelines, and grids. 
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MOVE TOOL

The Move tool  lets you drag an object (layer) by holding the left mouse button. 

Using the arrow keys with the enabled tool, you can move the active layer or the selected fragment in the
chosen direction in increments of one pixel or with the Ctrl  key in increments of 10 pixels. 

Hold the Shift+Alt  keys while moving a layer/object to create and move its copy. 

Moving Objects

The tool's parameters will be displayed in the Tool Options panel above the Image Window and by right-
clicking within the image. 

Auto Select check-box. Enable this mode to automatically select a single layer or layer groups with
the mouse click. Use this feature when working with a multilayer document. 

Double-clicking on a vector shape or text will activate the Edit Shape tool, the Text tool, or the Fit
Text to Path tool, respectively, to edit the selected element. 

Show Bounds check-box. This option lets you show/hide a bounding box of the moving object. 
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Show Bounds Hide Bounds

Note. If you enable the check-box and drag one of the square markers, the Free Transform tool is
activated. The transformation parameters are displayed in the Settings Panel.

Use the following buttons to align the selected layer relative to the canvas or multiple selected layers
to each other: 

 - align top edges, 

 - align vertical centers, 

 - align bottom edges, 

 - align left edges, 

 - align horizontal centers, 

 - align right edges. 

Top Edges Aligned Horizontal Centers Aligned

Click the Default button to reset the settings. 
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CROP TOOL

The Crop tool  allows cutting off an image that helps to remove unwanted areas, to improve focus, or

to make a square from a rectangular or contrariwise. To quickly access the tool use C . 

You can also activate the Crop tool using the command Image -> Crop...

The Image -> Crop by Selection command allows you to quickly remove parts of an image surrounding
the selection. 

Activating the tool creates a crop frame that encloses the entire image. Select an area you want to keep
by dragging the cursor while holding left mouse button. 

Crop Area

If there is an active selection on the image, the crop frame automatically appears around the selection
area. 

You can change the size of the area by dragging the markers on the sides and angles of the bounding

frame. To constrain the proportions hold down Shift . To move the frame, place the cursor  inside it

and drag. If you move the cursor to the center point, it turns to an arrow with a circle : in this case,

only the center is movable. 

To rotate the area, place the cursor  outside the frame, and move it with the left mouse button. If you

press  Alt ,  the rotation angle will  change in 5 degrees. The frame rotates around the transformation
center. 

Note: Blue markers on the bounding frame indicate where will be the top of the cropped image.
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If the frame is beyond the image, the empty area will be filled with a transparent background. 

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full

list of parameters, press the tool icon  in the Tool Options panel or F5 -key. 

Crop Settings

In the drop-down-list, select the size or the ratio to which you want to crop the picture. You can
choose between the crop modes: W x H x Resolution (exact size), Freehand, Custom, Original,
etc. (aspect ratio). 

The  W x H x Resolution item allows you to set the output size of the cropped image (in
pixels, inches, mm, cm). The crop frame will be created with the aspect ratio specified in the
Width and Height fields. The cropped image will be resized to the specified Width, Height,
and Resolution. 

To select the crop area by dragging the cursor over it, use the Freehand option. 

To crop an image to a specific ratio, select the  Custom option and enter the values in the
Width and Height input fields. 

To keep the original aspect ratio fixed, choose the Original option. 

Other items in the list allow you to choose one of the most common aspect ratios. 

Click  to swap the Width and Height values of the crop area. 

In the Trim section, specify the crop mode: 

Manual. The crop area is created using the cursor. 
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Trim Alpha. The crop frame is created using the alpha channel's information. 

Trim Selection. The crop frame is created using the selection channel's information. 

Top Left Color. Areas having the same color as the upper left pixel in the image will  be
placed outside the crop frame. 

Bottom Right Color. Areas having the same color as the lower right pixel in the image will be
placed outside the crop frame. 

Trim Alpha Top Left Color

You can select the side from where to crop the picture: Top,  Bottom,  Left,  Right. This option is
disabled for the selected Manual mode. 

The tool can work in two modes: 

Remove External Area. The areas outside of the bounding frame will be deleted. 

Hide External Area. The areas outside of the frame will be hidden but still accessible. This
mode lets you correct the cropped area later - you can move the visible part with the Move
tool. 

External Area. The check-box helps to better visualize areas in and outside of the crop frame. If
the check-box is enabled, the outer parts are highlighted in a selected color. 

Check-box is Disabled Check-box is Enabled
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Adjust the visualization options for the external area: 

Color. Click the color square to open the Select Color dialog box. 

Using Red Color Using White Color

Opacity (1-100). The parameter defines the transparency of the highlight color. 

Opacity = 25 Opacity = 75

Grid . In the drop-down menu, select one of the display options grid that helps when building an

image composition or aligning frame boundaries. You can switch the grid view using the O  key. 

For the Triangle and Golden Spiral grids, the Cycle Orientation button is active . It allows you

to mirror and rotate the grid. You can also flip the grid using the Shift+O  key combination. 

To apply the tool and remove the areas outside the frame, click OK or press Enter . To cancel the crop,
press Cancel or use the Esc -key. 
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PERSPECTIVE CROP

The Perspective Crop tool  combines two operations into one – correcting perspective and cropping.

The tool can be used to fix perspective distortions, which can occur when taking pictures of wide or tall
objects with a camera at an angle to the subject. 

Perspective Crop

Activating the tool creates a crop frame that encloses the entire image. Select an area you want to keep
by dragging the cursor while holding left mouse button. 

If there is an active selection on the image, then the crop frame will cover the selection area. 
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Initial Crop Area

Drag the corner  markers  to  change the perspective  of  the  contour.  When moving the markers,  it  is
necessary to ensure that the sides of the frame become parallel to the sides of the object being corrected. 

Hint: Blue markers on the frame indicate where the top of the cropped photo will be. 
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Modified Crop Area

The basic tool settings are shown in the Tool Options panel above the Image Window. To display the full

list of parameters, press the tool icon  in the Tool Options panel or F5 -key. 

In the Width, Height, and Resolution fields, specify the final dimensions of the cropped image. If values
are zero, the final image dimensions will be determined automatically. 

In the Trim section, specify the method for creating the crop area: 

Manual. A crop frame is created manually using the mouse cursor. 

Trim Alpha. A crop frame will be created based on the contents of the alpha channel. 

Trim Selection. A crop frame will be created based on the contents of the selection channel. 

Top Left Color. Areas having the same color as the upper left pixel in the image will be placed
outside the crop frame. 

Bottom Right Color. Areas having the same color as the lower right pixel in the image will be
placed outside the crop frame. 

You can select the side from where to crop the picture: Top, Bottom, Left, Right. This option
is disabled for the selected Manual mode.
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External  Area.  The check-box helps to facilitate visualization of  the crop frame. If  the check-box is
enabled, the outer parts are highlighted in a selected color. 

External Area check-box is disabled External Area check-box is enabled

Show Grid. When the check-box is active, a grid is displayed above the crop area, which helps when
adjusting the crop frame. 

To complete the perspective cropping, click  OK or press the  Enter  key. After that, the crop area will
convert to a rectangular shape, and everything outside the frame will be deleted. 
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Cropped Image
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TRANSFORM TOOL

Call the  Free Transform and Transform commands in the  Edit menu to apply transformations to the
selected layer or object. The transformation parameters are displayed on the Settings Panel. 

Note: If you want to transform the entire image, you should select the needed operation in the
menu Image -> Transform Image. In this case, all layers of the active image will be transformed.

To transform the contour of the selection, use the  Transform Selection command in the  Select
menu. 

Transformation Options: 

Shift. You can change the position of an object horizontally (X) and vertically (Y). The parameter
uses the coordinates (in pixels) of the upper left point of the bounding box or of the center point (if
the sign   is activated). Usually the center point is fixed, but you can move it  to the different
location. 

Place the cursor  inside the bounding frame and drag the object. If you bring the cursor to the

center point, you will get a pointer with a circle  - now you can move only the center point. 

Before Moving Object After Moving Object

Scale. You can adjust the size of an object in width (W) and height (H) (in percent). Drag one of
the eight square markers on the frame to increase or reduce the size. The cursor will turn into a
two-sided  arrow  .  Use  Shift -key  or  press  the  sign   between  W and  H to  constrain  the

proportions of the object. If the sign is deactivated   the proportions can change. Hold down the

Alt  key to scale a fragment or a layer relative to its center point (transformation center). 
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Original Size Scale Increased

Skew. You can shift some parts of an object relative to the others. When you bring the cursor to the
frame, it will look like this . Press and drag to transform the object. Hold down the Alt  key to

skew a fragment or a layer relative to its center point (transformation center). 

Source Object Object is skewed

Perspective. You can alter the perspective of the selected object and fix perspective distortions.
Select Edit -> Free Transform... and move the corner markers while holding down the Ctrl  key.
Each marker can be moved independently of the others, which allows you to easily change the
perspective of the selected object. 

AliveColors Common Tools: Transform Tool

486



Original Perspective Modified Perspective

Rotate. You can rotate an object. The center of rotation can be changed by moving the center point
of  the object.  Outside the bounding frame the cursor  turns to  a  rounded two-sided arrow  .

Holding down the left mouse button, rotate the object clockwise or counter-clockwise. If you press
Alt , the rotation angle will change in five degrees. 

Before Rotation After Rotation

Click  the  Reset  Perspective button  to  reset  the  changes  you  made  to  the  perspective.  The
transformation will be determined by the parameters in the settings panel. 

Click the Reset Center button to restore the center point in its default position. 

Press OK to apply changes. To cancel the transformation press Cancel or use the Esc -key. 

Also, you can apply transformations using the following commands from the Transform submenu: 

The commands Rotate 90o CW, Rotate 90o CCW, and Rotate 180o rotate the image to specify
degrees. 
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Flip  Horizontal.  The  command  allows  an  object  to  be  mirrored  along  the  standing  axis,  i.e.
interchanging the left and right sides. 

Flip Vertical. The command mirrors an object by turning it upside down. 

Before Transformation Rotate 90 CW

Flip Horizontal Flip Vertical
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EYEDROPPER

The  Eyedropper tool   lets selecting a color from an image. A color selected with a mouse-click is

shown as the current color. If you move a cursor holding down the Eyedropper tool you can see how the
current color  dynamically  changes.  Moving the Eyedropper with the pressed  Shift -key averages out
colors along all pixels in the cursor’s path. Press I  to quickly access this tool. 

The tool's parameters are shown in the Tool Options panel above the Image Window or by right-clicking
the image. To specify the parameter settings, enter a numerical value in the parameter’s field or use the
slider. 

Sample Size (1-51). The number of pixels around the eyedropper’s tip that are used to average the
selected color. At minimum values, the area around the eyedropper’s tip is reduced to one pixel. A
higher value of the parameter can be used on photos with a lot of color noise (random red and blue
pixels on homogeneous background). 

In the popup menu you can select between the variants. In the Tool Options panel it’s possible to set
more precise Sample Size using the slider or entering a numerical value in the parameter field. 

Show Color Ring check-box. If the option is enabled, the eyedropper’s cursor is displayed as a
Color Ring with 5 sectors that lets to get more information about the colors in this area. 

Gradient line with the current color in the center, on the left side is +30% black, and on the
right side +30% white. 
The previously selected color. 
The current color of the pixel where the cursor is. 
Colors of surrounding pixels. 
Average  colors  from  areas  of  3x3,  5x5,  11x11,  31x31,  51x51,  101x101  px  (around  the
eyedropper’s tip). 

This feature helps you select colors more precisely. If it's hard to catch a certain color, you can see
adjacent tints in the Color Ring and select the color on the ring while holding the Ctrl -key. 

1. 

2. 
3. 
4. 
5. 
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HAND

The Hand tool  is designed to scroll the displayed area of the image in the window if the whole image

doesn’t fit into the window at the chosen scale. To move the image you should press this button, put the
cursor onto the image, press the left button and, keeping it pressed, move the image in the window. 

Scrolling of Displayed Area

To scroll through the image, you can use the scroll bars or press the space bar and drag the image with
the left mouse button. 

To align the picture in the center of the  Image Window, double-click on the square field between the
scroll bars. 

Use the buttons in the Tool Options panel above the Image Window to adjust the image scaling: 

100% (Ctrl+1  on Win, ⌘+1  on Mac) - the image is displayed at its actual size; 

Fit to View (Ctrl+0  on Win, ⌘+0  on Mac) - the image is fully visible in the Image Window; 

Fill Window - the image is scaled to fill the Image Window completely. 

Double-clicking the tool’s icon  on the Toolbar makes the image fit the Image Window (Fit to View). 
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ZOOM

The Zoom tool  is used to change the image scale. You can also use the Navigator panel. 

To zoom in or out, select the tool and click the image. In the Tool Options panel, select one of two modes: 

- Zoom In : click in the image or hold-down the left mouse button to zoom in; hold down the

Alt  key and click in the image to zoom out. 

- Zoom Out : click in the image or hold-down the left mouse button to zoom out; hold down the

Alt  and click to zoom in. 

When the  Scrubby Zoom check-box is enabled, the scale is changed by holding the left mouse button
and moving the cursor: to the right to increase the scale, to the left to decrease the scale. 
When the check-box is disabled, you can zoom in an image area. To do this, hold down the left mouse
button and select a rectangular area. Once the rectangle is drawn, the area will be scaled to fit the Image
Window. 

Zoom-In Selected Area

To restore the original scale, press the 100% button in the Tool Options panel. When you click the Fit to
View button, the image will automatically scale to fit the size of the Image Window. 

You can also use the keyboard shortcuts to change the image scale: +  and Ctrl++  (⌘++  on Mac) to
zoom in, -  and Ctrl+-  (⌘+-  on Mac) to zoom out. 

You can adjust the scale using the following commands in the Image menu: Zoom In, Zoom Out, and
Scaling. 

Double-clicking the tool’s icon  on the Toolbar makes the image scale to 100% (Actual Size). 
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RAW PROCESSING

When you open a RAW file in AliveColors image editor, the RAW editing mode is launched. It is possible to
preprocess the image, and then continue working in the graphic editor. 

Use the parameters in the following tabs to adjust the RAW files: 

General Settings
Tone Curve
Details
HSL/Grayscale
Lens Corrections

In the Presets field, you can save the settings of all the tabs as a preset in order to reuse them with the
other RAW files. 

After adjusting the parameters,  click the  OK button to apply the settings to the entire image or the
Cancel button to discard all  changes. Then you can edit the image using the tools and filters of the
software. 
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GENERAL SETTINGS

The General Settings tab  contains settings for adjusting the white balance, tone and saturation of an

image. In this tab, you can perform the basic correction, and then use the parameters of other tabs to
fine-tune the image and get rid of some optical defects. 

The following parameters are used for tonal and color correction of an image: 

In the White Balance section, you can adjust the color correction settings to provide more accurate color
reproduction of an image. 

White balance is a process of color correction that makes white appear white, with no color tinge. 

You can automatically adjust the Color Temperature and Tint parameters using the presets in the White
Balance drop-down list. The entire color tone of the image changes according to the chosen preset. 

The default preset is As Shot. It applies camera white balance settings to the image if they are available
(recorded in the image metadata area). 

When you select Auto, the program will analyze the image and automatically adjust the white balance. 
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If the white balance was set incorrectly when shooting, you can choose one of the presets whose name
most  closely  matches  the  ambient  light  conditions  in  the  photo:  Daylight,  Cloudy,  Shade, 
Incandescent Lamp, Fluorescent Lighting, or Flash. 

As Shot Shade

If you are not happy with the automatic adjustment, you can change the parameter values manually: 

Color  Temperature (2000-50000).  The  parameter  moves  the  color  temperature  of  the  image
between  blue  and  yellow  along  the  Kelvin  scale.  If  the  photo  was  taken  at  a  higher  color
temperature of light (bluish), increase the value of the parameter. If the image was photographed at
a lower color temperature of light (yellowish), reduce the value of the parameter. 

Color Temperature = 4760 Color Temperature = 3552

Tint (-150..150). Changing the value of the parameter compensates for a green or magenta tint.
Decreasing  the  value  of  the  parameter  adds  more  green,  and  increasing  the  value  adds  more
magenta. 
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Tint = 5 Tint = 50

When setting the parameter values manually, the name of the preset will change to Custom. 

In the Tone Correction section, you can even out the brightness in certain areas of the image as well as
reveal details in the overexposed and underexposed areas. 

Exposure (-4.00..4.00). The parameter allows you to increase/reduce the amount of light being
rendered. As the value of the parameter decreases, the image becomes darker. When increasing the
parameter value, the image becomes lighter. 

Exposure = -1.00 Exposure = 1.00

Details in Highlights (0-100). The parameter allows you to reveal  the details  hidden in over-
exposed areas. As the parameter increases, the bright areas become darker, the details in these
areas become clearer. 

AliveColors RAW Processing: General Settings

495



Details in Highlights = 5 Details in Highlights = 50

Details in Shadows (0-100). The parameter allows you to reveal  the details  hidden in under-
exposed areas. As the parameter increases, the shaded areas become brighter, the details in these
areas become clearer. 

Details in Shadows = 5 Details in Shadows = 50

Darken (0-100). The parameter enhances the shadows in the image. The impact in the dark areas
is more intense, while light and mid-tone areas change less. The parameter increases the contrast of
the image. 
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Darken = 0 Darken = 15

Brightness (-150..150). The parameter allows you to adjust the overall brightness of the image,
make  it  darker  or  lighter.  When  increasing  the  parameter,  the  image  becomes  lighter.  When
decreasing the parameter, the image becomes darker. 

Brightness = -50 Brightness = 50

Contrast (-50..100). The parameter allows you to increase or decrease the contrast of the image.
When increasing the parameter, the dark areas of the image become darker, and the light areas
become lighter. 
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Contrast = -25 Contrast = 25

Click the Default button to revert the settings to their defaults. 

In the Color Correction section, you can change the sharpness of the image as well as the saturation of
colors. 

Adjust the following parameters: 

Sharpness (-100..100). The parameter enhances the details by increasing the difference between
the pixels located at the edges of the light and dark areas. The local change in contrast affects
mainly the halftone areas. By increasing the parameter, the image becomes sharper. 

Sharpness = -50 Sharpness = 50

Soft  Saturation (-100..100).  The  parameter  enhances  less  saturated  colors  without  affecting
saturated colors. 
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Soft Saturation = -50 Soft Saturation = 50

Saturation (-100..100).  The  parameter  adjusts  the  intensity  of  all  colors  in  the  image.  The
parameter value varies from -100 (black and white image) to +100 (most-saturated colors). 

Saturation = -50 Saturation = 50

Click the Default button to revert the settings to their defaults. 

Adjusting the parameters of this tab is usually sufficient to achieve a good result. 

If needed, you can apply additional effects to the image or remove some defects using the parameters of
other tabs. 

You can save the selected parameters as a preset  in  the  Presets tab in  order  to reuse them when
processing other RAW files. 
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TONE CURVE

The Tone Curve tab  is used to adjust the brightness (tonal range) of the image. It makes possible to

adjust the contrast not only in the entire image but also selectively. 

By default, the curve is a straight line at a 45o angle and does not reflect any changes. The initially
specified input tone values completely match the output values. 

Where the curve is above the diagonal, these image areas become lighter. Where the curve is below the
diagonal, these image areas become darker. If the entire curve lies above the diagonal, then the entire
image becomes lighter. If the entire curve lies below the diagonal, then the entire image becomes darker. 

The tab contains two curves: Parametric and Point. The settings for each curve are adjusted individually.

The Parametric Curve allows you to gradually change the brightness of certain areas of the image. The
curve can be modified by changing the following parameters: 

The parameters Light Areas and Dark Areas mainly affect the middle area of the curve. Changing
these parameters affects the mid-light and mid-dark areas of the image. 
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The parameters Highlights and Shadows affect the extreme values of the curve. Changing these
parameters affects the lightest and darkest areas of the image. 

Each  parameter  affects  a  specific  area  of  the  curve.  To  expand or  narrow the  range of  a  particular
parameter, you can use the separators located on the horizontal axis of the graph. The division into areas
goes from left to right from the darkest to the lightest area. 

Modifying Parametric Curve

Using the  Point Curve, you can finely adjust a certain range of brightness. The curve is modified by
setting and moving control points. 

In the  Curve list, you can select one of the standard curves that affect the brightness of the image:
Medium Contrast or Strong Contrast. When adding points manually, the name in the list will change to
Custom. If you select  Default, all added points will be deleted, and the curve will be reset to neutral/
linear. 

For each point of the curve, the Input and Output brightness values are displayed under the graph. 

The input brightness values are arranged horizontally; the output values are arranged vertically. 
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If the output brightness value is less than the input value, then the image area corresponding to this point
of the curve becomes darker (the point of the curve is below the diagonal). If the output value is greater
than the input one, then it becomes lighter (the curve is above the diagonal). 

The curve will change if you drag one of the control points. If there are not enough specified points, you
can add extra points in any parts of the curve by clicking on it with the left mouse button. To remove an
extra point, right-click on it. 

Modifying Point Curve

Note: When modifying both curves, their impact is cumulated. 
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DETAILS

In the Details tab , you can improve the sharpness of the image as well as reduce noise. 

Hint: To achieve better results, it is recommended to adjust these parameters at a scale of at least
100%. 

The parameters in the Sharpen section are used to increase the sharpness and clarity of the image. 

Strength (0-150). The parameter allows increasing the contrast along the edges of the objects. As
the parameter increases, the light pixels along the edges become lighter, and the dark ones become
darker. Due to this, the image becomes sharper. 
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Strength = 10 Strength = 100

Radius (0.50-3.00). The parameter determines the width of the area along the edges in which the
contrast will be enhanced. 

Radius = 1.00 Radius = 3.00

Microdetail (0-100). The parameter increases the contrast between neighboring pixels. The light
pixels in the image become lighter, and the darker ones become darker. Increasing the parameter
increases the sharpness of smaller image details. 
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Microdetail = 10 Microdetail = 100

Smoothing (0-100). When increasing the parameter, the edited image is blended with the original
image, and the sharpness is reduced. 

Smoothing = 5 Smoothing = 50

Click the Default button to revert the settings to their defaults. 

The parameters in the Noise Reduction section are used to reduce noise in images. 

Noise in a color image can be divided into two types: luminance noise and color noise. Luminance noise
appears as dark dots or small blots; color noise appears as colored speckles. 

Luminance Noise (0-100). Increase the parameter to reduce the image graininess and remove the
luminance noise. 
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Luminance Noise Luminance Noise Reduced

Color  Noise (0-100).  Increase  the  parameter  to  reduce  the  color  noise  (by  decreasing  the
saturation of colored dots). 

Color Noise Color Noise Reduced

Click the Default button to revert the settings to their defaults. 

When reducing the noise,  it  is  important not to overdo. When setting high smoothing values for  the
luminance noise, the image may appear unnatural and “plastic”. When setting high smoothing values for
the color noise, the color of small details changes due to blurring. 
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HSL/GRAYSCALE

The parameters in the HSL/Grayscale tab  are used to adjust individual color ranges or convert a

color image to grayscale. 

HSL is a color model that represents colors using Hue (H), Saturation (S) and Luminance (L). 

Enable the check-box  Convert to Grayscale (disabled by default) to convert the image to black and
white. Adjust the parameters in the Grayscale Mix tab. Each parameter changes the brightness of gray
corresponding to a specific color range, from white to black. 
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Original Colors Grayscale

With this check-box enabled, you can adjust the brightness of local areas in the image based on their
original color. 

When the check-box is disabled, three sub-tabs with sliders are available to adjust the individual color
components of each specific color range. Let's consider each sub-tab: 

In the Hue tab, you can shift the hues of specific color ranges in the image. For example, you can
change the color of the sky from light blue to purple. 

Light Blue Sky Purple Sky

In the Saturation tab, you can change the intensity or vividness of each color. For example, you
can change the color of the sky from gray to blue. 
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Gray Sky Blue Sky

In  the  Luminance tab,  you  can  change the  brightness  of  the  specific  color  range.  Adjust  the
parameter to make the area of the selected color lighter or darker. 

Dark Sky Light Sky

Adjusting the colors should be done carefully because when you move the slider of a certain color range,
all parts of the image that have this color will change. 

Click the Default button to reset all settings to the default values. 
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LENS CORRECTIONS

The camera lens may exhibit  various types of  distortion at certain focal  lengths and apertures.  Such

defects can be eliminated using the Lens Corrections tab . 

Using the following parameters you can get rid of the two most common optical defects. 

Chromatic aberrations are caused by the dispersion of light passing through the lens. This often results
in a fringe or halo around objects. For example, you can observe a red border on one side of an object
closer to the center of the image, and a blue border on the side of the object farther from the center of
the image. 

Red/Blue Edge (-100..100). Adjust the parameter to remove red or blue fringes. 

Blue/Yellow Edge (-100..100). Adjust the parameter to remove blue or yellow fringes. 

AliveColors RAW Processing: Lens Corrections

510



Chromatic Aberrations Chromatic Aberrations Eliminated

Lens Vignetting is  a lens defect that makes the edges of  the image become darker (or sometimes
lighter) compared to the center. 

Strength (-100..100). When increasing the value of the parameter, the edges of the image become
lighter. When reducing the value of the parameter, the edges of the image become darker. 

Distance (0-100). As the value increases, the adjustment is applied to a larger area extending far
from the edges of the image. At low values, the adjustment is applied to the area adjacent to the
corners. 

Shaded Edges Lens Vignetting Eliminated

The vignetting is not always a defect. Sometimes it is applied to an image for artistic effect. Adding a
vignette can be a powerful way to enhance both the mood and the composition of an image as well as to
draw the viewer's attention towards the main subject. 
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PRESETS

You can save the settings as a preset and reuse them for processing other RAW files. You can use the
settings of one tab or several tabs for creating a preset. 

Find all available presets in the drop-down Presets list. 

If you modify any settings, the preset name automatically changes to  Custom, and the  Save Custom
Preset button  appears next to the list. Click  to save the current settings. 

A new preset is automatically assigned a name that can be changed by entering any combination of letters
and numbers in the highlighted field. Press the Enter  key in the name edit mode (while the cursor there
is in the preset name field). This will open the New Preset dialog where you can adjust the parameters
for the preset. 

Select the parameters that will be recorded in the preset: either all settings or parameters of a certain tab.

You can also manually enable the check-boxes next to the names of the desired parameters or groups of
parameters. The values of the selected parameters will be recorded in the preset. 

Click OK to save the preset. 

Attention! When you select a preset, the values of the parameters that were not recorded in the
preset will be reset to default values. 
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Click  to export your presets to a .presets file. 

To load the file with the presets into the program, press on . 

To remove your preset, select it from the list and click . 
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